# Contents

## 1 Safety

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrical Safety</td>
<td>10</td>
</tr>
<tr>
<td>General Guidelines</td>
<td>10</td>
</tr>
<tr>
<td>Laser Safety</td>
<td>10</td>
</tr>
<tr>
<td>Power Cord</td>
<td>10</td>
</tr>
<tr>
<td>Operational Safety</td>
<td>12</td>
</tr>
<tr>
<td>Operational Guidelines</td>
<td>12</td>
</tr>
<tr>
<td>Ozone Release</td>
<td>12</td>
</tr>
<tr>
<td>Printer Location</td>
<td>12</td>
</tr>
<tr>
<td>Printer Supplies</td>
<td>13</td>
</tr>
<tr>
<td>Maintenance Safety</td>
<td>14</td>
</tr>
<tr>
<td>Printer Symbols</td>
<td>15</td>
</tr>
</tbody>
</table>

## 2 Features

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parts of the Printer</td>
<td>18</td>
</tr>
<tr>
<td>Front View</td>
<td>18</td>
</tr>
<tr>
<td>Rear View</td>
<td>19</td>
</tr>
<tr>
<td>Internal View</td>
<td>19</td>
</tr>
<tr>
<td>Control Panel</td>
<td>20</td>
</tr>
<tr>
<td>Configurations and Options</td>
<td>21</td>
</tr>
<tr>
<td>Configurations</td>
<td>21</td>
</tr>
<tr>
<td>Standard Features</td>
<td>21</td>
</tr>
<tr>
<td>Additional Capabilities</td>
<td>21</td>
</tr>
<tr>
<td>Optional Features</td>
<td>22</td>
</tr>
<tr>
<td>Energy Saver Mode</td>
<td>23</td>
</tr>
<tr>
<td>Setting the Power Saver Time</td>
<td>23</td>
</tr>
<tr>
<td>Exiting Energy Saver Mode</td>
<td>23</td>
</tr>
<tr>
<td>Starting Energy Saver Mode</td>
<td>23</td>
</tr>
<tr>
<td>Information Pages</td>
<td>24</td>
</tr>
<tr>
<td>Menu Map</td>
<td>24</td>
</tr>
<tr>
<td>Configuration Page</td>
<td>24</td>
</tr>
<tr>
<td>Startup Page</td>
<td>24</td>
</tr>
<tr>
<td>CentreWare Internet Services</td>
<td>25</td>
</tr>
<tr>
<td>Accessing CentreWare Internet Services</td>
<td>25</td>
</tr>
<tr>
<td>More Information</td>
<td>26</td>
</tr>
</tbody>
</table>

## 3 Installation and Setup

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation and Setup Overview</td>
<td>28</td>
</tr>
<tr>
<td>Selecting a Location for the Printer</td>
<td>29</td>
</tr>
</tbody>
</table>
Contents

Connecting the Printer ................................................................. 30
  Choosing a Connection Method ................................................. 30
  Connecting to a Network ......................................................... 30
  Connecting Using a USB Cable ................................................ 31
  Connecting to a Telephone Line ............................................. 31
Configuring Network Settings .................................................. 32
  About TCP/IP and IP Addresses ............................................... 32
  Assigning the IP Address of the Printer .................................... 32
  Finding the IP Address of Your Printer .................................... 35
  Enabling the Printer for Faxing ............................................... 35
  Enabling the Printer for Scanning ......................................... 36
Setting the Date and Time ...................................................... 37
Installing the Software ............................................................. 38
  Operating System Requirements ............................................ 38
  Available Print Drivers ........................................................ 38
  Installing the Print Drivers for a Windows Network Printer .......... 39
  Installing the Scan Drivers for a Windows Network Printer .......... 39
  Installing Print and Scan Drivers for Windows USB .................... 40
  Installing the Drivers and Utilities for Macintosh OS X Version 10.5 and Later ........................................ 41
  Installing Other Drivers ....................................................... 43
Installing Utilities for Windows .................................................. 44
  Installing the Address Book Editor ......................................... 44
  Installing PrintingScout ........................................................ 44
Enabling Optional Features ....................................................... 46
  Enabling Optional Features for the Windows PostScript Driver .... 46
  Enabling Optional Features for the Windows PCL Driver ............ 47
  Enabling Optional Features for Macintosh OS X 10.5 and Later .... 48
  Enabling Optional Features for Linux ...................................... 48
Setting up Scanning ................................................................. 49
  Scanning Setup Overview ..................................................... 49
  Setting Up Scanning to a Shared Folder on Your Computer ........ 49
  Setting Up Scanning to an FTP Server .................................... 51
  Setting Up Scanning to an Email Address ................................ 52
  Setting Up Scanning with USB ............................................... 53

4  Printing

Supported Paper and Media ....................................................... 56
  Paper Usage Guidelines ...................................................... 56
  Paper That Can Damage Your Printer .................................... 57
  Paper Storage Guidelines .................................................... 57
  Supported Paper ................................................................. 58
Loading Paper ........................................................................... 61
  Loading Paper in Tray 1 ........................................................ 61
  Loading Paper in the Manual Feed Slot .................................. 63
  Loading Paper in the 250-Sheet Feeder (Tray 2) ....................... 65
Contents

Setting Paper Types and Sizes .......................................................... 68
    Setting the Paper Type .......................................................... 68
    Setting the Paper Size .......................................................... 68
Selecting Printing Options ............................................................. 70
    Selecting Printing Defaults in Windows ..................................... 70
    Selecting Printing Defaults in Windows for a Shared Network Printer .......................................................... 71
    Selecting Printing Options for an Individual Job in Windows ........ 71
    Selecting Printing Options for an Individual Job in Macintosh .... 75
Printing on Specialty Media .......................................................... 77
    Printing Envelopes .............................................................. 77
    Printing Labels ................................................................. 80
    Printing on Glossy Cardstock .................................................. 82
    Printing on Cardstock .......................................................... 85
Printing Custom Sizes ................................................................. 87
    Defining Custom Paper Sizes .................................................. 87
    Printing on Custom Size Paper ................................................. 89
Printing on Both Sides of the Paper ................................................. 91
    Automatic 2-Sided Printing Guidelines ..................................... 91
    Binding Edge Options .......................................................... 91
    Automatic 2-Sided Printing .................................................... 92
    Manual 2-Sided Printing ....................................................... 92
Printing Using Secure Print .......................................................... 95
    Storing a Print Job in Memory .................................................. 95
    Printing a Secure Print Job ................................................... 96
Printing Using Proof Print ........................................................... 97
    Setting Up a Proof Print Job .................................................... 97
    Printing a Proof Print Job .................................................... 98

5 Copying

Basic Copying ................................................................. 100
    Automatic Document Feeder Guidelines ................................... 100
Adjusting Copying Options .......................................................... 102
    Basic Settings ................................................................. 102
    Image Adjustments ............................................................ 104
    Image Layout Adjustments .................................................... 105
    Output Adjustments ........................................................... 106
Changing the Default Settings ....................................................... 107
    Selecting the Default Copy Settings ....................................... 107
    Limiting Access to Copy Operations ....................................... 109

6 Scanning

Loading Documents for Scanning .................................................. 112
Scanning to a Folder on a Computer with a USB Connection .......... 113
Scanning to a USB Flash Drive ..................................................... 114
Contents

Scanning to a Shared Folder on a Network Computer .................................................. 115
   Setting Up Scanning to a Computer ................................................................. 115
   Scanning to a Computer ................................................................................. 115
Scanning to an Email Address ............................................................................. 116
Scanning to an FTP Server ..................................................................................... 117
Scanning Images into an Application .................................................................. 118
   Scanning an Image into a Windows Application (TWAIN) ................................. 118
   Using the WIA Image Manager in a Windows Application ............................... 118
   Scanning an Image into a Macintosh OS X Application .................................... 119
Adjusting Scanning Options ................................................................................... 120
   Adjusting Scan Settings ..................................................................................... 120
   Changing the Default Scan Settings ................................................................. 123
   Limiting Access to Scan Operations ................................................................ 125

7 Faxing

Loading Documents for Faxing ............................................................................. 128
Basic Faxing ........................................................................................................... 129
   Sending a Fax from the Printer ......................................................................... 129
   Sending a Fax from Your Computer .................................................................. 130
Using the Fax Address Book .................................................................................. 132
   Faxing to an Individual ...................................................................................... 132
   Faxing to a Group ............................................................................................. 133
Selecting Fax Options for Single Jobs ................................................................ 137
   Setting the Fax Resolution ................................................................................. 137
   Making the Image Lighter or Darker ................................................................. 137
   Turning On Hook On or Off .............................................................................. 137
   Sending a Delayed Fax ...................................................................................... 138
   Including a Fax Cover Page .............................................................................. 138
   Setting Up Polling ............................................................................................. 138
Changing the Default Fax Job Settings ................................................................ 139
   Fax Configuration .............................................................................................. 139
Managing Fax Functions ....................................................................................... 140
   Printing Monitor Reports .................................................................................. 140
   Enabling or Disabling Secure Faxes ................................................................. 141
   Limiting Access to Fax Operations .................................................................. 141
   Limiting Who Can Send Faxes to the Printer .................................................. 142
   Limiting Access to Fax Operations .................................................................. 142
   Printing Fax Reports ......................................................................................... 143
   Inserting Pauses in Fax Numbers ..................................................................... 143

8 Control Panel Menus

Navigating the Control Panel Menus ..................................................................... 146
9 Maintenance

Cleaning the Printer ........................................... 166
  General Precautions ........................................ 166
  Cleaning the Document Glass ............................... 167
  Cleaning the Exterior ...................................... 167
  Cleaning the Interior ...................................... 168
Ordering Supplies ............................................. 169
  Consumables ................................................. 169
  Routine Maintenance Items ................................. 169
  When to Order Supplies .................................. 169
  Recycling Supplies ........................................ 170
Managing the Printer ........................................... 171
  Managing the Printer with CentreWare Internet Services ........................................... 171
  Checking Printer Status with PrintingScout ................ 172
  Checking Printer Status using Email ...................... 173
Checking Page Counts ........................................ 176
  Viewing the Billing Meter .................................. 176
  Printing the Print Volume Report ......................... 176
Moving the Printer ............................................. 178

10 Troubleshooting

Troubleshooting Overview .................................... 182
  Error and Status Messages ................................ 182
  PrintingScout Alerts ...................................... 182
  Online Support Assistant ................................ 182
  Information Pages ......................................... 182
  More Information ......................................... 183
Control Panel Messages ...................................... 184
  Supply Status Messages .................................. 184
  Error Messages ........................................... 185
Problems with the Printer .................................... 188
Print-Quality Problems ....................................... 191
Cleaning the Imaging Unit and Laser Lens ................. 196
Color Registration ............................................ 199
  Setting Automatic Color Registration .................... 199
  Performing a One-time Automatic Color Registration Adjustment ........................................... 199
  Performing a Manual Color Registration Adjustment ........................................... 199
Color Balance .................................................. 203
Safety

This chapter includes:

- Electrical Safety on page 10
- Operational Safety on page 12
- Maintenance Safety on page 14
- Printer Symbols on page 15

Your printer and the recommended supplies have been designed and tested to meet strict safety requirements. Attention to the following information ensures the continued safe operation of your printer.
Safety

Electrical Safety

This section includes:

- General Guidelines on page 10
- Laser Safety on page 10
- Power Cord on page 10

General Guidelines

⚠️ **WARNING:** Do not push objects, including paper clips or staples, into slots or openings on the printer. Contact with a voltage point or shorting out a part could result in fire or electrical shock.

⚠️ **WARNING:** Do not remove the covers or guards that are fastened with screws unless you are installing optional equipment and are instructed to do so. Power must be OFF when performing these installations. Disconnect the power cord when removing covers and guards for installing optional equipment. Except for user-installable options, there are no parts that you can maintain or service behind these covers.

**Note:** Leave the printer on for optimum performance. It does not pose a safety hazard. If, however, you do not use the printer for an extended period, turn it off and unplug it.

The following are hazards to your safety:

- The power cord is damaged or frayed.
- Liquid is spilled into the printer.
- The printer is exposed to water.

If any of these conditions occur, do the following:

1. Turn off the printer immediately.
2. Disconnect the power cord from the electrical outlet.
3. Call an authorized service representative.

Laser Safety

This printer complies with laser printer performance standards set by governmental, national, and international agencies and is certified as a Class 1 Laser Product. The printer does not emit hazardous light because the beam is enclosed during all modes of customer operation and maintenance.

⚠️ **WARNING:** Use of controls, adjustments, or performance of procedures other than the procedures specified in this manual can result in hazardous radiation exposure.

Power Cord

- Use the power cord supplied with your printer.
• Plug the power cord directly into a grounded electrical outlet. Make sure that each end of the cord is securely connected. If you do not know if an outlet is grounded, ask an electrician to check the outlet.
• Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a ground connection terminal.
• Only use an extension cord or power strip designed to handle the electrical current capacity of the printer.
• Verify that the printer is plugged into an outlet that provides the correct voltage and power. Review the electrical specification of the printer with an electrician if necessary.

⚠️ **WARNING:** Avoid the potential of electrical shock by ensuring that the printer is properly grounded. Electrical products can be hazardous if misused.
• Do not place the printer in an area where people can step on the power cord.
• Do not place objects on the power cord.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet.
Operational Safety

This section includes:

- Operational Guidelines on page 12
- Ozone Release on page 12
- Printer Location on page 12
- Printer Supplies on page 13

Your printer and supplies were designed and tested to meet strict safety requirements. These include safety agency examination, approval, and compliance with established environmental standards. Your attention to the following safety guidelines helps to ensure the continued safe operation of your printer.

Operational Guidelines

- Do not remove the selected paper source tray when the printer is printing.
- Do not open the doors when the printer is printing.
- Do not move the printer when it is printing.
- Keep hands, hair, neckties, and such, away from the exit and feed rollers.

Ozone Release

During print operation, a small quantity of ozone is released. This amount is not large enough to harm anyone adversely. However, be sure the room where the printer is being used has adequate ventilation. Ventilation is important if you are printing in high volume, or if the printer is being used continuously over a long period.

Printer Location

- Do not block or cover the slots or openings on the printer. These openings are provided for ventilation and to prevent overheating of the printer.
- Place the printer in a dust-free area where there is adequate space for operation and servicing. For details, see Selecting a Location for the Printer on page 29.
- Do not store or operate the printer in extreme conditions of heat or humidity. For specifications on optimum performance environment, see Relative Humidity on page 213.
- Place the printer on a level, solid, non-vibrating surface with adequate strength to hold the weight of the printer. The base printer weight without any packaging materials is approximately 30 Kg (66 lb.).
- Do not place the printer near a heat source.
- Do not place the printer in direct sunlight to avoid exposure to light-sensitive components.
- Do not place the printer where it is directly exposed to the cold air flow from an air conditioning unit.
- Do not place the printer in locations susceptible to vibrations.
- For optimum performance, use the printer at elevations below 3,100 m (10,170 ft.).
Printer Supplies

- Use the supplies designed for your printer. The use of unsuitable materials can cause poor performance and a possible safety hazard.
- Follow all warnings and instructions marked on, or supplied with, the printer, options, and supplies.

⚠️ CAUTION: Use of non-Xerox® supplies is not recommended. The Xerox® Warranty, Service Agreements, and Total Satisfaction Guarantee, do not cover damage, malfunction, or degradation of performance caused by use of non-Xerox® supplies. They also do not cover damage or degradation of performance caused by the use of Xerox® supplies not specified for this printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage can vary outside these areas. Please contact your local representative for details.
Safety

Maintenance Safety

- Do not attempt any maintenance procedure that is not described in the documentation supplied with your printer.
- Do not use aerosol cleaners. Clean with a dry, lint-free cloth only.
- Do not burn any consumables or routine maintenance items. For information on Xerox® supplies recycling programs, go to www.xerox.com/gwa.

See also:

  Cleaning the Printer on page 166
  Moving the Printer on page 178
Printer Symbols

The following safety symbols are marked on the printer.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Warning or Caution:](Image) | Warning or Caution:  
Ignoring this warning could cause serious injury or even death.  
Ignoring this caution can damage the property or cause serious injury. |
| ![Hot surface on or in the printer. Use caution to avoid personal injury.](Image) | Hot surface on or in the printer. Use caution to avoid personal injury. |
| ![Do not expose the item to sunlight.](Image) | Do not expose the item to sunlight. |
| ![Do not expose the item to light.](Image) | Do not expose the item to light. |
| ![Do not touch components with this symbol as personal injury could result.](Image) | Do not touch components with this symbol as personal injury could result. |
| ![Do not touch the transfer belt with your fingers or with sharp objects. It can cause print-quality problems. The belt can be easily punctured.](Image) | Do not touch the transfer belt with your fingers or with sharp objects. It can cause print-quality problems. The belt can be easily punctured. |
| ![Do not place or drop any object on the transfer belt. It can cause print-quality problems or permanently damage the belt.](Image) | Do not place or drop any object on the transfer belt. It can cause print-quality problems or permanently damage the belt. |
| ![It can take 40 minutes for the fuser to cool down.](Image) | It can take 40 minutes for the fuser to cool down. |
Safety
Features

This chapter includes:

- Parts of the Printer on page 18
- Configurations and Options on page 21
- Energy Saver Mode on page 23
- Information Pages on page 24
- CentreWare Internet Services on page 25
- More Information on page 26
Features

Parts of the Printer

This section includes:

- Front View on page 18
- Rear View on page 19
- Internal View on page 19
- Control Panel on page 20

Front View

1. Tray 1 (250 sheet paper tray)
2. Manual feed slot
3. Front cover
4. Front cover release button
5. Control panel
6. USB memory port
7. Automatic document feeder (ADF) tray
8. Output tray
9. Power switch
10. Side door
Features

Rear View

1. Power plug
2. ADF cover
3. USB port
4. Memory slot door
5. Network connector
6. Line out (to telephone)
7. Line in (from wall jack)

Internal View

1. Button for opening the front cover
2. Transfer unit
3. Imaging unit
4. Fuser
5. ADF document glass
6. Toner cartridges
Control Panel

1. **One Touch** keypad: Use to speed dial a phone number.
2. **Copy, Scan, Print, and Fax** buttons: Press to use the Copy, Scan, Print, and Fax menus on the display screen.
3. **Display Screen**: Shows status messages, menus, and toner levels.
4. **Arrow** buttons: Scroll up, down, forward, and back through the menus.
5. **Job Status** button: Press to check active job status.
6. **System** button: Switches the display to the System menus.
7. **Alphanumeric** keypad: Use to enter letters and numbers for names and phone numbers.
8. **Redial/Pause** button: Press the button to recall the last fax number used or to insert pauses in fax numbers.
9. **Speed Dial** button: Press to access directories of group or individual fax telephone numbers.
10. **Wake Up/Power Saver** button: This light is illuminated in power saver mode. Push the button to exit Energy Saver mode.
11. **Clear All** button: Clears all text, numbers or instructions.
12. **Stop** button: Cancels the current print job.
13. **Start** button: Press to start a copy, scan, or fax job.
14. **Status** indicator light: The green or red light indicates printer status.
   - Lights green when the printer is ready to receive data.
   - Blinks green when the printer is busy receiving data.
   - Lights red to indicate an error condition or warning that requires your attention.
   - Blinks red when an error occurs that requires technical support.
   - Off when the printer is in Energy Saver mode.
15. **Cancel/Clear** button: Cancels the current print or copy job. In menus, deletes a single character each time the button is pressed.
16. **Address Book** button: Press to access the Fax and Email address books.
17. **OK** button: Press to accept the selected setting.
18. **Back/Return** button: Press to go up one level in the menu.
19. **Color Mode** button: Press to switch between Color and Black and White modes for your copy, fax, and scan jobs.
Configurations and Options

This section includes:

- **Configurations** on page 21
- **Standard Features** on page 21
- **Additional Capabilities** on page 21
- **Optional Features** on page 22

Configurations

The WorkCentre 6505 printer is available in two configurations:

- **WorkCentre 6505N**: Includes all standard features.
- **WorkCentre 6505DN**: Includes all standard features plus a duplex unit.

  **Note**: When these items are not standard on your printer, you can order additional memory and trays. For automatic 2-sided printing, you can order the duplex unit.

Standard Features

All configurations of the WorkCentre 6505 printer include the following features:

- Tray 1 with 250-sheet capacity
- Single-sheet manual feed slot
- 256 MB Memory (RAM)
  
  **Note**: All printer configurations have one memory slot supporting 512 MB or 1024 MB DDR2 DIMMs. Maximum RAM is 1280 MB (256 MB standard plus 1024 MB optional).
- 10Base-T/100/1000Base-TX Ethernet interface network connection
- USB 2.0 connection
- Energy Saver mode
- PrintingScout printer monitoring utility (Windows only)
- Printer information pages, including a Menu Map, Configuration Page, and Demo Page
- Billing meters
- Administration menu with control panel lock

Additional Capabilities

These features are built in to the printer but require additional memory to function. You can purchase additional memory. For details, see **Optional Features** on page 22.

- Walk-Up Printing: Prints a stored print job directly from the printer control panel.
- RAM Disk: Allocates memory to the RAM Disk file system for Collation, Secure Print, Proof Print, Form Overlay, and Font Download.
- Collation: Allows jobs to be stored in memory so that multiple copies can be printed in page sequence order: 123, 123, 123, 123, instead of 1111, 2222, 3333.
Features

- Secure Print: Stores data in memory and requires you to enter a password into the control panel to print the document.
- Proof Print: Stores multiple copies of a document in memory, then allows you to print only the first set to check the print results. If the first copy is satisfactory, print the remainder from the control panel.
- Form Overlay: Enables writing PCL5 forms.
- Font Download: Enables the downloading of fonts to the RAM Disk.

Optional Features

- Duplex unit for automatic 2-sided printing (optional for WorkCentre 6505N)
- 250-sheet feeder (Tray 2)
- Wireless network adapter
- Productivity Kit (512 MB)

See also:
- Printer Specifications on page 211
- Enabling Optional Features on page 46
Energy Saver Mode

This section includes:
- Setting the Power Saver Time on page 23
- Exiting Energy Saver Mode on page 23
- Starting Energy Saver Mode on page 23

The printer is equipped with Energy Saver modes to reduce power consumption when it is left idle for a specified time. When no print data is received within the Power Saver Times, the printer enters an Energy Saver mode.

Setting the Power Saver Time

1. On the control panel, press the System button.
2. Press the Up Arrow or Down Arrow button to select Admin Menu, then press the OK button.
3. Press the Up Arrow or Down Arrow button to select System Setup, then press OK.
4. At Power Saver Time, press OK.
5. Press the Up Arrow or Down Arrow button to select one of the following:
   - **Mode 1 (Printer)**: Reduces power consumption to 17 W or less when the printer is left idle. Range is 5–60 minutes. The default setting is 3.
   - **Mode 2 (System)**: Disables control panel and all sensors after the printer enters Mode 1. Reduces power consumption to 12 W or less. Range is 5–120 minutes. The default setting is 1.
6. Press OK.
7. Press the Up Arrow or Down Arrow button to select the desired time, then press OK.
8. Press the Return button to return to the Ready screen.

Exiting Energy Saver Mode

The printer automatically cancels Energy Saver mode when it receives data from a connected computer. However, you can cancel Energy Saver mode by pressing the Power Saver button on the control panel. For details, see Control Panel on page 20.

Starting Energy Saver Mode

You can put the printer into Energy Saver mode without having to wait for it to do so automatically from the default settings. To enter sleep mode, press the Power Saver button on the control panel. The printer must currently be idle and have been idle for at least one minute before you press the Power Saver button. The printer cannot enter Energy Saver mode when any of the following conditions exist:
- The printer is receiving data.
- The printer is calibrating after having been in Energy Saver mode or after a jam is cleared.
- You pressed another button within the last minute.
Information Pages

This section includes:

- Menu Map on page 24
- Configuration Page on page 24
- Startup Page on page 24

Your printer comes with a set of information pages to help you track the performance of the printer and diagnose problems. Access the information pages from the control panel. The following topics discuss the most commonly used information pages. For a complete list of printer information pages, see Information Pages on page 148.

Menu Map

The Menu Map lists all main and second-level menus. Use the Menu Map to navigate the control panel menus. The Menu Map also lists other information pages available for printing.

To print the Menu Map:

1. On the control panel, press the System button.
2. At Information Pages, press the OK button.
3. At Menu Map, press OK to print the page.

Configuration Page

The Configuration Page lists printer information such as default settings, installed options, network settings with IP address, and font settings. Use the information on this page to help you configure network settings for your printer, and to view page counts and system settings.

To print the Configuration Page:

1. On the control panel, press the System button.
2. At Information Pages, press the OK button.
3. Press the Up Arrow or Down Arrow button to select Configuration.
4. Press OK to print the page.

Startup Page

The Startup Page is an abbreviated version of the Configuration Page without the details of the settings. Use the information on this page to help you configure network settings for your printer and to view page counts.

Note: By default, the Startup Page prints automatically each time the printer is turned on. You can turn off this feature in the System Setup Menu under the Admin Menu settings. For details, see System Setup on page 157.
CentreWare Internet Services

CentreWare Internet Services is the administration and configuration software installed on the embedded Web server in the printer. It allows you to manage, configure, monitor, and administer the printer from a Web browser. CentreWare Internet Services gives you access to printer status, configuration and security settings, diagnostic functions, and more.

CentreWare Internet Services requires:

- A TCP/IP connection between the printer and the network in Windows, Macintosh, or Linux environments.
- TCP/IP and HTTP enabled on the printer.
- A network-connected computer with a Web browser that supports JavaScript.

Accessing CentreWare Internet Services

At your computer, open a Web browser, type the IP address of the printer into the address field, then press Enter or Return.

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on page 35.
More Information

The following resources provide more information about your printer and its capabilities.

<table>
<thead>
<tr>
<th>Information</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Installation Guide</em></td>
<td>Packaged with the printer.</td>
</tr>
<tr>
<td><em>Quick Use Guide</em></td>
<td>Packaged with the printer.</td>
</tr>
<tr>
<td>Video Tutorials</td>
<td><a href="http://www.xerox.com/office/WC6505docs">www.xerox.com/office/WC6505docs</a></td>
</tr>
<tr>
<td>Online Support Assistant</td>
<td><a href="http://www.xerox.com/office/WC6505support">www.xerox.com/office/WC6505support</a></td>
</tr>
<tr>
<td>Technical Support</td>
<td><a href="http://www.xerox.com/office/WC6505support">www.xerox.com/office/WC6505support</a></td>
</tr>
<tr>
<td>Information Pages</td>
<td>Print from the control panel menu.</td>
</tr>
<tr>
<td>Supplies</td>
<td><a href="http://www.xerox.com/office/WC6505supplies">www.xerox.com/office/WC6505supplies</a></td>
</tr>
</tbody>
</table>
Installation and Setup

This chapter includes:

- Installation and Setup Overview on page 28
- Selecting a Location for the Printer on page 29
- Connecting the Printer on page 30
- Configuring Network Settings on page 32
- Setting the Date and Time on page 37
- Installing the Software on page 38
- Installing Other Drivers on page 43
- Installing Utilities for Windows on page 44
- Enabling Optional Features on page 46
- Setting up Scanning on page 49

See also:

Online Support Assistant at www.xerox.com/office/WC6505support
Installation Guide packaged with your printer.
Installation and Setup Overview

Before using the printer, you must:
1. Make sure that the printer is set up correctly in an appropriate location. For details, see Selecting a Location for the Printer on page 29.
2. Select a connection method. For details, see Choosing a Connection Method on page 30.
3. Make sure that the printer is connected correctly. For details, see Connecting the Printer on page 30.
4. Turn on the printer and the computer. The Startup Page prints by default. If it does not, see Startup Page on page 24. If you are connected to a network, keep the Startup Page for referencing network settings such as the IP address of your printer.
5. If connected to a network, configure network settings. For details, see Configuring Network Settings on page 32.
6. Install drivers and software utilities from the Software and Documentation disc. The software installation procedure depends on your connection type (network or USB). For details, see Installing the Software on page 38.
7. Enable optional features and configure software.

Note: If the Software and Documentation disc is not available, you can download the latest drivers from www.xerox.com/office/WC6505drivers.
Selecting a Location for the Printer

1. Select a dust-free area with temperatures from 10° through 32°C (50°–90°F), and relative humidity 15–85%.

   **Note:** Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can cause condensation inside the printer, directly interfering with image transfer.

2. Place the printer on a level, solid, non-vibrating surface with adequate strength for the weight of the printer. The printer must be horizontal with all four feet in solid contact with the surface. The printer weight, without the options or paper, is 25 Kg (55.1 lb.). With the 250-sheet feeder, the duplex unit, and supplies, the weight is 34.5 Kg (76.1 lb.).

3. Ensure that your printer has the proper amount of clearance for all of its features, including any options you purchased. See the following measurements.

   The recommended minimal spacing for the printer includes the following:

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Clearance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overhead Clearance</td>
<td>275 mm (12.5 in.) above the printer for clearance when opening the document feeder</td>
</tr>
</tbody>
</table>
   | Height Requirement| • Printer: 549.3 mm (25.4 in.)  
                     | • Printer with 250-sheet feeder: 657.3 mm (25.9 in.)                     |
   | Other Clearances  | • 100 mm (3.9 in.) behind the printer  
                     | • 600 mm (23.6 in.) in front of the printer  
                     | • 100 mm (3.9 in.) on the left side of the printer  
                     | • 250 mm (9.8 in.) on the right side of the printer |

4. After positioning the printer, you are ready to connect it to the power source and computer or network. Go to the next section, **Connecting the Printer** on page 30.
Connecting the Printer

This section includes:
- Choosing a Connection Method on page 30
- Connecting to a Network on page 30
- Connecting Using a USB Cable on page 31
- Connecting to a Telephone Line on page 31

Choosing a Connection Method

The printer can be connected to your computer using a USB cable or an Ethernet cable. The method you choose depends on whether your computer is connected to a network. A USB connection is a direct connection and is the easiest to set up. An Ethernet connection is used for networking. If you are going to use a network connection, understand how your computer is connected to your network. For example, if your computer is connected to the network by way of a router connected to a cable or DSL modem. For more information, see About TCP/IP and IP Addresses on page 32.

Note: Hardware and cabling requirements vary for the different connection methods. Routers, network hubs, network switches, modems, Ethernet, and USB cables are not included with your printer and must be purchased separately.

- **Network**: If your computer is connected to an office network or a home network, use an Ethernet cable to connect the printer to the network. You cannot connect the printer directly to the computer. It must be connected through a router or hub. An Ethernet network can be used for one or more computers and supports many printers and systems simultaneously. Ethernet connection is typically faster than USB and allows you direct access to the settings of the printer using CentreWare Internet Services.

- **USB**: If you connect the printer to one computer and do not have a network, use a USB connection. A USB connection offers fast data speeds, but not as fast as an Ethernet connection. In addition, a USB connection does not provide access to CentreWare Internet Services.

- **Telephone**: The printer must be connected to a dedicated telephone line to send and receive faxes.

Connecting to a Network

To connect the printer to a network:
1. Make sure that the printer is turned off.
2. Attach a category 5 or better Ethernet cable from the printer to the network or router socket. Use an Ethernet hub or router, and two or more Ethernet cables. Connect the computer to the hub or router with one cable, then connect the printer to the hub or router with the second cable. Connect to any port on the hub or router except the uplink port.
3. Attach the power cord, then plug in the printer and turn it on. For safety information, see Power Cord on page 10.
4. Set or automatically discover the network IP address of the printer. For details, see Assigning the IP Address of the Printer on page 32.
Connecting Using a USB Cable

To use USB, you must have Windows Server 2003 and later or Windows XP SP1 and later. Macintosh users must use Mac OS X, version 10.5 and later.

To connect the printer to the computer using a USB cable:
1. Make sure that the printer is turned off.
2. Connect one end of a standard A/B USB 2.0 cable to the USB Port of the printer.
3. Attach the power cord and then plug in the printer and turn it on. For safety information, see Power Cord on page 10.
4. Connect the other end of the USB cable to the USB Port on the computer.
5. When the Windows Found New Hardware Wizard appears, cancel it.
6. You are ready to install the print drivers. For details, see Installing the Software on page 38.

Connecting to a Telephone Line

To connect the printer to a telephone line:
1. Make sure that the printer is turned off.
2. Connect a standard RJ11 cable, NO. 26 AWG (American Wire Gauge) or larger, to the Fax port on the back of the printer.
3. Connect the other end of the RJ11 cable to an operating telephone line.
4. Enable and configure the Fax functions. For details, see Changing the Default Fax Job Settings on page 139.
Configuring Network Settings

This section includes:

- **About TCP/IP and IP Addresses** on page 32
- **Assigning the IP Address of the Printer** on page 32
- **Finding the IP Address of Your Printer** on page 35
- **Enabling the Printer for Faxing** on page 35
- **Enabling the Printer for Scanning** on page 36

*Note:* These instructions apply to the printer when it is connected to a network. If you have a USB connection to the printer, you can skip this section.

**About TCP/IP and IP Addresses**

Computers and printers primarily use TCP/IP protocols to communicate over an Ethernet network. Generally, Macintosh computers use either TCP/IP or the Bonjour protocol to communicate with a network printer. For Macintosh OS X systems, TCP/IP is preferred. Unlike TCP/IP, however, Bonjour does not require printers or computers to have IP addresses.

With TCP/IP protocols, each printer and computer must have a unique IP address. Many networks and Cable and DSL routers have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server automatically assigns an IP address to every computer and printer on the network that is configured to use DHCP.

If you use a Cable or DSL router, see the documentation for your router for information on IP addressing.

**Assigning the IP Address of the Printer**

This section includes:

- **Allowing the IP Address to be Assigned Automatically** on page 33
- **Assigning the IP Address Manually** on page 33
- **Changing the IP Address Using CentreWare Internet Services** on page 34

By default, the printer is set to acquire an IP address form the network server using DHCP. Network addresses assigned by DHCP are temporary, however. After a specified time, the network could assign a new IP address to the printer. You can experience connectivity issues if the print driver is set to an IP address that changes periodically. To avoid problems, or if your network administrator requires a static IP address for the printer, you can assign the IP address to the printer. For details, see **Assigning the IP Address Manually** on page 33.

*Note:* You can view the IP address of your printer from the Startup Page, the Configuration Page, or the printer control panel. For details, see **Finding the IP Address of Your Printer** on page 35.
Allowing the IP Address to be Assigned Automatically

To re-enable automatic assignment of the IP address of the printer:
1. On the printer control panel, press the System button.
2. Press the Up Arrow or Down Arrow button to select Admin Menu, then press the OK button.
3. At Network Setup, press OK.
4. Press the Up Arrow or Down Arrow button to select TCP/IP, then press OK.
5. Press the Up Arrow or Down Arrow button to select IPv4, then press OK.
6. At Get IP Address, press OK.
7. Press the Up Arrow or Down Arrow button to select DHCP/AutoIP, then press OK.
8. Press the Return button to return to the Ready screen.

Assigning the IP Address Manually

You can assign a static IP address to your printer from the printer control panel. Once an IP address is assigned, you can change it using CentreWare Internet Services.

To assign a static IP address to the printer, you need the following information:
- An IP address properly configured for your network
- The Network Mask address
- The default Router/Gateway address

If you are on a network managed by a network administrator, contact your network administrator to obtain the network information.

For a home network using routers or other devices to connect the printer to the network, refer to the device instructions on assigning network addresses. The router or device documentation can give you a range of acceptable address numbers you can use. It is important that the addresses be similar to the IP addresses used by other printers and computers on the network, but not the same. Only the last digit must be different. For example, your printer can have the IPv4 address 192.168.1.2 while your computer has the IP address 192.168.1.3. Another device can have the IP address 192.168.1.4.

The router could assign the static IP address of the printer to another computer that obtains its IP address dynamically. To avoid having the IP address reassigned, give the printer an address at the higher end of the range allowed by the router or device. For example, if your computer has IP address 192.168.1.2, and your device allows IP addresses to 192.168.1.25, select an address between 192.168.1.20 and 192.168.1.25.

To assign a static IP address to the printer:
1. On the printer control panel, press the System button.
2. Press the Up Arrow or Down Arrow button to select Admin Menu, then press the OK button.
3. Press the Up Arrow or Down Arrow button to select Network Setup, then press OK.
4. Press the Up Arrow or Down Arrow button to select TCP/IP, then press OK.
5. Press the Up Arrow or Down Arrow button to select IPv4, then press OK.
6. At Get IP Address, press OK.
7. Press the Up Arrow or Down Arrow button to select Panel, then press OK to enable this option.
Installation and Setup

8. Press the **Return** button once to return to the IPv6 menu.

9. Press the **Up Arrow** or **Down Arrow** button to select **IP Address**, then press the **OK** button. When undefined, the address is 000.000.000.000.

10. Set the IP address:
    a. In the first field, press the **Up Arrow** or **Down Arrow** button, or use the alphanumeric keypad, to enter the desired number.
    b. Press the **Forward Arrow** button to move to the next field, then enter the desired number.
    c. Move to the next two fields and enter the desired numbers.

    **Note:** To scroll quickly to a number, hold down the **Up Arrow** or **Down Arrow** button. To return to a field, press the **Back Arrow** button.

    d. When finished, press **OK** to confirm the address.

11. Press the **Back Arrow** button once to return to **IP Address**.

12. Press the **Down Arrow** button to select **Network Mask**, then press **OK**. Repeat step 10 to set the Network Mask address.

13. Press the **Back Arrow** button once to return to **Network Mask**.

14. Press the **Down Arrow** button to select **Gateway Address**, then press **OK**. Repeat step 10 to set the Gateway Address.

15. Press the **Return** button to return to the Ready screen.

16. Print the Configuration Page to verify the new settings. For details, see **Configuration Page** on page 24.

17. You are ready to install software. For details, see **Installing the Software** on page 38.

See also:

- Online Support Assistant at [www.xerox.com/office/WC6505support](http://www.xerox.com/office/WC6505support)

**Changing the IP Address Using CentreWare Internet Services**

To change the IP address of the printer using CentreWare Internet Services:

1. At your computer, open a Web browser, type the IP address of the printer in the address field, then press **Enter** or **Return**.

2. Click the **Properties** link.

3. Under **Properties**, scroll to the **Protocols** link and expand it if it is not already expanded.

4. Click **TCP/IP**.
   The TCP/IP - Dual Stack page opens.

5. In the IPv4 section of the page, make the desired changes. For example, to change the way the printer acquires the IP address, in the **Get IP Address** field, select a method from the drop-down list.

6. After changing the address information, scroll to the bottom of the page and click **Save Changes**.
Finding the IP Address of Your Printer

To install the print drivers for a network-connected printer, you need the IP address of your printer. You also need the IP address to access the settings of your printer through CentreWare Internet Services. The IP address of your printer appears on the Configuration Page. You can also view it on the printer control panel.

To print the Configuration Page:
1. On the control panel, press the **System button**.
2. At **Information Pages**, press the **OK** button.
3. Press the **Up Arrow** or **Down Arrow** button to select **Configuration**, then press **OK** to print the page.
   The IP address of the printer is listed in the Network Setup section of the page.
   **Note:** The first time you turn on your printer, it automatically prints the Startup Page. If the IP address listed on the page is 0.0.0.0, the printer has not had time to acquire an IP address from the DHCP server. Wait a minute or two, then print the Startup Page again.

To view the IP address of the printer on the control panel:
1. On the control panel, press the **System** button.
2. Press the **Up Arrow** or **Down Arrow** button to select **Admin Menu**, then press the **OK** button.
3. Press the **Up Arrow** or **Down Arrow** button to select **Network Setup**, then press **OK**.
4. Press the **Up Arrow** or **Down Arrow** button to select **TCP/IP**, then press **OK**.
5. Press the **Up Arrow** or **Down Arrow** button to select **IPv4**, then press **OK**.
6. Press the **Up Arrow** or **Down Arrow** button to select **IP Address**, then press **OK**.
   The IP address of the printer appears on the IP Address screen.

Enabling the Printer for Faxing

It is unlawful to send a message from a fax machine without the proper Fax Send Header information. The following information must appear on the first transmitted page, or in the top or bottom margin of each transmitted page:
- Identity of the business or individual sending the fax
- Telephone number of the sending machine
- Date and time of the transmission

To set the required Fax Send Header information at the control panel:
1. Press the **System** button.
2. Press the **Up Arrow** or **Down Arrow** button to select **Admin Menu**, then press the **OK** button.
3. Press the **Up Arrow** or **Down Arrow** button to select **Fax Settings**, then press **OK**.
4. Identify the business or individual sending the fax:
   a. Press the **Up Arrow** or **Down Arrow** button to select **Company Name**, then press **OK**.
   b. Use the alphanumeric keypad to enter the name of your company, then press **OK**.
5. Identify the telephone number of the sending machine:
   a. Press the **Up Arrow** or **Down Arrow** button to select **Fax Number**, then press **OK**.
b. Use the alphanumeric keypad to enter the telephone number of the printer, then press OK.

6. Identify the country:
   a. Press the Up Arrow or Down Arrow button to select Country, then press OK.
   b. Press the Up Arrow or Down Arrow button to select your country name, then press OK.
   c. At the Restart System (Are You Sure?) prompt, press the Down Arrow button to select Yes, then press OK.

7. Press the Return button repeatedly to return to the Ready screen.

   Note: To set the date and time, see Setting the Date and Time on page 37.

You can also set the Fax Send Header information through Properties in CentreWare Internet Services. For details, see CentreWare Internet Services on page 25.

For details about using the fax features, see Faxing on page 127.

**Adding Fax Numbers and Email Addresses to the Address Book**

If the printer is connected to a network, you can add fax numbers and email addresses to the printer address book using CentreWare Internet Services.

If the printer is connected with a USB cable, you can add fax numbers and email addresses to the printer address book using Address Book Editor.

For details, see Adding an Individual Fax Address Book Entry on page 132, Creating a Fax Group on page 134, and Editing Address Book Fax Groups on page 135.

For more information see Faxing on page 127 and Scanning on page 111.

**Enabling the Printer for Scanning**

If the printer is connected to a network you can scan to an FTP address, an email address, or a shared folder on your computer. You must first set up scanning in CentreWare Internet Services. For details, see CentreWare Internet Services on page 25.

If the printer is connected with a USB cable, you can scan to a folder on your computer, or scan into an application. You must first install the scan drivers and the Express Scan Manager utility.

   Note: If you are connected using the USB cable only, you cannot scan to an email address or a network location (a shared folder on your computer).

For more information see Scanning Setup Overview on page 49.
Setting the Date and Time

Set the date and time on the printer before using it to send fax transmissions. It is unlawful to send a fax without the proper Fax Send Header information. For details, see Enabling the Printer for Faxing on page 35.

To set the date and time from the control panel:
1. Press the System button.
2. Press the Up Arrow or Down Arrow button to select Admin Menu, then press the OK button.
3. Press the Up Arrow or Down Arrow button to select System Setup, then press OK.
4. Press the Up Arrow or Down Arrow button to select Clock Settings, then press OK.
5. At Set Date & Time, press OK.
6. At Time Zone, press the Up Arrow or Down Arrow button to select the UTC offset for your time zone, then press OK.
   
   Note: For example, the Coordinated Universal Time (UTC) zone for Pacific Standard time is -08.00.
7. At Set Date, press the Up Arrow or Down Arrow button to set the month, then press the Forward Arrow button.
8. Press the Up Arrow or Down Arrow button to set the day, then press the Forward Arrow button.
9. Press the Up Arrow or Down Arrow button to set the year, then press OK.
10. At Set Time, press the Up Arrow or Down Arrow button to set the hour, then press the Forward Arrow button.
11. Press the Up Arrow or Down Arrow button to set the minutes, then press OK.
12. Press the Return button repeatedly to return to the Ready screen.
   
   Note: You can also set the date and time using CentreWare Internet Services.
Installing the Software

This section includes:
- Operating System Requirements on page 38
- Available Print Drivers on page 38
- Installing the Print Drivers for a Windows Network Printer on page 39
- Installing the Scan Drivers for a Windows Network Printer on page 39
- Installing Print and Scan Drivers for Windows USB on page 40
- Installing the Drivers and Utilities for Macintosh OS X Version 10.5 and Later on page 41
- Installing Other Drivers on page 43

Operating System Requirements
- Windows Server 2003 and later, or Windows XP SP1 and later
- Macintosh: OS X version 10.5 and later
- Linux: Your printer supports connection to Linux platforms through the network interface.

Available Print Drivers

To access special printing options, use a Xerox® print driver. Xerox® provides drivers for various page description languages and operating systems. The following print drivers are available. To download the latest drivers, go to www.xerox.com/office/WC6505drivers.

<table>
<thead>
<tr>
<th>Print Driver</th>
<th>Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe PostScript 3 Driver</td>
<td>Software disc</td>
<td>The PostScript driver is recommended to take full advantage of the custom features and genuine Adobe PostScript of your printer. Default print driver.</td>
</tr>
<tr>
<td></td>
<td>and Web</td>
<td></td>
</tr>
<tr>
<td>PCL6</td>
<td>Software disc</td>
<td>The Printer Command Language (PCL) driver can be used for applications requiring PCL.</td>
</tr>
<tr>
<td></td>
<td>and Web</td>
<td></td>
</tr>
<tr>
<td>Mac OS X version 10.5 and later Driver</td>
<td>Software disc and Web</td>
<td>This driver enables printing from a Mac OS X version 10.5 and later operating system.</td>
</tr>
<tr>
<td>Linux</td>
<td>Software disc</td>
<td>This driver enables printing from a Linux operating system.</td>
</tr>
<tr>
<td></td>
<td>and Web</td>
<td></td>
</tr>
</tbody>
</table>
Installing the Print Drivers for a Windows Network Printer

To install the print driver from the Software and Documentation disc:
1. Insert the disc into the appropriate drive on your computer. If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe installer file.
   The Easy Setup Navigator starts.
2. In the lower left section of the screen, click the Software Installation button.
3. At the top of the License Agreement, select your language, then click I Agree to accept the agreement.
   The Xerox® Printer Installation screen appears.
4. In the Discovered Printers list, select your WorkCentre 6505 printer, then click Next.
   Note: When installing drivers for a network printer, if you do not see your printer in the list, click the IP Address or DNS Name button. In the IP Address or DNS Name field, type the IP address of your printer, then click Search to locate your printer. If you do not know the IP address of the printer, see Finding the IP Address of Your Printer on page 35.
5. In the Installation Options screen, select PostScript and/or PCL 6.
   Note: You can install both drivers at once. Each will be displayed in your printer list after installation.
6. Click Install to start the installation.
7. When the installation is complete, at the Installation Status screen, select the following:
   • Set Printer As Default (optional)
   • Print a Test Page
   • Share Printer (optional)
8. Click Finish.
9. At the Product Registration screen, select your country from the list, then click Next. Complete the registration form and submit it.
   If you selected Print a Test Page, a test page prints for each driver you installed.
   Note: PrintingScout is a separate option that monitors printer status. To install PrintingScout, see Installing PrintingScout on page 44.

See also:
   Online Support Assistant at www.xerox.com/office/WC6505support

Installing the Scan Drivers for a Windows Network Printer

To install the scan driver from the Software and Documentation disc:
1. Insert the disc into the appropriate drive on your computer. If the installer does not start automatically, navigate to the drive, find the appropriate scan driver folder, and double-click the Setup.exe installer file.
   The Easy Setup Navigator starts.
2. In the lower left section of the screen, click the Software Installation button.
3. At the top of the License Agreement, select your language, then click I Agree to accept the agreement. The Xerox® Printer Installation screen appears.

4. When the installer is done, click Finish.

   Note: Before using the Scanner, you must select it in the Scan Setting Tool.

To configure the computer software for using the WorkCentre 6505 scanner feature:

1. On your computer, select Start > All Programs > Xerox > WorkCentre 6505 > Scan Setting Tools.
2. In the IP Address box of the IP Address Setting window, enter the IP address of the printer.
3. If a password has been set for using the scanner feature of the printer, enter it in the field on the Password Settings window.
4. Click OK, then close the Scan Settings Tool window.
5. Click Start > Control Panel > Scanners and Cameras. Select Xerox WorkCentre/Pro TWAIN (Recommended) #2. Click the Test Scanner button to test the connection and setting of the scanner.
6. Double-click Xerox WorkCentre 6505 (LAN) to open the Scanner and Camera Wizard. The scanner feature is ready to use.

Installing Print and Scan Drivers for Windows USB

To install the print driver:

1. If a USB cable is not connected from the printer to your computer, connect it now.
2. Cancel the Windows Found New Hardware Wizard.
3. Wait for the wizard to appear again and cancel it again.

   Note: Windows recognizes the printer as two devices, a printer and a scanner, and tries to help you install the drivers.

4. Insert the Software and Documentation disc into the appropriate drive on your computer. The installer starts automatically unless you have autorun disabled on your computer. If the installer does not start, navigate to the drive and double-click the Setup.exe installer file.

   Note: If the Software and Documentation disc is not available, download the latest driver from www.xerox.com/office/WC6505drivers.

5. When the installation menu appears, click Install Print Driver and accept the License Agreement. The Xerox Printer Installation window appears.
6. Select your printer from the list.
7. When the Installation Options window appears, click Install.
8. When the installation is complete, click Finish.

   The print driver is installed.

To install the scan driver:

1. From the installation menu, click Install Scan Driver.
2. Click Next to start the installer.
3. Accept the License Agreement and click Next.
4. When the installer is done, click **Finish**.

5. The Windows **Found New Hardware Wizard** appears again. This time, select **Yes, this time only**, then click **Next**.

6. Select **Install the software automatically**, then click **Next**.

7. The wizard searches for your printer and lists the associated .inf files. Select the .inf file that corresponds to your Windows operating system:
   - Vista - d:windows scan\x86vista\xrsmnim.inf
   - XP, Windows Server 2003 - d:windows scan\x86\xrsmnim.inf
   - Vista 64 bit - d:windows scan\x64vista\xrsmnim.inf
   - XP 64 bit - d:windows scan\x64\xrsmnim.inf

8. Select **Next**.

9. The installer runs and completes the installation.

You can now print and scan. For information about printing see **Printing** on page 55. For information about scanning see **Scanning** on page 111.

### Installing the Drivers and Utilities for Macintosh OS X Version 10.5 and Later

To access all features of the printer, you must:

- Install the print driver
- Install the scan driver
- Add the printer

**Note:** Before installing drivers, verify that the printer is plugged in, turned on, and connected by USB or to an active network. Make sure that the printer is receiving network information by monitoring the LEDs on the back of the printer near the Ethernet cable jack (RJ45). When the printer is connected to a functioning network and receiving traffic, the link LED is green, and its amber traffic LED is flashing rapidly.

### Installing the Print Driver

The installation process for Macintosh OS X is the same for versions 10.5 and later.

To install the print driver from the **Software and Documentation disc**:

1. Insert the **Software and Documentation disc** into the appropriate drive on your computer.

   **Note:** If the **Software and Documentation disc** is not available, download the latest drivers from [www.xerox.com/office/6505MFPdrivers](http://www.xerox.com/office/6505MFPdrivers).

2. On your desktop, double-click the **WorkCentre 6505** icon.

3. Double-click **WorkCentre 6505 Installer**.

4. At the **Introduction installer** window, click **Continue**.

5. Acknowledge the warning notice, then click **Continue**.

6. Read the license agreement, click **Continue**, then click **Agree**.

7. Click **Install**.
8. If prompted, enter your password, then click **OK**.
9. Click **Continue Installation**.
   When the driver is finished installing, click **Logout** to complete the installation and restart your computer.

**Installing the Scan Driver**

To install the scan driver:
1. Insert the *Software and Documentation disc* into the appropriate drive on your computer.
   
   **Note:** If the *Software and Documentation disc* is not available, download the latest drivers from www.xerox.com/office/6505MFPdrivers.

2. On your desktop, double-click the **WorkCentre 6505** scan icon.
3. Click **WorkCentre 6505 Scan Installer**.
4. If prompted, enter your password, then click **OK**.
5. At the **Introduction installer** window, click **Continue**.
6. Read the license agreement, click **Continue**, then click **Agree**.
7. Click **Install**.
   When the driver is finished installing, your browser opens to an online registration form.
8. Complete the online registration, then close the browser.
9. At the **Finish Up** window, click **Quit**.
10. Next, add the printer to your printer queue. For details, see *Adding the Printer* on page 42.

**Adding the Printer**

For networking, set up your printer using Bonjour (Rendezvous), or connect using the IP address of your printer for an LPD/LPR connection. For a non-network printer, create a desktop USB connection.

To add the printer using Bonjour:
1. From the **Applications** folder or from the dock, open **System Preferences**.
2. Click **Print & Fax**.
   The list of printers appears on the left of the window.
3. Click the plus (+) button under the list of printers.
4. Click the **Default** icon at the top of the window.
5. Select your printer from the list and click **Add**.

   **Note:** If your printer was not detected, verify that the printer is on and that the Ethernet or USB cable is connected properly.

To add the printer by specifying the IP address:
1. From the **Applications** folder or from the dock, open **System Preferences**.
2. Click **Print & Fax**.
   The list of printers appears on the left of the window.
3. Click the plus (+) button under the list of printers.
4. Click **IP**.
5. From the **Protocol** drop-down menu, select the protocol.
6. In the **Address** field, enter the IP address of the printer.
7. In the **Name** field, enter a name for the printer.
8. From the **Print Using** drop-down list, select **Select a driver to use**.
9. Select the print driver for your printer model from the list.
10. Click **Add**.

You can now print and scan. For information about printing, see **Printing** on page 55.

**See also:**
- Online Support Assistant at [www.xerox.com/office/WC6505support](http://www.xerox.com/office/WC6505support)

**Utilities**

Address Book Editor and Express Scan Manager are installed automatically when you install the scan driver. For more information see **Installing the Drivers and Utilities for Macintosh OS X Version 10.5 and Later** on page 41.

**Installing Other Drivers**

This section includes:
- Linux Drivers on page 43
- Other Xerox® Drivers on page 43

**Linux Drivers**

A complete list of supported Linux distributions and the associated drivers to download are provided at [www.xerox.com/office/WC6505drivers](http://www.xerox.com/office/WC6505drivers).

**Other Xerox® Drivers**

The following drivers are also available to download for Windows at [www.xerox.com/office/WC6505drivers](http://www.xerox.com/office/WC6505drivers):
- **Xerox Global Print Driver** (PCL version): Print to any PCL printer on your network, even printers made by other manufacturers. It configures itself for your individual printer upon installation.
- **Xerox Mobile Express Driver™** (PCL version): Print to any PCL printer on your network, even printers made by other manufacturers. The driver configures itself for the printer you select every time you print. If you travel frequently to the same sites, you can save your favorite printers in that location and the driver retains your settings.
Installing Utilities for Windows

This section includes:

- Installing the Address Book Editor on page 44
- Installing PrintingScout on page 44

Installing the Address Book Editor

Xerox® provides software for helping to manage the address book used by the scanner and fax functions of the printer. Use the Address Book Editor to maintain the information in the address books.

To install the utilities from the Software and Documentation disc:
1. Insert the disc into the appropriate drive on your computer. If the installer does not start automatically, navigate to the drive, find the appropriate scan driver folder, and double-click the Setup.exe installer file.
2. Click Install Utilities.
3. Click Next to start the installer.
4. Accept the License Agreement and click Next.
5. Click Next to accept the destination location.
6. At the prompt, click Finish.
7. On your computer, select Start > All Programs > Xerox > WorkCentre 6505 > Address Book Editor.
8. Click Connect via Network to manage the address book over the network, then click OK.
9. Enter the IP address in the IP Address field of the IP Address Settings.
10. Click OK.
   The computer synchronizes information with the printer and displays it in the Address Book Editor.

Installing PrintingScout

PrintingScout is a Windows utility that enables you to monitor the status of print jobs and printer supplies from your computer. It automatically checks the printer status when you send a print job. If the printer is unable to print, PrintingScout displays an alert on your computer screen to let you know that the printer needs attention.

To install PrintingScout:
1. Insert the Software and Documentation disc into the appropriate drive on your computer. If the installer does not start automatically, navigate to the drive, then double-click the Setup.exe installer file.
2. At the installer screen, click Install PrintingScout.
3. In the Choose Setup Language window, select your language, then click Next.
4. At the Xerox® PrintingScout screen, click Next.
5. Read the license agreement, then click I accept the terms of the license agreement, then click Next.
6. At the next screen, click **Next** to accept the default installation destination.
7. Click **Next**.
8. Click **Finish**.
   The PrintingScout icon appears in your Windows Taskbar.

See also:

   * Checking Printer Status with PrintingScout* on page 172
Enabling Optional Features

This section includes:

- Enabling Optional Features for the Windows PostScript Driver on page 46
- Enabling Optional Features for the Windows PCL Driver on page 47
- Enabling Optional Features for Macintosh OS X 10.5 and Later on page 48
- Enabling Optional Features for Linux on page 48

You must enable the following options in each print driver before you can use them:

- Duplex unit
- 250-sheet feeder
- RAM Disk
- Extra memory

Enabling Optional Features for the Windows PostScript Driver

This section includes:

- Enabling Optional Features for a Network-Connected Printer on page 46
- Enabling Optional Features for a USB-Connected Printer on page 46

Enabling Optional Features for a Network-Connected Printer

1. Navigate to the list of printers on your computer:
   - For Windows XP SP1 and later, click Start > Settings > Printers and Faxes.
   - For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers.
   - For Windows Server 2003 and later, click Start > Settings > Printers.
   - For Windows 7, click Start > Devices and Printers.
2. In the list of printers, right-click the WorkCentre 6505 PS printer and select Properties.
3. Click the Configuration tab, then click the Get Information from Printer button. The IP address of the printer appears in the Network Address section.
4. Click Apply.
5. To verify that the installed optional features are enabled, click the Device Settings tab and scroll down to view the Installable Options section.
6. Click OK to close the Properties dialog box.

Enabling Optional Features for a USB-Connected Printer

1. Navigate to the list of printers on your computer:
   - For Windows XP SP1 and later, click Start > Settings > Printers and Faxes.
   - For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers.
   - For Windows Server 2003 and later, click Start > Settings > Printers.
   - For Windows 7, click Start > Devices and Printers.
2. In the list of printers, right-click the **WorkCentre 6505 PS** printer and select **Properties**.
3. In the **Properties** dialog box, click the **Device Settings** tab.
4. Click the plus sign (+) to the left of Installable Options to expand and see the list of optional features.
5. Enable the installed features:
   - To specify the amount of RAM memory available, click **Memory** and select the amount of memory from the drop-down list.
   - To enable the 250-sheet feeder, click **Paper Tray Configuration** and select **2-Tray** from the list.
   - If you have enough memory to use the RAM Disk feature, 768 MB or 1280 MB, click **RAM Disk** and select **Available** from the list.
   - To enable the duplex unit, click **Duplex Unit** and select **Available** from the drop-down list.
6. Click **OK**.

**Enabling Optional Features for the Windows PCL Driver**

This section includes:
- **Enabling Optional Features for a Network-Connected Printer** on page 46
- **Enabling Optional Features for a USB-Connected Printer** on page 46

**Enabling Optional Features for a Network-Connected Printer**

1. Navigate to the list of printers on your computer:
   - For Windows XP SP1 and later, click **Start > Settings > Printers and Faxes**.
   - For Windows Vista, click **Start > Control Panel > Hardware and Sound > Printers**.
   - For Windows Server 2003 and later, click **Start > Settings > Printers**.
   - For Windows 7, click **Start > Devices and Printers**.
2. In the list of printers, right-click the **WorkCentre 6505 PCL** printer and select **Properties**.
3. In the **Properties** dialog box, click the **Options** tab.
4. Click the **Get Information from Printer** button.
   The IP address of the printer appears in the Network Address section. The installed optional features appear as Available in the Items list. The amount of memory installed appears in the Memory Capacity field.
5. Click **OK**.

**Enabling Optional Features for a USB-Connected Printer**

1. Navigate to the list of printers on your computer:
   - For Windows XP SP1 or later, click **Start > Settings > Printers and Faxes**.
   - For Windows Vista, click **Start > Control Panel > Hardware and Sound > Printers**.
   - For Windows Server 2003 and later, click **Start > Settings > Printers**.
   - For Windows 7, click **Start > Devices and Printers**.
2. In the list of printers, right-click the **WorkCentre 6505 PCL** printer and select **Properties**.
Installation and Setup

3. In the **Properties** dialog box, click the **Options** tab.
   The Items box lists the printer options. To the right of each item is the status, either Available or Not Available or, for Memory Capacity, the amount of RAM in MB.

4. To enable the items that are installed in your printer, select the item in the list, then in the **Settings for** drop-down list, select **Available**. If you are enabling additional memory, in Memory Capacity, select the amount of RAM in MB from the list.

5. Click **OK**.

**Enabling Optional Features for Macintosh OS X 10.5 and Later**

1. From the **Applications** folder or from the dock, open **System Preferences**.
2. Open **Print & Fax**. The list of printers appears on the left side of the window.
3. Select your printer in the list, then click the **Options & Supplies** button.
4. In the window, click the **Driver** tab and select the print driver from the Print Using list.
5. Enable the installed features:
   - To specify the amount of RAM memory available, select the amount of memory from the drop-down Memory Capacity list.
   - To enable the optional 250-sheet feeder, click **Paper Tray Configuration** and select **2-Tray** from the drop-down list.
   - If you have enough memory to use the RAM Disk feature, select **Available** from the RAM Disk drop-down list.

   **Note:** A minimum of 512 MB is required.
   - To enable the duplex unit, select **Available** from the Duplex Unit drop-down list.

6. Click **OK**.

**Enabling Optional Features for Linux**

**Note:** These instructions are for using Common UNIX Printing System (CUPS), accessed through a Web browser.

1. Open the Web browser on your computer. In the address field, type **http://127.0.0.1:631**, then press **Enter**.
2. At the CUPS Home tab, click the **Manage Printers** button.
3. Locate your printer in the list, then click the **Set Printer Options** button for your printer.
4. At the Set Printer Options page, enable the optional features installed on your printer:
   - In the Memory field, select the amount of Memory in MB.
   - If you have the 250-sheet feeder installed, select **2-Tray** in the Paper Tray Configuration field.
   - To enable RAM Disk, select the **Available** option.

   **Note:** A minimum of 512 MB is required.
   - To enable automatic 2-sided printing, at the Duplex Unit field, select the **Available** option.

5. Click **Set Printer Options** to save the settings.
Setting up Scanning

This section includes:
- **Scanning Setup Overview** on page 49
- **Setting Up Scanning to a Shared Folder on Your Computer** on page 49
- **Setting Up Scanning to an FTP Server** on page 52
- **Setting Up Scanning to an Email Address** on page 52
- **Setting Up Scanning with USB** on page 53

See also:
- **Scanning** on page 111

**Scanning Setup Overview**

If the printer is connected to a network, it is enabled for scanning. Before you can scan you must do the following:
- Scanning to a shared folder on your computer: Share the folder, and add the folder as an Address Book entry in CentreWare Internet Services. For details, see **Setting Up Scanning to a Shared Folder on Your Computer** on page 49.
- Scanning to an FTP server: Add the FTP server as an Address Book entry in CentreWare Internet Services. For details, see **Setting Up Scanning to an FTP Server** on page 52.
- Scanning to an email address: Configure the email server in CentreWare Internet Services. For details, see **Setting Up Scanning to an Email Address** on page 52.

If the printer is connected using a USB cable, you cannot scan to an email address or a network location. You can scan to a folder on your computer, or scan into an application after installing the scan drivers and the Express Scan Manager utility. For more information, see **Installing the Software** on page 38.

**Setting Up Scanning to a Shared Folder on Your Computer**

Before you can scan to a shared folder you must:
- Share the folder.
- Add the folder as an Address Book entry using the Address Book Editor or CentreWare Internet Services.

  **Note:** For details, see **CentreWare Internet Services** on page 25.

**Sharing a Folder Using Windows**

To enable a folder on your Windows computer for network sharing:
1. Open Windows Explorer.
2. Browse to, then right-click the folder you want to share, then select Properties.
3. Click the **Sharing** tab, then click **Share this folder**.
4. Click the **Permissions** button.
5. Select the **Everyone** group, and verify that all permissions are enabled. If the group is not present, type **Everyone** into the text block and press **Enter**.
6. Click **OK**.
   
   **Note:** Record the Share name for later use.
7. Click **OK** again.
8. Open a DOS Command Prompt window:
    a. On the **Start** menu, select **Run**.
    b. In the **Open** field, type **cmd** and click **OK**.
9. Type **ipconfig**, then press **Enter**.
   
   **Note:** Record your IP address to use when creating the address book entry.
10. Close the DOS Command Prompt window.

The folder is ready. Now add the folder as an Address Book entry. See **Adding the Folder as an Address Book Entry Using the Address Book Editor** on page 51 or **Adding the Folder as an Address Book Entry Using CentreWare Internet Services** on page 51.

### Sharing the Folder Using Macintosh

To enable a folder on your Macintosh computer for network sharing:

1. Open **System Preferences**.
2. Click the **Sharing** icon.
3. Enable **Windows Sharing**.
4. Click the **Enable Accounts** button, then enable your account.
5. Follow the onscreen prompts for entering your password.
6. Click **Done**.
7. Click **Show All**, then click the **Network** icon.
8. Select **Built-in Ethernet** from the Show drop-down list.
   
   **Note:** Record your IP address to use when creating the address book entry.
9. Click **Show All**, then click **Accounts**.
   
   **Note:** Record your Short Name to use when creating the address book entry.
10. Close System Preferences.
11. Create a folder in your Public folder. The scanner places scanned images in this folder.
12. In the **Finder** window, click the folder you created.
13. On the **File** menu, click **Get Info**, then **Ownership & Permissions**.
14. Click **Details** to expand the window.
15. Set permissions for Group to have Read and Write access, then click **Apply**.
The folder is ready. Now add the folder as an Address Book entry. See Adding the Folder as an Address Book Entry Using the Address Book Editor on page 51 or Adding the Folder as an Address Book Entry Using CentreWare Internet Services on page 51.

Adding the Folder as an Address Book Entry Using the Address Book Editor

1. On your computer select **Start** > **All Programs** > **Xerox** > **WorkCentre 6505** > **Address Book Editor**. The Address Book Editor opens.
2. Double-click the **Server** icon under the Printer Address Book in the left navigation pane.
3. Enter a name in the **Name**: field to identify this access to the shared file on your computer.
4. Select **Computer (SMB)** as the Server Type.
5. Click the **Computer Settings Wizard** button. The Computer Folder Settings window appears.
6. Click the **Browse** button.
7. Browse to the shared folder that you created on your computer.
8. Click **OK**, then click **Next**.
9. Enter a Login Name for the printer to use to access the shared folder.
10. Enter, then confirm, a Login Password for the printer to use to access the shared folder.
11. Click **Next**, then click **Finish**. At the Server Address window, click **OK**. The new server appears in the Server pane at the top of the window.

Adding the Folder as an Address Book Entry Using CentreWare Internet Services

1. Open your Web browser, type the IP address for your printer in the address field, then press **Enter** or **Return**.
   
   *Note*: To find the IP address for your printer, see Finding the IP Address of Your Printer on page 35.
2. Click **Address Book**.
3. Under **Network Scan (Comp./Serv.)**, click **Comp./Server Address Book**.
4. Click **Add** next to any unused entry, and enter the following information:
   - **Name**: Enter the name that you want to appear in the Address Book.
   - **Network Type**: Select **Computer (SMB)**.
   - **Host Address**: Enter the IP address of your computer.
   - **Port Number**: Enter the default port number for SMB, 139, or select a number from the range provided.
   - **Name of Shared Directory**: Enter a name for the directory or folder.
   - **Subdirectory Path**: Enter the path of the subfolder on your computer. For example, if you want the scanned files to go in a folder called `colorsans` inside your shared folder, type `\colorsans`.
5. Click **Save Changes**. A new address book entry is created.

You can now scan to a folder on your computer. For more information, see Setting Up Scanning to a Shared Folder on Your Computer on page 49.
Setting Up Scanning to an FTP Server

1. Open your Web browser, type the IP address for your printer in the address field, then press Enter or Return.

   Note: To find the IP address for your printer, see Finding the IP Address of Your Printer on page 35.

2. Click Address Book.

3. Under Network Scan (Comp./Serv.), click Comp./Server Address Book.

4. Click Add next to any unused entry, and enter the following information:
   - Name: Type the name that you want to appear in the Address Book.
   - Network Type: Select Server (FTP).
   - Host Address: Enter the IP address or DNS name of the FTP server.
   - Port Number: Enter the default port number for FTP, 21, or select a number from the range provided.
   - Login Name: Enter a valid login name for your FTP server.
   - Password: Enter a valid password for your FTP server.
   - Re-enter Password: Enter the password again.
   - Name of Shared Directory: Enter a name for the directory or folder. For example, if you want the scanned files to go in a folder called scans type /scans.
   - Subdirectory Path: Enter the path of the folder on the FTP server. For example, if you want the scanned files to go in a folder called colorscans inside the scans folder, type /colorscans.

5. Click Save Changes. A new address book entry is created.

You can now scan to the FTP server. For more information, see Setting Up Scanning to an FTP Server on page 52.

Setting Up Scanning to an Email Address

Before you can scan to an email address, you must configure the printer to communicate with your SMTP email server.

To configure the SMTP server settings:

1. Open your Web browser, type the IP address for your printer in the address field, then press Enter or Return.

   Note: To find the IP address for your printer, see Finding the IP Address of Your Printer on page 35.

2. Click Properties.

3. Under Protocols in the left pane, click Email Settings.

4. Enter the following information:
   - Return Email Address: Enter the email address to be used when sending email messages to the printer. This is also the address that appears in the From: field of email messages sent by the printer.

   Note: A Return Email Address is not required by all SMTP servers in order to Scan to Email. The Return Email Address can usually be any email address that is in the correct format.

   - Host Address: Enter the IP address or DNS name of the SMTP server.
• **SMTP Port**: Enter the default port number for SMTP, 25, or select a number from the range provided.

  **Note**: If you use a DNS name, a DNS server must be configured in the TCP/IP settings.

5. Select an Authentication Type.
6. Enter a valid login name and password.
7. Scroll down and click **Save Changes**.

  **Note**: Contact your internet service provider (ISP) or system administrator to obtain your SMTP server name or IP address. Some ISP providers require authentication. Make sure to confirm authentication type, login, and password.

You can now scan to an email address. For more information, see Setting Up Scanning to an Email Address on page 52.

### Setting Up Scanning with USB

When connected with a USB cable, you can scan to a folder on your computer, or scan into an application. Before scanning, you must install the scan driver. For more information see Installing the Software on page 38.

### Setting Up Scanning to a Folder on Your Computer with USB

Before you can scan to a folder on your computer, you must install the Express Scan Manager utility. For more information see Installing the Software on page 38.

1. Start Express Scan Manager:
   - Windows: Click Start > Programs > Xerox > WorkCentre 6505 > Express Scan Manager.
   - Macintosh: Navigate to Applications > Xerox > WorkCentre 6505, and double-click Express Scan Manager.

2. Click **OK** to accept the default Destination Path folder, or click **Browse** to navigate to another folder.

3. Click **OK**.

You can now scan to a folder on your computer. For more information, see Scanning to a Folder on a Computer with a USB Connection on page 113.
Printing

This chapter includes:

- Supported Paper and Media on page 56
- Loading Paper on page 61
- Setting Paper Types and Sizes on page 68
- Selecting Printing Options on page 70
- Printing on Specialty Media on page 77
- Printing Custom Sizes on page 87
- Printing on Both Sides of the Paper on page 91
- Printing Using Secure Print on page 95
- Printing Using Proof Print on page 97
Supported Paper and Media

This section includes:
- Paper Usage Guidelines on page 56
- Paper That Can Damage Your Printer on page 57
- Paper Storage Guidelines on page 57
- Supported Paper on page 58

Your printer is designed to use various paper and other media types. Follow the guidelines in this section to ensure the best print quality and to avoid jams.

For best results, use Xerox® printing media specified for your printer. They are guaranteed to produce excellent results with your printer.

To order paper or other specialty media, contact your local reseller or go to www.xerox.com/office/WC6505supplies.

⚠️ CAUTION: The Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee do not cover damage caused by using unsupported paper, transparencies, and other specialty media. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage can vary outside these areas. Please contact your local representative for details.

See also:
- Recommended Media List (Europe): www.xerox.com/europaper
- Recommended Media List (North America): www.xerox.com/paper

Paper Usage Guidelines

Each printer tray accommodates certain sizes and types of paper or other specialty media. Follow these guidelines when loading paper in the trays:
- Fan paper before loading it in the tray.
- Do not print on label stock once a label has been removed from a sheet.
- Use only paper envelopes. Do not use envelopes with windows, metal clasps, or adhesives with release strips.
- Print all envelopes 1-sided only.
- Some wrinkling and embossing can occur when printing envelopes.
- Do not overload the paper trays. Do not load paper above the fill line on the inside of the paper guide.
- Adjust the paper guides to fit the paper size. The paper guides click into place when they are adjusted correctly.
- If excessive jams occur, use paper or other media from a new package.
Paper That Can Damage Your Printer

Your printer is designed to use various paper types. However, some paper can cause poor output quality, increase paper jams, or damage your printer.

Unacceptable media includes:
- Rough or porous media
- Transparencies
- Paper that has been folded or wrinkled
- Paper with staples
- Envelopes with windows or metal clasps
- Padded envelopes
- Non-laser glossy or coated paper
- Perforated media
- Carbon backed media or paper
- Pressure sensitive media or paper
- Paper designed for use in inkjet printers

Paper Storage Guidelines

Providing good storage conditions for your paper contributes to optimum print quality.

- Store paper in dark, cool, relatively dry locations. Most paper items are susceptible to damage from ultraviolet (UV) and visible light. UV radiation emitted by the sun and fluorescent bulbs is particularly damaging to paper items. Reduce the intensity and length of exposure to visible light on paper items as much as possible.
- Maintain constant temperatures and relative humidity.
- Avoid moisture, excessive humidity, and heat above 32°C (90°F).
- Avoid attics, kitchens, garages, and basements for storing paper. Inside walls are drier than outside walls where moisture can collect.
- Store paper flat on pallets, cartons, shelves, or in cabinets.
- Avoid having food or drinks in the area where paper is stored or handled.
- Do not open sealed packages of paper until you are ready to load them into the printer. Leave paper in the original packaging. For most commercial cut-size grades, the ream wrapper contains an inner lining that protects the paper from moisture loss or gain.
Supported Paper

Using unsuitable paper can lead to paper jams, poor print quality, and damage to your printer. To use the features of the printer effectively, use the paper recommended in the following tables.

Printing on paper that has settings different from the paper size or paper type selected in the print driver can lead to paper jams. Loading paper into a paper tray unsuitable for the type of print job can also lead to paper jams. To ensure that printing is done correctly, select the correct paper size, paper type, and paper tray.

The printed image can fade due to moisture, such as water, rain or vapor. For details, contact your reseller.

<table>
<thead>
<tr>
<th>Tray 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Paper Size</strong></td>
</tr>
<tr>
<td>Letter (8.5 x 11 in.)</td>
</tr>
<tr>
<td>US Folio (8.5 x 13 in.)</td>
</tr>
<tr>
<td>Legal (8.5 x 14 in.)</td>
</tr>
<tr>
<td>Executive (7.25 x 10.5 in.)</td>
</tr>
<tr>
<td>A4 (210 x 297 mm, 8.2 x 11.5 in.)</td>
</tr>
<tr>
<td>A5 (148 x 210 mm, 5.2 x 8.2 in.)</td>
</tr>
<tr>
<td>JIS B5 (182 x 257 mm)</td>
</tr>
<tr>
<td>#10 Envelope (4.1 x 9.5 in.)</td>
</tr>
<tr>
<td>Monarch Envelope (3.9 x 7.5 in.)</td>
</tr>
<tr>
<td>DL Envelope (110 x 220 mm)</td>
</tr>
<tr>
<td>C5 Envelope (162 x 229 mm)</td>
</tr>
<tr>
<td>Custom size range:</td>
</tr>
<tr>
<td>Width: 76.2–215.9 mm (3–8.5 in.)</td>
</tr>
<tr>
<td>Height: 127–355.6 mm (5–14 in.)</td>
</tr>
<tr>
<td><strong>Paper Type and Weight</strong></td>
</tr>
<tr>
<td>Plain (65–120 g/m², 17–32 lb. Bond)</td>
</tr>
<tr>
<td>Lightweight Cardstock (100–163 g/m², 37–60 lb. Cover)</td>
</tr>
<tr>
<td>Heavyweight Cardstock (163–220 g/m², 60–80 lb. Cover)</td>
</tr>
<tr>
<td>Envelope</td>
</tr>
<tr>
<td>Labels</td>
</tr>
<tr>
<td>Letterhead</td>
</tr>
<tr>
<td>Lightweight Glossy Cardstock (100–163 g/m², 37–60 lb. Cover)</td>
</tr>
<tr>
<td>Heavyweight Glossy Cardstock (163–220 g/m², 60–80 lb. Cover)</td>
</tr>
<tr>
<td>Hole Punched</td>
</tr>
<tr>
<td>Colored Paper</td>
</tr>
<tr>
<td>Special (Lightweight Cardstock 1)</td>
</tr>
<tr>
<td><strong>Loading Capacity</strong></td>
</tr>
</tbody>
</table>
### 250-Sheet Feeder (Tray 2)

| Paper Size | Letter (8.5 x 11 in.)  
|            | US Folio (8.5 x 13 in.)  
|            | Legal (8.5 x 14 in.)  
|            | Executive (7.25 x 10.5 in.)  
|            | A4 (210 x 297 mm)  
|            | A5 (148 x 210 mm)  
|            | JIS B5 (182 x 257 mm)  
|            | Custom size range:  
|            | Width: 147.3–215.9 mm (5.8–8.5 in.)  
|            | Height: 210.8–355.6 mm (8.3–14 in.)  
| Paper Type and Weight | Plain Paper (60–105 g/m², 16–28 lb. Bond)  
|            | Letterhead  
|            | Hole Punched  
|            | Colored Paper  
| Loading Capacity | 250 sheets (20 lb.)

### Manual Feed Slot

| Paper Size | Letter (8.5 x 11 in.)  
|            | Legal (8.5 x 14 in.)  
|            | Executive (7.25 x 10.5 in.)  
|            | US Folio (8.5 x 13 in.)  
|            | No. 10 Envelope (4.1 x 9.5 in.)  
|            | Monarch Envelope (3.9 x 7.5 in.)  
|            | DL Envelope (110 x 220 mm)  
|            | C5 Envelope (162 x 229 mm)  
|            | A4 (210 x 297 mm)  
|            | A5 (148 x 210 mm)  
|            | JIS B5 (182 x 257 mm)  
|            | Custom size range:  
|            | Width: 76.2–215.9 mm (3–8.5 in.)  
|            | Height: 127–355.6 mm (5–14 in.)  

### Manual Feed Slot

<table>
<thead>
<tr>
<th>Paper Type and Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Plain (65–120 g/m², 17–32 lb. Bond)</td>
</tr>
<tr>
<td>• Letterhead (plain)</td>
</tr>
<tr>
<td>• Lightweight Cardstock (100–163 g/m², 28–60 lb. Cover)</td>
</tr>
<tr>
<td>• Heavyweight Cardstock (163–220 g/m², 60–80 lb. Cover)</td>
</tr>
<tr>
<td>• Lightweight Glossy Cardstock (100–163 g/m², 28–60 lb. Cover)</td>
</tr>
<tr>
<td>• Heavyweight Glossy Cardstock (163–220 g/m², 60–80 lb. Cover)</td>
</tr>
<tr>
<td>• Hole Punched (plain)</td>
</tr>
<tr>
<td>• Colored Paper (plain)</td>
</tr>
<tr>
<td>• Labels</td>
</tr>
<tr>
<td>• Envelope (short-edge feed only for Monarch and DL envelopes)</td>
</tr>
<tr>
<td>• Special</td>
</tr>
</tbody>
</table>

| Loading Capacity | One sheet at a time |

### Duplex Unit (2-Sided Printing)

<table>
<thead>
<tr>
<th>Paper Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>• A4 (210 x 297 mm)</td>
</tr>
<tr>
<td>• Letter (8.5 x 11 in.)</td>
</tr>
<tr>
<td>• US Folio (8.5 x 13 in.)</td>
</tr>
<tr>
<td>• Legal (8.5 x 14 in.)</td>
</tr>
<tr>
<td>• Custom size range:</td>
</tr>
<tr>
<td>• Width: 76.2–215.9 mm (3–8.5 in.)</td>
</tr>
<tr>
<td>• Height: 127–355.6 mm (5–14 in.)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Paper Type and Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Plain (60–105 g/m², 16–28 lb. Bond)</td>
</tr>
<tr>
<td>• Letterhead (plain)</td>
</tr>
<tr>
<td>• Hole Punched (plain)</td>
</tr>
<tr>
<td>• Colored Paper (plain)</td>
</tr>
</tbody>
</table>

| Loading Capacity | One sheet at a time |
Loading Paper

This section includes:

- Loading Paper in Tray 1 on page 61
- Loading Paper in the Manual Feed Slot on page 63
- Loading Paper in the 250-Sheet Feeder (Tray 2) on page 65

Loading Paper in Tray 1

You can use Tray 1 for a wide variety of media, including:

- Plain Paper
- Lightweight Cardstock
- Heavyweight Cardstock
- Letterhead
- Labels
- Envelopes
- Lightweight Glossy Cardstock
- Heavyweight Glossy Cardstock
- Hole Punched
- Colored Paper
- Pre-printed Paper (paper already printed on one side)
- Custom Size Paper

For a complete list of paper types and sizes usable in Tray 1, see Supported Paper on page 58.

Follow these guidelines when loading paper into Tray 1:

- Load up to 250 sheets of plain paper, or a stack of paper (65–220 g/m², 17–40 lb. Bond, 40–80 lb. Cover) less than 15 mm high (0.60 in.).
- Tray 1 holds paper within the following dimensions:
  - Width: 76.2–216 mm (3–8.5 in.)
  - Length: 127–355.6 mm (5–14 in.)
  - For automatic 2-sided printing, you can load paper in the range of 60–105 g/m² (16–28 lb. Bond).
- Do not load different types of paper in the same tray at the same time.
- To print high quality, use high-quality paper intended for laser printers.
- Do not remove or add paper to Tray 1 during printing. Doing so could cause a paper jam. Remove the paper, align it with the new paper and insert both into the tray together.
- Do not put any objects other than paper in Tray 1.
- Do not push or force down Tray 1.
- Always load paper for short edge feed.

For more paper usage guidelines, see Supported Paper and Media on page 56.
To load paper in Tray 1:

1. Gently pull out the paper tray.

2. Slide the paper width guides to the edge of the tray. Extend the width guides fully as shown in the following illustration.

3. Before loading the paper flex the sheets back and forth, and then fan them. Straighten the edges of the stack on a level surface.
4. Insert all paper face up, with the top edge at the front of the paper tray.

   **Notes:**
   - Do not force the paper into the tray.
   - Be careful not to bend the paper.

5. Slide the paper width guides until they rest lightly against the edge of the paper stack.
6. Insert the tray back into the printer until it stops.

   **CAUTION:** Be careful not to use excessive force on the tray. Doing so could damage the printer.

**See also:**
- Setting Paper Types and Sizes on page 68
- Loading Paper in the Manual Feed Slot

**Loading Paper in the Manual Feed Slot**

Use the manual feed slot for a wide range of media including:

- Plain Paper
- Letterhead
- Lightweight Cardstock
- Heavyweight Cardstock
- Lightweight Glossy Cardstock (Coated 2 and Coated 3)
- Heavyweight Glossy Cardstock
- Colored Paper
- Labels
- Envelopes
- Special

For a more complete list of paper types and sizes usable in the Manual Feed Slot, see Supported Paper on page 58.

Follow these guidelines to avoid problems during printing:

- Use several sheets of the paper only when adjusting the paper width guides.
- Holding the paper on both sides, slowly and evenly insert the paper into the printer.
- If the paper looks skewed after the printer pulls it in, gently remove the paper and reseat it. Then press the OK button or wait for the automatic calibration to start.
To load paper in the manual feed slot:
1. Slide the paper guides of the manual feed slot to fit the paper you are using.

2. Place the paper into the slot with the print side face down and the top of the sheet entering the printer first.

   **Note:** You can insert paper during the ready mode or sleep mode of the printer. The printer automatically detects the paper and holds it while it waits for a print job.
Loading Paper in the 250-Sheet Feeder (Tray 2)

You can use the 250-sheet feeder for the following types of paper:

- Plain paper
- Letterhead
- Hole Punched
- Colored Paper

For supported paper sizes and weights, see Supported Paper on page 58.

Follow these guidelines to avoid problems during printing:

- Do not load different types of paper in the tray at the same time.
- To print high quality, use high-quality paper intended for laser printers.
- Do not remove or add paper to the 250-sheet feeder during printing. Doing so can cause a paper jam. Remove the paper, align it with the new paper, and insert both into the tray together.
- Do not put any objects other than paper in the tray.
- Do not push or force down the tray.
- Always load paper short-edge feed first.

⚠️ CAUTION: Do not remove the tray during printing because it can cause a paper jam.

To load paper in the 250-sheet feeder:

1. Gently pull the paper tray out of the printer.
2. Slide the paper width guides to the edge of the tray. Extend the width guides fully as shown in the following illustration.

3. Squeeze the green tab on the length guide, then slide the tray until the arrow lines up with the appropriate paper size. The guide clicks into place.

4. Before loading the paper, flex the sheets back and forth, and then fan them. Straighten the edges of the stack on a level surface.

5. Place the paper into the tray with the print side face up.
   Note: Do not exceed the maximum fill line in the tray. Overfilling the tray can cause paper jams.
6. Slide the width and length guides until they rest lightly against the edge of the paper stack.  
   **Note:** Be careful not to bend the paper.

   ![Image of width and length guides](wc6505_017)

7. Insert the tray back into the printer until it stops.

   ![Image of tray insertion](wc6505_050)

   **CAUTION:** Be careful not to use excessive force on the tray. Doing so could damage the printer.

*See also:*
   Setting Paper Types and Sizes on page 68
Setting Paper Types and Sizes

This section includes:

- Setting the Paper Type on page 68
- Setting the Paper Size on page 68

After loading paper in paper Tray 1 or the 250-sheet feeder (Tray 2), set the paper type and size on the printer control panel.

Notes:

- If None is selected in the Paper Type menu in the print driver, the printer uses the control panel settings. The printer prints only when the settings for the paper size and type configured in the print driver match the control panel settings. If the settings in the print driver and control panel do not match, follow the instructions displayed on the control panel.
- You can select an option to display a message prompting you to set the paper size and type on the control panel each time paper is loaded. For details, see Tray Settings on page 163.

Setting the Paper Type

⚠️ CAUTION: Paper type settings must match the type of paper loaded in the tray or print-quality problems can occur.

Note: If None is selected in the Paper Type menu in the print driver, the printer uses the control panel settings. The printer prints only when the settings for the paper size and type configured in the print driver match the control panel settings. If the settings in the print driver and control panel do not match, the print driver setting overrides the control panel setting for this job.

To set the paper type for paper in a tray:

1. On the control panel, press the System button.
2. Press the Up Arrow or Down Arrow button to select Tray Settings, then press the OK button.
3. Press the Up Arrow or Down Arrow button to select the tray you are setting, then press OK.
4. At Paper Type, press OK.
5. Press the Up Arrow or Down Arrow button to select the type of paper that is loaded in the tray, then press OK.
6. Press the Return button to return to the Ready screen.

Setting the Paper Size

To set the paper size for paper in a tray:

1. On the control panel, press the System button.
2. Press the Up Arrow or Down Arrow button to select Tray Settings, then press the OK button.
3. Press the Up Arrow or Down Arrow button to select the tray you are setting, then press OK.
4. Press the Up Arrow or Down Arrow button to select Paper Size, then press OK.
5. Select the paper size, then press OK.
6. Press the Return button to return to the Ready screen.
Selecting Printing Options

This section includes:
- Selecting Printing Defaults in Windows on page 70
- Selecting Printing Defaults in Windows for a Shared Network Printer on page 71
- Selecting Printing Options for an Individual Job in Windows on page 71
- Selecting Printing Options for an Individual Job in Macintosh on page 75

Note: Print driver settings override control panel settings when you print using the driver software on your computer.

Selecting Printing Defaults in Windows

Notes:
- These instructions are for setting print driver defaults for the print driver software installed on your computer. You can set defaults settings for a network printer that apply to that printer for anyone who accesses it over the network. For details, see Selecting Printing Defaults in Windows for a Shared Network Printer on page 71.
- Use the following procedure to set the default settings used for all print jobs sent to the printer from your computer using the specific driver. You can override the default settings for an individual print job when printing from an application.

1. Navigate to the list of printers on your computer:
   - For Windows XP SP1 and later, click Start > Settings > Printers and Faxes.
   - For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers.
   - For Windows Server 2003 and later, click Start > Settings > Printers.
   - For Windows 7, click Start > Devices and Printers.
2. In the Printers folder, right-click the name of your print driver (printer name plus PCL 6 or PS) and select Printing Preferences.
3. Make selections on the driver tabs as desired, then click OK to save your selections.
4. Set defaults for the other print driver if applicable.

Note: For more information about Windows print driver options, click the Help button in the Printing Preferences dialog box to view the online help.
Selecting Printing Defaults in Windows for a Shared Network Printer

If the printer is shared on a network, you can set printing defaults that apply to anyone who accesses it from the network. You can override network-level defaults through the driver settings on an individual computer.

1. Navigate to the list of printers on your computer:
   - For Windows XP SP1 or later, click Start > Settings > Printers and Faxes.
   - For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers.
   - For Windows 7, click Start > Devices and Printers.

2. In the Printers folder, right-click the name of your print driver (printer name plus PCL 6 or PS) and select Properties.

3. In the printer Properties dialog box, click the Advanced tab.

4. On the Advanced tab, click the Printing Defaults button.

5. Make selections on the driver tabs as desired, then click Apply to apply your selections.

6. Click OK to save your selections.

Selecting Printing Options for an Individual Job in Windows

This section includes:
- Printing Options for Windows PostScript Driver on page 72
- Printing Options for Windows PCL Driver on page 73

To use special printing options for a particular job, change the print driver settings in the application before sending the job to the printer.

**Note:** The print driver includes online help with more information on selecting printing options. In the driver dialog boxes, click the Help button.

To select printing options:
1. With the desired document or graphic open in your application, open the Print dialog box.
2. Select your **WorkCentre 6505** printer (either PostScript or PCL) and then click the Properties button to open the print driver dialog box.
3. Make selections from the driver tabs as desired, beginning with settings in the Paper/Output tab. For a list of options, see Printing Options for Windows PostScript Driver on page 72, and Printing Options for Windows PCL Driver on page 73.

**Note:** In the PCL driver for Windows, you can save a set of printing options with a distinctive name and apply them to other print jobs. For instructions, click the Help button in the print driver dialog box to view the online help.
### Printing Options for Windows PostScript Driver

For detailed information on using the print driver options, click the **Help** button in the print driver to view the online help.

**Note:** For optional printer features to be available in the print driver, the optional features must be installed and enabled. If you have not enabled your installed optional features, see **Enabling Optional Features for the Windows PostScript Driver** on page 46.

<table>
<thead>
<tr>
<th>Driver Tab</th>
<th>Printing Option</th>
</tr>
</thead>
</table>
| Paper/Output   | • Job Type: Specifies the type of print job: Normal Print, Secure Print, Proof Print. Secure Print and Proof Print available with extra RAM memory only.  
• 2-Sided Print: 1-Sided Print, Flip on long edge, Flip on short edge.  
• Paper Size: Specifies the size of the paper to print on, including specifying a custom paper size.  
• Paper Tray: Specifies which paper tray to print to when the Paper Tray setting in the PostScript print driver is set to Auto Select.  
• Paper Type: Specifies the type of paper in the tray.  
• Image Orientation: Portrait or Landscape.  
• Output Color: Color or Black and White.  
• Saved Settings: Enables you to save the current settings under a specific name so that they can be used repeatedly. Also enables you to load and edit a set of saved settings.  
• Printer Status button: Opens the internal settings page of the printer in CentreWare Internet Services, in your computer Web browser for network printers only.  
• Defaults button: Returns all of the Paper/Output tab settings to their default settings.  
• Default All button: Returns all settings in the Properties dialog of the printer to their default settings.  
• Help button: Opens the online help of the print driver for the Paper/Output tab. |
| Image Options  | • Image Quality: Affects the quality of the print by specifying the speed at which the page prints.  
• Brightness: Makes the printed image or page darker or lighter.  
• Color Correction: Specifies how color is applied to printed images, text, and photographs.  
• Color Balance button: Enables you to specify the density of each color used for printing.  
• Defaults button: Returns all of the Image Options tab settings to their default settings.  
• Help button: Opens the online help of the print driver for the Image Options tab. |
| Layout         | • Pages per Sheet (N-up): For multiple-page documents, enables you to print more than one page per sheet of paper, including Booklet print.  
• Draw Outlines: When multiple pages are printed per sheet, prints a border around each page.  
• Fit to New Paper Size: Select the output paper size to fit the page.  
• Defaults button: Returns all of the Layout tab settings to their defaults.  
• Help button: Opens the online help of the print driver for the Layout tab. |
Printing Options for Windows PCL Driver

For detailed information on using the print driver options, click the Help button in the print driver to view the online help.

Note: For optional printer features to be available in the print driver, the optional features must be installed and enabled. If you have not enabled your installed optional features, see Enabling Optional Features for the Windows PCL Driver on page 47.

<table>
<thead>
<tr>
<th>Driver Tab</th>
<th>Printing Option</th>
</tr>
</thead>
</table>
| Advanced    | • Image Options: Enables you to set print resolution, image color management and method used, TrueType font configuration, and image magnification or reduction percentage for printed images.  
• Document Options: Enables you to set the PostScript Options and the Manual Feed slot Orientation. PostScript Options include the PostScript Output Format, TrueType Font Download Method, PostScript Language Level, PostScript Error Message control, and Mirror Image control.  
• Help button: Opens the online help of the print driver for the Advanced tab.  
• Set Features to Default button: Returns the Advanced tab settings to their defaults. |

<table>
<thead>
<tr>
<th>Driver Tab</th>
<th>Printing Option</th>
</tr>
</thead>
</table>
| Paper/Output| • Job Type: Specifies the type of print job: Normal Print, Secure Print, Proof Print. Secure Print and Proof Print are available with extra RAM memory only.  
• 2-Sided Print: 1-Sided Print, Flip on long edge, Flip on short edge.  
• Paper Size: Specifies the size of the paper to print on, including specifying a custom paper size.  
• Output Color: Color or Black and White.  
• Paper Type: Specifies the type of paper in the tray.  
• Saved Settings: Enables you to save the current settings under a specific name so that they can be used repeatedly. Also enables you to load and edit a set of saved settings.  
• Paper Tray: Specifies which paper tray to print to when the Paper Tray setting in the PCL driver is set to Auto Select.  
• Manual Feed Slot Orientation: Portrait or Landscape.  
• Covers/Separators button: Enables you to specify cover and separator pages for print jobs.  
• Printer Status button: Opens the internal settings page of the printer in CentreWare Internet Services in your computer Web browser for network printers only.  
• Defaults button: Returns the Paper/Output tab settings to their defaults. |
<table>
<thead>
<tr>
<th>Driver Tab</th>
<th>Printing Option</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Image Options</strong></td>
<td>• Image Quality: Affects the print quality by specifying way the image is processed and marked on the page.</td>
</tr>
<tr>
<td></td>
<td>• Output Color: Specifies Color or Black and White.</td>
</tr>
<tr>
<td></td>
<td>• Output Recognition: When Color is selected in the Output Color field, selecting this check box causes some chromatic colors to be printed as black.</td>
</tr>
<tr>
<td></td>
<td>• Image Adjustment Mode: Recommended, ICM Adjustment (System), CMS Adjustment (Application), Complementary Color Conversion.</td>
</tr>
<tr>
<td></td>
<td>• Image Types: Enables you to specify a printing mode to match the characteristics of the printed image.</td>
</tr>
<tr>
<td></td>
<td>• Image Auto Correction: Determines the characteristics of a specified image type, such as photographs on a page, and automatically performs correction for it.</td>
</tr>
<tr>
<td></td>
<td>• Image Settings button: Opens the Image Settings tab of the Graphics Properties dialog box.</td>
</tr>
<tr>
<td></td>
<td>• Color Balance button: Opens the Color Balance tab of the Graphics Properties dialog box.</td>
</tr>
<tr>
<td></td>
<td>• Profile Settings button: Opens the Profile Settings tab of the Graphics Properties dialog box.</td>
</tr>
<tr>
<td></td>
<td>• Defaults button: Returns the Image Option tab settings to their default settings.</td>
</tr>
<tr>
<td><strong>Layout</strong></td>
<td>• Pages per Sheet (N-up): For multiple-page documents, enables you to print more than one page on one sheet of paper.</td>
</tr>
<tr>
<td></td>
<td>• Image Order: (Available only if more than one page is being printed on a sheet.) Determines the order in which pages are printed on the sheet.</td>
</tr>
<tr>
<td></td>
<td>• Draw Outlines: When multiple pages are printed per sheet, prints a border around each page.</td>
</tr>
<tr>
<td></td>
<td>• Booklet/Poster/Mixed Document/Rotation button: Provides selection of Poster printing, Booklet Creation, and Image Rotation. Poster printing enlarges one page of data and prints it across multiple pages. Booklet Print repaginates the original document and prints two pages per sheet so that you can fold it into a booklet. Image rotation allows rotation of the output for files with pages that have mixed orientation.</td>
</tr>
<tr>
<td></td>
<td>• Fit to New Paper Size: Select the output paper size to fit the page.</td>
</tr>
<tr>
<td></td>
<td>• Reduce/Enlarge: Specifies percentage to reduce or enlarge the image being printed.</td>
</tr>
<tr>
<td></td>
<td>• Image Orientation: Specifies Portrait or Landscape.</td>
</tr>
<tr>
<td></td>
<td>• Margin Shift/Margins button: Provides access to page margin settings.</td>
</tr>
<tr>
<td></td>
<td>• Defaults button: Returns the Layout tab settings to their default settings.</td>
</tr>
<tr>
<td><strong>Watermarks/Overlays</strong></td>
<td>Provides access to settings for creating watermarks and overlays to print on pages. A page overlay is a group of PCL commands and/or data created from a page image and is stored as an external file.</td>
</tr>
<tr>
<td><strong>Advanced</strong></td>
<td>Provides access to advanced printer options such as skipping blank pages, printing in draft mode, banner mode, and size mismatch settings. It provides access to certain graphic settings and font settings.</td>
</tr>
</tbody>
</table>
Selecting Printing Options for an Individual Job in Macintosh

To use special printing options for a particular job, change the print driver settings in the application before sending the job to the printer.

Note: The print driver includes help with more information on selecting printing options.

1. With the document open in your application, click **File** and then click **Print**.
2. Select the desired printing options from the menus and drop-down lists that are displayed. For a list of options, see Printing Options for Macintosh OS X Version 10.5 and Later on page 75.

Note: In Macintosh OS X, click **Save** from the Presets drop-down list on the Print menu to save the current printer settings. You can create multiple presets and save each with its own distinctive name and printer settings. To print jobs using specific printer settings, select the applicable saved preset in the Presets list.

3. Click **Print** to print the job.

Printing Options for Macintosh OS X Version 10.5 and Later

For detailed information on using the print driver options, click the question mark (?) button in the print driver dialog boxes to view the online help.

<table>
<thead>
<tr>
<th>Driver Drop-Down Title</th>
<th>Printing Options</th>
</tr>
</thead>
</table>
| Copies & Pages         | • Copies: Specifies number of copies and whether to collate.  
                        | • Pages: All, Current, Selection, From x to x, Page range. |
| Layout                 | • Pages per Sheet: Specifies the number of pages to print on each sheet of paper.  
                        | • Layout Direction: Specifies the order in which to print the pages when printing multiple pages on one sheet of paper.  
                        | • Border: Specifies the type and width of border to print around each page printed on the sheet of paper.  
                        | • Two-Sided: When selected, specifies whether to flip the page on the long edge or the short edge (duplex unit required). |
| Color Matching         | • ColorSync: This selection allows you to choose a profile from the Profile selection menu.  
                        | • In printer |
| Paper Handling         | • Pages To Print: All Pages, Odd Only, Even Only.  
                        | • Destination paper size: (Active only when Scale to fit paper size is selected.)  
                        | • Page Order: Automatic, Normal, Reverse. |
| Paper Feed             | • All pages from: Specifies the tray to print all pages from: Auto Select, Manual Feed Slot, Tray 1, Tray 2 (if installed).  
                        | • First page from: Specifies the tray from which to print the first page.  
<pre><code>                    | • Remaining from: Specifies the tray from which to print the remaining pages. |
</code></pre>
<table>
<thead>
<tr>
<th>Driver Drop-Down Title</th>
<th>Printing Options</th>
</tr>
</thead>
</table>
| Cover Page             | - Print Cover Page: None, Before document, After document. When an option other than None is selected, a cover page prints.  
                          - Cover Page Type: Classified, Confidential, Secret, Standard, Top Secret, Unclassified.  
                          - Billing Info: A field in which you can specify billing information to print on the cover page. |
| Scheduler              | - Print Document: Now, At [time], On Hold.  
                          - Priority: Urgent, High, Medium, Low. |
| Job Type               | Specifies the type of print job: Normal Print, Secure Print, Proof Print. Secure Print and Proof Print are available with extra RAM memory only. |
| Job Control            | - Account Mode: User, Administrator.  
                          - User Settings: Specifies account settings such as name and password. |
| Printer Features       | - Print Quality/Color: Specifies output color, image quality, brightness, color correction method, halftone screen settings, and adjust color balance.  
                          - Color Adjustment: Specifies RGB color adjustment settings.  
                          - Color Balance (C, M, Y, K): Specifies amount of color to use.  
                          - Media Handling: Specifies manual feed slot orientation, paper type, size mismatch setting, and custom paper auto orientation.  
| Supply Levels          | Displays bar graph showing level of toner left in each toner cartridge, and the useful life remaining of the imaging unit. |
| Summary                | Summarizes the driver selections. |
Printing on Specialty Media

This section includes:
- Printing Envelopes on page 77
- Printing Labels on page 80
- Printing on Glossy Cardstock on page 82
- Printing on Cardstock on page 85

Printing Envelopes

This section includes:
- Guidelines for Printing Envelope on page 77
- Printing Envelopes from Tray 1 on page 78
- Printing Envelopes from the Manual Feed Slot on page 79
- Printing Envelopes using the PostScript Driver on page 79
- Printing Envelopes using the PCL Driver on page 79

Guidelines for Printing Envelope

- Envelopes can be printed from Tray 1 and from the manual feed slot.
- Do not perform automatic 2-sided printing using envelopes.
- Successful envelope printing is highly dependent on the quality and construction of the envelopes. Use envelopes made specifically for laser printers, in the supported sizes. For a listing of supported envelope sizes for Tray 1 and the manual feed slot, see Supported Paper on page 58.
- Store unused envelopes in their packaging to avoid the effects of moisture and dryness, which can affect print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or during printing. For best results, maintain constant temperatures and relative humidity.
- Do not use padded envelopes. Purchase envelopes that lie flat.
- Remove air bubbles from the envelopes before loading by setting a heavy book on top of the envelopes.
- If wrinkling or embossing problems occur, use a different brand of envelope made specifically for laser printers.

⚠️ CAUTION: Never use envelopes with windows or metal clasps because they can damage the printer. Damage caused by using unsupported envelopes is not covered under the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage can vary outside these areas. Please contact your local representative for details.
Printing

Printing Envelopes from Tray 1

To load envelopes:
1. Gently pull out the paper tray. For details, see Loading Paper in Tray 1 on page 61.
2. Slide the paper guides to the edge of the tray.
3. Insert the envelopes with the flaps closed, flaps down, and flaps to the right. You can load envelopes up to the maximum fill line in the tray.
   
   Note: You cannot print on the reverse side of the envelope. Envelopes can get wrinkled or the print quality can be reduced, depending on the envelope type used.

4. Slide the paper guides so they rest lightly against the edges of the envelopes.
5. Insert the tray back into the printer until it stops.
6. On the control panel, press the System button to display the Menu screen.
7. Press the Up Arrow or Down Arrow button to select Tray Settings, then press the OK button.
8. At Tray 1, press OK.
9. Press the Up Arrow or Down Arrow button to select Paper Type, then press OK.
10. Press the Up Arrow or Down Arrow button to select Envelope, then press OK.
11. Press the Return button once to back out of the menu.
12. Press the Up Arrow or Down Arrow button to select Paper Size, then press OK.
13. Press the Up Arrow or Down Arrow button to select the desired envelope size, then press OK.
14. Do one of the following:
   - If you are printing using the PostScript driver, go to Printing Envelopes using the PostScript Driver on page 79.
   - If you are printing using the PCL driver, go to Printing Envelopes using the PCL Driver on page 79.
Printing Envelopes from the Manual Feed Slot

*Note:* You can load only one envelope at a time in the manual feed slot.

To load an envelope:

1. Slide the paper guides of the manual feed slot to fit the envelopes you are using. For details, see Loading Paper in the Manual Feed Slot on page 63.

2. Insert one envelope with the flaps closed, flaps up, and flaps to the right as shown in the illustration.

3. Slide the paper guides so they rest lightly against the edge of the envelope.

4. Do one of the following:
   - If you are printing using the PostScript driver, go to Printing Envelopes using the PostScript Driver on page 79.
   - If you are printing using the PCL driver, go to Printing Envelopes using the PCL Driver on page 79.

Printing Envelopes using the PostScript Driver

1. After loading the envelopes in the appropriate tray or the manual feed slot, in the application you are printing from, open the *Print* dialog box.

2. Select the *WorkCentre 6505 PS* printer from the list of printers, then click the *Properties* or *Preferences* button.

3. On the Paper/Output tab, do the following:
   a. From the Paper Size list, select the envelope size.
   b. From the Paper Type list, select *Envelope*.
   c. From the Paper Tray list, select the tray you are using.

4. Click *OK*.

5. In the Print dialog box, click *OK* or *Print* to start printing.

Printing Envelopes using the PCL Driver

1. After loading the envelopes in the appropriate tray, in the application you are printing from, open the *Print* dialog box.
2. Select the **WorkCentre 6505 PCL** printer from the list of printers, then click the **Properties** or **Preferences** button.

3. Click the **Paper/Output** tab, then do the following:
   a. From the **Paper Size** list, select the envelope size.
   b. From the **Paper Type** list, select **Envelope**.
   c. From the **Paper Tray** list, select the tray you are using.

4. Select the **Layout** tab.

5. From the **Fit to New Paper Size** list, select the envelope size.
   
   **Note:** Some applications do not allow you to rotate the image for printing on envelopes the way they are fed into the printer. Since you cannot change the way the envelope is fed into the printer, you can use the special rotation setting of the print driver. In the Layout tab, click the **Booklet/Poster/Mixed Document/Rotation** button and select **Portrait & Landscape [For envelopes]** from the **Image Rotation (180 deg)** list, then click **OK**.

6. Click **OK**.

7. In the Print dialog box, click **OK** or **Print** to start printing.

### Printing Labels

This section includes:

- **Guidelines for Printing Labels** on page 80
- **Printing Labels from Tray 1** on page 81
- **Printing Labels from the Manual Feed Slot** on page 81

To order paper or other specialty media, contact your local reseller or go to the Xerox® Supplies website at [www.xerox.com/office/WC6505supplies](http://www.xerox.com/office/WC6505supplies).

### Guidelines for Printing Labels

**Note:** Labels can be printed from Tray 1 and from the manual feed slot.

- Do not use vinyl labels.
- Print only on one side of the sheet of labels. Use full sheet labels only.

**CAUTION:** Do not use any sheet where labels are missing; it can damage the printer.

- Do not use labels that are perforated, have backing sheets that have partially peeled away or that have parts of the labels already removed.
- Store unused labels flat in their original packaging. Leave the sheets of labels inside the original packaging until ready to use. Return any unused sheets of labels to the original packaging and reseal it.
- Do not store label sheets in extreme conditions of temperature or humidity. Storing them in extreme conditions can cause print-quality problems or cause them to jam in the printer.
- Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and jam in the printer.
Printing Labels from Tray 1

1. Gently pull out the paper tray and slide open the paper guides. For details, see Loading Paper in Tray 1 on page 61.
2. Fan the labels to release sheets that are stuck together.
3. Insert the labels with the label side up and with the top of the sheets at the front of the tray. Do not load more than 25 sheets.
4. Adjust the paper guides to fit the sheets.

5. In the application you are using to print the labels, open the Print dialog box then click the Properties or Preferences button.
6. Click the Paper/Output tab, then do the following:
   a. From the Paper Tray list, select Tray 1.
   b. From the Paper Size list, select the size of the sheet of labels.
   c. From the Paper Type list, select Labels.
7. Click OK.
8. In the Print dialog box, click OK or Print to start printing.

Printing Labels from the Manual Feed Slot

Note: Generally it is best to print labels from Tray 1. The manual feed slot paper path has more bends, and is more likely to cause the labels to peel off from the backing sheet.

1. Slide the paper guides of the manual feed slot to fit the label sheet. For details, see Loading Paper in the Manual Feed Slot on page 63.
2. With the labels face down and the top of the sheet toward the printer, slowly insert the sheet into the manual feed slot until it stops. Ensure that the sheet is entered straight, not crooked. If necessary, reposition the paper guides to fit the sheet.
3. In the application you are using to create the labels, open the Print dialog box and select the WorkCentre 6505 printer. You can use the PCL or the PostScript driver.

4. Click the Properties or Preferences button.

5. Click the Paper/Output tab, then do the following:
   a. From the Paper Size list, select the size of the sheet of labels.
   b. From the Paper Type list, select Labels.
   c. From the Paper Tray list, select Manual Feed Slot.

6. Click OK.

7. In the Print dialog box, click OK or Print to start printing.

Printing on Glossy Cardstock

This section includes:
- Guidelines for Printing on Glossy Cardstock on page 82
- Printing on Glossy Cardstock from Tray 1 on page 82
- Printing on Glossy Cardstock from the Manual Feed Slot on page 84

Guidelines for Printing on Glossy Cardstock

- Use Lightweight Cardstock mode for paper weight less than 163 g/m².
- Use Heavyweight Cardstock mode for paper weight more than 163 g/m².
- You can print on glossy cardstock from Tray 1 or from the manual feed slot.
- Do not perform automatic 2-sided printing using glossy cardstock.
- Do not open sealed packages of glossy cardstock until you are ready to load them into the printer.
- Leave glossy cardstock in the original wrapper and store unopened packages in the original shipping carton until ready to use.
- Remove all other paper from the tray before loading glossy cardstock.
- Load only the amount of glossy cardstock you plan to use, and remove the unused portion from the tray when you are finished printing. Put the unused glossy cardstock back in the original wrapper and seal it for later use.
- Rotate stock frequently. Long periods of storage in extreme conditions can cause glossy cardstock to curl and jam the printer.

Printing on Glossy Cardstock from Tray 1

1. Gently pull out the paper tray and slide open the paper guides. For details, see Loading Paper in Tray 1 on page 61.
2. Fan the sheets to release any that are stuck together.

3. Insert the glossy cardstock into the tray with the print side face up.
   
   **Note:** Do not load more than 25 sheets. Do not load the paper above the fill line indicated on the tray. Overloading the tray can cause jams.

4. In the application you are printing from, open the **Print** dialog box and select the **WorkCentre 6505** printer. You can use the PCL or the PostScript driver.

5. Click the **Properties** or **Preferences** button.

6. Click the **Paper/Output** tab, then do the following:
   a. From the **Paper Size** list, select the paper size.
   b. From the **Paper Type** list, select **Lightweight Glossy Cardstock** or **Heavyweight Glossy Cardstock**.
   c. From the **Paper Tray** list, select **Tray 1**.

7. Select any other desired settings, such as page orientation, then click **OK**.

8. In the **Print** dialog box, click **OK** or **Print** to start printing.
Printing on Glossy Cardstock from the Manual Feed Slot

1. Slide the paper guides of the manual feed slot to fit the sheet. For details, see Loading Paper in the Manual Feed Slot on page 63.

2. With the sheet face down and the top toward the printer, slowly insert one sheet into the manual feed slot until it stops. Ensure that the sheet is entered straight, not crooked. If necessary, reposition the paper guides to fit the sheet.

3. In the application you are printing from, open the Print dialog box and select the WorkCentre 6505 printer. If you have both the PCL and the PostScript drivers installed, you can use either driver.

4. Click the Properties button.

5. Click the Paper/Output tab, then do the following:
   a. From the Paper Size list, select the size of the glossy cardstock.
   b. From the Paper Type list, select Lightweight Glossy Cardstock or Heavyweight Glossy Cardstock.
   c. From the Paper Tray list, select Manual Feed Slot.

6. Click OK.

7. In the Print dialog box, click OK or Print to start printing.
Printing on Cardstock

This section includes:
- Guidelines for Printing on Cardstock on page 85
- Printing on Cardstock from Tray 1 on page 85
- Printing on Cardstock from the Manual Feed Slot on page 86

Guidelines for Printing on Cardstock

- You can print on lightweight cardstock and heavyweight cardstock from Tray 1 or from the manual feed slot.
- Do not perform automatic 2-sided printing using cardstock.
- Lightweight cardstock acceptable weight for this printer is 100–163 g/m², 37–60 lb. cover.
- Heavyweight cardstock acceptable for this printer is 163–220 g/m², 60–80 lb. cover. Test all thick stock to ensure acceptable performance.
- Do not load cardstock of mixed thicknesses in the tray at the same time.
- Do not use cardstock that is coated or designed for inkjet printers.

Printing on Cardstock from Tray 1

1. Gently pull out the paper tray and slide open the paper guides. For details, see Loading Paper in Tray 1 on page 61.
2. Fan the sheets to release any that are stuck together.
3. Insert the cardstock into the tray with the print side face up.
   **Note:** Do not load a stack of cardstock higher than 27.6 mm (1.08 in.) in the tray.
4. In the application you are printing from, open the Print dialog box and select the WorkCentre 6505 printer. You can use the PCL or the PostScript driver.
5. Click the Properties button.
6. Click the Paper/Output tab, then do the following:
   a. From the Paper Size list, select the size of the cardstock.
   b. From the Paper Type list, select Lightweight Cardstock or Heavyweight Cardstock.
   c. From the Paper Tray list, select Tray 1.
7. Click OK.
8. In the Print dialog box, click OK or Print to start printing.
Printing on Cardstock from the Manual Feed Slot

1. Slide the paper guides of the manual feed slot to fit the sheet. For details, see Loading Paper in the Manual Feed Slot on page 63.

2. With the sheet face down, and the top toward the printer, slowly insert one sheet into the manual feed slot until it stops. Ensure that the sheet is entered straight, not crooked. If necessary, reposition the paper guides to fit the sheet.

3. In the application you are printing from, open the Print dialog box and select the WorkCentre 6505 printer. You can use the PCL or the PostScript driver.

4. Click the Properties or Preferences button.

5. Click the Paper/Output tab, then do the following:
   a. From the Paper Size list, select the size of the cardstock.
   b. From the Paper Type list, select Lightweight Cardstock or Heavyweight Cardstock.
   c. From the Paper Tray list, select Manual Feed Slot.

6. Click OK.

7. In the Print dialog box, click OK or Print to start printing.
Printing Custom Sizes

This section includes:

- Defining Custom Paper Sizes on page 87
- Printing on Custom Size Paper on page 89

  Note: Custom size paper can be loaded into all trays.

Defining Custom Paper Sizes

This section includes:

- Defining the Custom Paper Size in the Windows PostScript Driver on page 87
- Creating a Custom Paper Size Through the Windows Print Server Properties on page 88
- Creating a Custom Paper Size for the Windows PCL Driver on page 88
- Creating a Custom Paper Size for Macintosh on page 88

Notes:

1. The custom size defined must be within the maximum and minimum size range for the printer paper tray you are using. For details, see the custom size paper ranges given for each tray in Supported Paper on page 58.
2. You can create custom paper sizes for use with both the PostScript and PCL print drivers, but the method for each is different. For optimum results, follow the instructions carefully.
3. If you get an error message when creating a custom size, you might not have permission to save custom paper sizes on your computer. See your system administrator for help.

Defining the Custom Paper Size in the Windows PostScript Driver

Note: You can save only one custom paper size at a time as you print. Once saved, the dimensions are retained until you change them. To create a custom paper size for the PostScript driver and save it under a unique name for repeat use, see Creating a Custom Paper Size Through the Windows Print Server Properties on page 88.

To define a custom paper size using the PostScript print driver:

1. Navigate to your printer directory or list, then right-click the WorkCentre 6505 PS driver and select Properties.
2. In the Properties dialog box, click the Printing Preferences button.
4. In the PostScript Custom Size Settings dialog box, select the units of measurement to use.
5. In the Custom Size Settings section, specify the size for the short edge (width) and the long edge (length) of the paper, then click OK.
6. In the Printing Preferences dialog box, click OK.

Note: To change the custom size, in the Paper/Output tab, click the Edit button below the Paper Size field. Make the desired changes, and save your changes in all applicable dialog boxes.
Creating a Custom Paper Size Through the Windows Print Server Properties

**Note:** This method allows you to create and save a custom paper size under a unique name for use with the Windows PostScript driver.

1. In Windows, navigate to your printer directory or list. In the Printers and Faxes folder, click the **File** menu and select **Server Properties**.
   The Print Server Properties dialog box opens.
2. Click the **Forms** tab, then select the **Create a new form** check box.
3. In the Form name field, type a name for your custom size, replacing the name that appears.
4. In the Form description section, select the units of measurement to use, then define the paper width and height, and printer area margins.
5. Click the **Save Form** button, then click **Close**.
   The custom size is available as an option in the Print dialog box of most applications when you select the **WorkCentre 6505 PS** driver. The exact location varies with the application.

Creating a Custom Paper Size for the Windows PCL Driver

**Notes:**
- The PCL print driver is available for Windows only.
- Custom paper sizes created in the PCL driver become available in the Paper Size list on the Paper/Output tab of the print driver. They are also available in the Print dialog box of most applications. The exact location varies with the application.

1. Navigate to your printer directory or list, then right-click the **WorkCentre 6505 PCL** driver and select **Properties**.
2. In the Properties dialog box, click the **Configuration** tab.
3. At the bottom of the Configuration tab, click the **Custom Paper Size** button.
   The Custom Paper Size dialog box opens.
4. In the Units section, select the units of measurement to use for defining the page size.
5. In the Short Edge field, specify the width of the page.
6. In the Long Edge field, specify the length of the page.
7. To save this custom size, select the **Name Paper Size** check box, then type a name in the **Paper Name** field.
8. Click **OK**.
9. In the Properties dialog box, click **OK**.
   The custom size is available as an option in the Print dialog box of most applications when you select the **WorkCentre 6505 PCL** driver. The custom size is also available in the Paper Size field, in the Paper/Output tab of the PCL driver.

Creating a Custom Paper Size for Macintosh

1. In the application you are printing from, select **File > Page Setup**.
2. From the **Format For** drop-down list, select the **WorkCentre 6505**.
3. From the **Paper Size** drop-down list, select **Manage Custom Sizes**.
4. In the Custom Paper Sizes window, click the plus (+) button to add the new custom size.
5. Enter the dimensions of the custom paper size.
6. In the Non-Printable Area drop-down list, select the WorkCentre 6505.
7. Click the OK button to close the Custom Paper Sizes window.
8. Click OK to close the Page Setup window.

Note: To use the custom paper size, select File > Print, and choose the custom size you created from the Paper Size drop-down list.

Printing on Custom Size Paper

This section includes:
- Printing on Custom Size Paper Using the Windows PostScript Driver on page 89
- Printing on Custom Size Paper Using the Windows PCL Driver on page 89

Note: When setting the paper size in the print driver and control panel, be sure to specify the same size as the paper in the tray. Setting the wrong size for printing can cause a printer error.

Printing on Custom Size Paper Using the Windows PostScript Driver

1. Load the custom size paper in the tray you want to use. For details, see Loading Paper on page 61.
2. In the application you are printing from, open the Print dialog box and select the WorkCentre 6505 PS driver.
3. Do one of the following:
   - To print using a custom size, in the Print dialog box, select the custom paper size name from the dialog box size menu or list. Click the Properties button and skip to step 4.
   - To print using the Custom Page Size defined in the PostScript driver properties, in the Print dialog box, click the Properties button. On the Paper/Output tab, select Custom Page Size from the Paper Size list. In the PostScript Custom Size Settings dialog box, leave the settings as is or change them to match the paper you are printing on. Click OK.
4. Click on the Paper/Output tab, then do the following:
   a. From the Paper Type list, select the paper type.
   b. From the Paper Tray list, select the tray to print from.
5. Select any other desired options, then click OK.
6. In the Print dialog box, click OK or Print to start printing.

Printing on Custom Size Paper Using the Windows PCL Driver

1. Load the custom size paper in the tray you want to use. For details, see Loading Paper on page 61.
2. In the application you are printing from, open the Print dialog box and select the WorkCentre 6505 PCL driver.
3. Click the Properties button.
4. Click the Paper/Output tab, then do the following:
   a. From the Paper Size list, select the name of a custom size you created.
   b. From the Paper Type list, select the paper type.
   c. From the Paper Tray list, select the tray to print from.
5. Select any other desired options, then click **OK**.
6. In the Print dialog box, click **OK** or **Print** to start printing.
Printing on Both Sides of the Paper

This section includes:
• Automatic 2-Sided Printing Guidelines on page 91
• Binding Edge Options on page 91
• Automatic 2-Sided Printing on page 92
• Manual 2-Sided Printing on page 92

Note: Automatic 2-sided printing is available for the WorkCentre 6505DN configuration. Manual 2-sided printing using Tray 1 is available for both WorkCentre 6505 configurations. The PCL 6 print driver for Windows is the only driver that supports manual 2-sided printing. For details, see Performing Manual 2-sided Printing from Tray 1 on page 93. However, you can use the manual feed slot to print 2-sided pages one sheet at a time using the PostScript driver. For details, see Performing Manual 2-sided Printing from the Manual Feed Slot on page 93.

Automatic 2-Sided Printing Guidelines

Before printing a 2-sided document, verify that the paper is a supported size for the tray. For a list of supported sizes, see Supported Paper on page 58.

Do not use the following media for automatic 2-sided printing:
• Transparencies
• Envelopes
• Labels
• Any die-cut specialty media, such as business cards
• Cardstock

Binding Edge Options

When you use the print driver to select 2-sided printing, you also select the binding edge. The binding edge determines how the pages turn. The actual outcome depends on the orientation (portrait or landscape) of images on the page, as shown in the following illustrations.

<table>
<thead>
<tr>
<th>Portrait</th>
<th>Landscape</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="portrait.png" alt="Flip on Long Edge" /></td>
<td>Flip on Long Edge</td>
</tr>
<tr>
<td><img src="portrait.png" alt="Flip on Short Edge" /></td>
<td>Flip on Short Edge</td>
</tr>
</tbody>
</table>

![Flip on Long Edge](landscape.png) | Flip on Long Edge |

![Flip on Short Edge](landscape.png) | Flip on Short Edge |
Automatic 2-Sided Printing

You can perform automatic 2-sided printing from Tray 1 and, if installed, the 250-sheet feeder (Tray 2).

To perform automatic 2-sided printing:
1. Insert the paper into the desired tray. For more information, see Loading Paper on page 61.
2. In the print driver, select 2-sided printing:
   • Windows: On the Paper/Output tab, from the 2-Sided Print drop-down list, select Flip on long edge or Flip on short edge.
   • Macintosh: In the Print dialog box, from the Presets menu, select Layout. Then select Long-edged printing or Short-edged printing.
     For details, see Binding Edge Options on page 91.
3. Select any other desired printing options, then click OK.
4. Click OK or Print to start printing.

   Note: For optional printer features, such as 2-sided printing, to be available in the print driver dialog boxes, the optional features must be installed and enabled. If you have not enabled your installed optional features, see Enabling Optional Features on page 46.

See also:
   Automatic 2-Sided Printing Guidelines on page 91

Manual 2-Sided Printing

This section includes:
• Performing Manual 2-sided Printing from Tray 1 on page 93
• Performing Manual 2-sided Printing from the Manual Feed Slot on page 93

If you do not have the optional duplex unit installed, you can still print on both sides of some paper. You can also use this technique for printing on paper incompatible with the duplex unit.

⚠️ CAUTION: Use only paper specified for use with this printer. Damage caused by unsupported paper is not covered under the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage can vary outside these areas. Please contact your local representative for details.
Performing Manual 2-sided Printing from Tray 1

Notes:
- This method of manual 2-sided printing is only available using the PCL print driver.
- Do not use this method with cardstock or glossy cardstock.
- This method requires the Productivity Kit to be installed in the printer for a total of 768 MB of RAM. For information on your printer configuration and available optional features, see Configurations and Options on page 21.
- The RAM Disk feature of the printer must also be enabled for you to use this method. For information on enabling this option, see Enabling Optional Features on page 46.

1. Load Tray 1 with paper acceptable for use in Tray 1. For details, see Supported Paper on page 58.
2. In the application you are printing from, open the Print dialog box and select the WorkCentre 6505 PCL driver.
3. Click the Properties button.
4. Click the Advanced tab.
5. In the Other Settings section, in the Items list, select Electronic Sort.
6. In the Electronic Sort field below the Items list, select Off.
7. Click the Paper/Output tab, then do the following:
   a. From the Paper Tray list, select Tray 1.
   b. From the 2-Sided Print list, select Flip on long edge (Manual) or Flip on short edge (Manual).
   c. From the Paper Type field, select the paper type.
   d. Select any other desired settings, then click OK.
8. In the Print dialog box, specify the pages to print, then click OK or Print to start printing.
   Note: You do not need to specify printing odd or even pages. Specify all pages or a page range. The driver sends the even pages, then pauses the printer so you can insert the printed pages back into Tray 1.
   The Setting Method for Paper Tray 1 Duplex window opens.
   Note: Leave this window open until you complete the entire print job. It contains instructions for reloading the printed pages into the paper tray.
9. When printing is complete, lift the printed pages from the paper tray without turning them over or around, and place them in the paper tray with the blank sides of the pages facing up.
10. Close the tray.
11. On the printer control panel, press the OK button to resume printing.

Performing Manual 2-sided Printing from the Manual Feed Slot

1. Print the first side of a sheet of paper.
2. Adjust the paper guides in the manual feed slot to fit the printed sheet.
3. Insert the sheet evenly into the manual feed slot with the printed side face down.
   Note: If the paper looks skewed after the printer pulls it in, gently remove the paper and insert it again.
4. In the print file, select **Print** from the **File** menu.
5. In the Print dialog box, select the appropriate print driver, then click the **Properties** button.
6. Click the **Paper/Output** tab, then do the following:
   a. From the Paper Size list, select the paper size.
   b. From the Paper Type list, select the paper type.
   c. From the Paper Tray list, select **Manual Feed Slot**.
7. Click **OK**.
8. In the Print dialog box, specify the page you want to print.
9. Click **Print** or **OK** to start printing.
Printing Using Secure Print

This section includes:
- Storing a Print Job in Memory on page 95
- Printing a Secure Print Job on page 96

Notes:
- Secure Print requires the Productivity Kit to be installed in the printer for a total of 768 MB of RAM. For information on your printer configuration and available optional features, see Configurations and Options on page 21.
- The RAM Disk feature of the printer must also be enabled for you to use Secure Print. For information on enabling this option, see Enabling Optional Features on page 46.

Secure Print allows you to store a document in the printer, then print it from the control panel. When sending a Secure Print document to the printer, you can assign a password. When you retrieve the print job you must enter the same password at the control panel. You can use this feature to send confidential documents to the printer and print them when you are at the printer.

You can also store documents in the printer without assigning a password. Store frequently used documents in the printer, then print them on demand without sending the print job from the computer each time.

Storing a Print Job in Memory

Set up Secure Print print jobs using the PCL or PostScript print driver at your computer.

To store a print job in memory:
1. In the application you are printing from, open the Print dialog box.
2. Select your WorkCentre 6505 printer, then click the Properties button.
3. Click the Paper/Output tab, then do the following:
   a. From the Job Type list, select Secure Print.
   b. If you are using the PostScript driver, click the Setup button. For the PCL driver, click the Setting button.
   c. In the Secure Print dialog box, in the Username field, type your name, up to eight characters.
   d. In the Password field, enter a numeric password.
   e. In the Retrieve Document Name field, do one of the following:
      - To use a specific document name to access the document from the printer control panel, select Enter Document Name. In the Document Name field, type a name for the document, up to 12 characters. This name appears on the control panel.
      - To display a timestamp on the control panel, select Use Existing Name if you are using the PostScript driver, or Auto Retrieve for the PCL driver.
   f. Click OK.
4. Select any other printing options, then click OK.
5. In the Print dialog box, click OK or Print.
6. When you are ready to print, follow the instructions in Printing a Secure Print Job on page 96.

   Note: Any print jobs stored in the RAM are erased when the printer is turned off or loses power.

Printing a Secure Print Job

To print a stored Secure Print job at the control panel:
1. Press the Print button.
2. At Secure Print, press the OK button.
3. Press the Up Arrow or Down Arrow button to select the username you created when you set up the Secure Print, then press OK.
4. Use the alphanumeric keypad to enter the password that you assigned to the document, then press OK.
5. Press the Up Arrow or Down Arrow button to select one of the following:
   - All Documents
   - The timestamp assigned to the document
   - The document name you created
6. Press OK.
7. Press the Up Arrow or Down Arrow button to select one of the following:
   - To delete the document from memory after printing, select Delete after Print, then press OK. Use the Up Arrow and Down Arrow buttons or the alphanumeric keypad to indicate the number of copies to print.
   - To delete the document without printing it, select Delete.
8. Press OK.

   Note: Any print jobs stored in the RAM are erased when the printer is switched off or loses power.

See also:
   Storing a Print Job in Memory on page 95
Printing Using Proof Print

This section contains:

- Setting Up a Proof Print Job on page 97
- Printing a Proof Print Job on page 98

Notes:

- Proof Print requires that you have the Productivity Kit installed in the printer. For information on your printer configuration and available optional features, see Configurations and Options on page 21.
- The RAM Disk feature of the printer must also be enabled for you to use Proof Print. For information on enabling this option, see Enabling Optional Features on page 46.

The Proof Print feature enables you to store a multiple-copy print job in the printer, then review one set before printing the remainder. If you are satisfied with the first set, you can print the remaining copies from the control panel.

Setting Up a Proof Print Job

You set up Proof Print print jobs in the print driver at your computer. You can use the PCL or the PostScript drivers for Proof Print. After setup, one copy of the job prints for you to review. Then you can print the rest of the copies or delete them from the printer control panel.

1. In the application you are printing from, open the Print dialog box.
2. Select your WorkCentre 6505 printer, then click the Properties button.
3. Click the Paper/Output tab, then do the following:
   a. From the Job Type list, select Proof Print.
   b. If you are using the PostScript driver, click the Setup button. For the PCL driver, click the Setting button.
   c. In the Proof Print dialog box, in the Username field, type your name, up to eight characters.
   d. In the Retrieve Document Name field, do one of the following:
      - To use a specific document name to access the document from the printer control panel, select Enter Document Name. In the Document Name field, type a name for the document, up to 12 characters. This name appears on the control panel.
      - To display a timestamp on the control panel, select Use Existing Name if you are using the PostScript driver, or Auto Retrieve for the PCL driver.
   e. Click OK.
4. Select any other printing options, then click OK.
5. In the Print dialog box, click OK or Print.

Note: Do not select the number of copies. You do that at the control panel later when you print.

One set of the job prints. Review this set. If the set is satisfactory, you can print the remaining sets from the control panel. For details, see Printing a Proof Print Job on page 98.
Printing

Printing a Proof Print Job

After reviewing the first set that printed when you sent the document, you can print the remaining sets from the printer control panel.

1. At the control panel, press the Print button to access the Walk-Up printing feature.
2. Press the Up Arrow or Down Arrow button to select Proof Print, then press the OK button.
3. Press the Up Arrow or Down Arrow button to select the username you created when you set up the Proof Print, then press OK.
4. Press the Up Arrow or Down Arrow button to select one of the following:
   - All Documents
   - The document name you created
   - The timestamp assigned to the document
5. Press OK.
6. Press the Up Arrow or Down Arrow button to select one of the following:
   - To delete the document from memory after printing, select Delete after Print, then press OK. Use the Up Arrow and Down Arrow buttons or the alphanumeric keypad to indicate the number of copies to print.
   - To delete the document without printing it, select Delete.
   - To keep the document in the printer memory, select Print and Save, then press OK. Use the Up Arrow and Down Arrow buttons or the alphanumeric keypad to indicate the number of copies to print.
7. Press OK.

Note: Any print jobs stored in the RAM are erased when the printer is turned off or loses power.

See also:
   Setting Up a Proof Print Job on page 97
Copying

This chapter includes:

- Basic Copying on page 100
- Adjusting Copying Options on page 102
- Changing the Default Settings on page 107
Basic Copying

To make copies:
1. On the control panel, press the **Clear All** button to clear previous copy settings.
2. Load your original documents:
   - Use the document glass for single pages or paper that cannot be fed using the document feeder. Place the first page of the document face up, in the top left corner of the document glass.
   - Use the document feeder for multiple or single pages. Remove any staples and paper clips from the pages, then place them face up in the document feeder.
3. On the control panel, press the **Copy** button.
4. Using the control panel keypad, enter the desired number of copies. The number of copies appears on the upper right corner of the display. To reset the number of copies to 1, press the **Clear All** button.
5. Press the **Up Arrow** or **Down Arrow** button to select the copying option you want to change. For details, see Adjusting Copying Options on page 102.
6. Press the **Start** button. One set of copies prints.
   If you place originals in the document feeder, copying continues until the document feeder is empty.

**Document Glass**
Lift the document feeder or the document glass cover, then place the original face down in the upper left corner of the document glass.

**Document Feeder**
Insert originals face up with the top of the page entering the feeder first. Adjust the paper guides so they fit against the originals.

Automatic Document Feeder Guidelines

The Automatic Document Feeder (ADF) accommodates the following original sizes:
- Width: 148 – 216 mm (4.1 in. – 8.5 in.)
- Length: 210 – 355.6 mm (8.3 in. – 14 in.)
The weight range includes 50–125 g/m$^2$ (17–32 lb. Bond).

Follow these guidelines when loading originals into the document feeder:
- Load originals face up so that the top of the document enters the feeder first.
- Place only loose sheets of paper in the document feeder.
- Adjust the paper guides so that they fit against the originals.
- Insert paper in the document feeder only when ink on the paper is dry.
- Do not load originals above the MAX fill line.

**Document Glass**

Use the document glass rather than the document feeder to copy or scan the following types of originals:
- Paper with paper clips or staples attached
- Paper with wrinkles, curls, folds, tears, or notches
- Coated or carbonless paper or items other than paper such as cloth or metal
- Envelopes
Adjusting Copying Options

You can adjust numerous options for your copy jobs, to specify characteristics of the original documents and customize the output. See Basic Copying on page 100.

You can also modify the default settings for many options. For details, see Changing the Default Settings on page 107.

This section includes:
- Basic Settings on page 102
- Image Adjustments on page 104
- Image Layout Adjustments on page 105
- Output Adjustments on page 106

Basic Settings

You can change the following basic settings when making copies:
- Selecting 2-Sided Options on page 102
- Selecting Color or Black and White Copies on page 102
- Selecting the Paper Supply on page 103
- Specifying the Original Size on page 103
- Specifying the Original Document Type on page 103

Selecting 2-Sided Options

If you have the optional duplex unit, you can specify how 2-sided pages are printed.

To select 2-sided options:
1. Press the Up Arrow or Down Arrow button to select 2-Sided, then press the OK button.
2. Select an option:
   - 1->1-Sided prints 1-sided copies.
   - Long Edge Binding prints 2-sided copies, flipped on the long edge.
   - Short Edge Binding prints 2-sided copies, flipped on the short edge.
3. Press OK to confirm the setting.

Selecting Color or Black and White Copies

If the original document contains color, you can create copies in color or in black and white.

Press the Color Mode button to toggle the selection between color and black and white. The green light indicates the current setting.

Note: The Color Mode returns to the default setting after the copy job is complete. To modify the default setting, see Selecting the Default Copy Settings on page 107.
Selecting the Paper Supply

You can make copies on letterhead, colored paper, or envelopes. After loading the paper in the tray, or preparing the media for feeding into the manual feed slot, you must select the appropriate paper supply.

To select a paper supply to use for your copies:
1. Press the Up Arrow or Down Arrow button to select Paper Supply, then press the OK button.
2. Select an option:
   • Manual Feed Slot
   • Tray 1
   • Tray 2 if you have the optional 250-sheet feeder.
3. Press OK to confirm the setting.

Specifying the Original Size

To specify the size of the original document:
1. Press the Up Arrow or Down Arrow button to select Document Size, then press the OK button.
2. Select the document size:
   • Auto
   • Letter - 8.5x11”
   • US Folio - 8.5x13”
   • Legal - 8.5x14”
   • A4 - 210x297mm
   • A5 - 148x210mm
   • B5 - 182x257mm
   • Executive - 7.25x10.5”
3. Press OK to confirm the setting.

Specifying the Original Document Type

The scanner optimizes the appearance of the output based on the contents of the original document.

To specify the type of the original document:
1. Press the Up Arrow or Down Arrow button to select Document Type, then press the OK button.
2. Select the document type:
   • Text for black and white or colored text.
   • Mixed for both text and photographs, such as magazines or newspapers.
   • Photo for photographs.
   
   Note: The default setting is Mixed.
3. Press OK to confirm the setting.
Image Adjustments

You can modify the following image adjustment settings:

- Reducing or Enlarging the Image on page 104
- Making the Image Lighter or Darker on page 104
- Adjusting the Sharpness on page 104
- Adjusting the Color Saturation on page 105
- Setting Auto Exposure on page 105

Reducing or Enlarging the Image

You can reduce the image to as little as 50% of its original size or enlarge it as much as 400%.

To reduce or enlarge the copied image:
1. Press the Up Arrow or Down Arrow button to select Reduce/Enlarge, then press the OK button.
2. Do one of the following:
   - Press the Up Arrow or Down Arrow button to select a preset image size.
   - Press the Back Arrow button, then press the Forward Arrow or Back Arrow button to set the copy size in increments of 1%.

   Note: The default setting is 100%.
3. Press OK to confirm the setting.

Making the Image Lighter or Darker

To lighten or darken the copied image:
1. Press the Up Arrow or Down Arrow button to select Lighten/Darken, then press the OK button.
2. Press the Back Arrow or Forward Arrow button to move the slider to lighten or darken the image.
3. Press OK to confirm the setting.

Adjusting the Sharpness

To adjust the sharpness of the copied image:
1. Press the Up Arrow or Down Arrow button to select Sharpness, then press the OK button.
2. Select a sharpness setting:
   - Sharper
   - Normal
   - Softer

   Note: The default setting is Normal.
3. Press OK to confirm the setting.
Adjusting the Color Saturation

To make the image colors more vivid or pastel:
1. Press the Up Arrow or Down Arrow button to select Color Saturation, then press the OK button.
2. Press the Up Arrow or Down Arrow button to select the level of color saturation:
   - Higher increases the color saturation to deepen the color of the copy.
   - Normal sets the color saturation is the same as the original.
   - Lower decreases the color saturation to lighten the color of the copy.
   
   Note: The default setting is Normal.
3. Press OK to confirm the setting.

Setting Auto Exposure

Papers that are close to white, such as newsprint or parchment, can cause the printer to put toner on the entire page. The Auto Exposure setting removes the light background and only prints the image itself.

To turn Auto Exposure on or off:
1. Press the Up Arrow or Down Arrow button to select Auto Exposure, then press the OK button.
2. Select an option:
   - Off
   - On
   
   Note: The default setting is On.
3. Press OK to confirm the setting.

Image Layout Adjustments

You can change the following image layout adjustment settings:
- Printing Multiple Pages per Side on page 105
- Setting the Copy Margins on page 106

Printing Multiple Pages per Side

You can copy two original page images onto one side of a sheet of paper. The images are reduced proportionally to fit on the selected paper.

To print multiple pages per side:
1. Press the Up Arrow or Down Arrow button to select N-Up, then press the OK button.
2. Select an option:
   - Off copies one original image onto one side of a page.
   - Auto copies two original pages, reduces the images, and prints them onto one side of a page.
   - ID Card Copy copies two original size images onto one side of a page. The images are not reduced.
• Manual reduces the two original images as specified in Reduce/Enlarge, and prints them onto one side of a page.

3. Press OK to confirm the setting.

**Setting the Copy Margins**

To set the copy margins:

1. Press the Up Arrow or Down Arrow button to select the margin you want to change:
   - Margin Top/Bottom
   - Margin Left/Right
   - Margin Middle

2. Press the OK button

3. Press the Up Arrow or Down Arrow button to adjust the margins from 0.0 to 2.0 in.

4. Press the OK button to confirm the setting.

5. Repeat the steps for other margins, then press the Return button.

   **Note:** The margin width settings only apply when copying from the document glass.

**Output Adjustments**

**Collating Copies**

When you make several copies of a multi-page document, you can collate the output. For example, if you are making three 1-sided copies of a six-page document and select Collation On, the copies are printed in this order:

1, 2, 3, 4, 5, 6, 1, 2, 3, 4, 5, 6, 1, 2, 3, 4, 5, 6

If you select uncollated, the copies are printed in this order:

1, 1, 1, 2, 2, 2, 3, 3, 3, 4, 4, 4, 5, 5, 5, 6, 6, 6

To select a collating option:

1. Press the Up Arrow or Down Arrow button to select Collated, then press the OK button.

2. Select an option:
   - Off turns collation off.
   - On turns collation on.
   - Auto turns collation on.

   **Note:** The default setting is Auto.

3. Press OK to confirm the setting.
Changing the Default Settings

This section includes:
- Selecting the Default Copy Settings on page 107
- Limiting Access to Copy Operations on page 109

Selecting the Default Copy Settings

The printer uses the default copy settings on all copy jobs unless you change them for an individual job. You can modify the default settings set at the factory.

This section includes:
- Changing the Color Mode on page 107
- Changing the Auto Exposure Level on page 107
- Changing the Color Balance on page 108
- Changing the Manual Feed Slot Paper Size on page 108
- Changing the Manual Feed Slot Paper Type on page 108

To select the default copy settings:
1. On the control panel, press the System button.
2. Press the Up Arrow or Down Arrow button to select Default Settings, then press the OK button.
3. Select Copy Defaults, then press OK.
4. Press the Down Arrow button to select the option you want to change, then press OK.
5. Select the desired setting, then press OK to confirm the new setting.
6. Repeat steps 4 and 5 as needed.
7. Press the Return button as necessary to return to the Ready screen.

Changing the Color Mode

To set the color mode to black and white or to color:
1. Press the Up Arrow or Down Arrow button to select Color, then press the OK button.
2. Select a color setting:
   - Black & White
   - Color
3. Press OK to confirm the new setting.

Changing the Auto Exposure Level

To set the auto exposure level:
1. Press the Up Arrow or Down Arrow button to select Auto Exposure Level, then press the OK button.
2. Select an auto exposure setting:
• Normal
• Higher(1)
• Higher(2)

3. Press OK to confirm the new setting.

Changing the Color Balance

The Color Balance control allows you to adjust the print color of your printer. Each of the four print colors, yellow, magenta, cyan, and black, have three density settings. The density settings adjust the output based on the level of color saturation. Adjusting the setting negatively lowers the density and lightens the output. Adjusting the setting positively increases the density and darkens the output. Examples of low density areas include faces and sky.

To adjust the color balance:
1. Press the Up Arrow or Down Arrow button to select Color Balance, then press the OK button.
2. Select the color you want to adjust, then press OK.
3. Press the Up Arrow or Down Arrow button to adjust the density setting from -3 to +3.
4. Press OK to confirm the new setting.
5. Select another color and adjust its density, or press the Return button to return to the Ready screen.

Changing the Manual Feed Slot Paper Size

To change the manual feed slot paper size:
1. Press the Up Arrow or Down Arrow button to select M.F. Paper Size, then press the OK button.
2. Select an option:
   • Letter - 8.5x11"
   • US Folio - 8.5x13"
   • Legal - 8.5x14"
   • A4 - 210x297mm
   • A5 - 148x210mm
   • B5 - 182x257mm
   • Executive - 7.25x10.5"
   • Monarch Env. - 3.9x7.5"
   • DL Env. - 110x220mm
   • C5 Env. - 162x229mm
   • #10 Env. - 4.1x9.5"
3. Press OK to confirm the new setting.

Changing the Manual Feed Slot Paper Type

To change the manual feed slot paper type:
1. Press the Up Arrow or Down Arrow button to select M.F. Paper Type, then press the OK button.
2. Select an option:
   - Plain Paper
   - Thin Card Stock
   - Thick Card Stock
   - Envelope
   - Letterhead
   - Glossy Paper
   - Thick Glossy
   - Pre-Punched
   - Colored Paper
   - Special
3. Press **OK** to confirm the new setting.

### Limiting Access to Copy Operations

The Copy Lock limits access to copy operations by requiring a password.

To set the copy lock:
1. On the control panel, press the **System** button.
2. Press the **Up Arrow** or **Down Arrow** button to select **Admin Menu**, then press the **OK** button.
3. If prompted, enter the four-digit password, then press **OK**.
4. Select **Secure Settings**, then press **OK**.
5. Select **Service Lock**, then press **OK**.
6. Select **Copy**, then press **OK**.
7. Select an option:
   - **Unlocked** turns off the service lock.
   - **Locked** turns on the service lock, disabling the copy function.
   - **Password Locked** requires a password to use the copy function. Enter a new password, then press **OK**.
   - **Color Pass.** requires a password to make color copies.
8. Press **OK**.

### Changing General Copy Default Settings

You can change the default settings for the following general copy options:
- 2-Sided
- Paper Supply
- Document Size
- Document Type
- Reduce/Enlarge
- Lighten/Darken
- Sharpness
Copying

- Color Saturation
- Auto Exposure On/Off
- Special Copy Mode
- Margin Top/Bottom
- Margin Left/Right
- Margin Center
- Collated

*Note:* For individual settings, see *Adjusting Copying Options* on page 102.
Scanning

This chapter includes:

- Loading Documents for Scanning on page 112
- Scanning to a Folder on a Computer with a USB Connection on page 113
- Scanning to a USB Flash Drive on page 114
- Scanning to a Shared Folder on a Network Computer on page 115
- Scanning to an Email Address on page 116
- Scanning to an FTP Server on page 117
- Scanning Images into an Application on page 118
- Adjusting Scanning Options on page 120

See also:

  Installation and Setup Overview on page 28
Loading Documents for Scanning

Position the original document to be scanned as shown.

**Document Glass**
Lift the document feeder or the document glass cover, then place the original face down in the upper left corner of the document glass.

**Document Feeder**
Insert originals face up with the top of the page entering the feeder first. Adjust the paper guides so they fit against the originals.

*Note: For details, see Automatic Document Feeder Guidelines on page 100.*
Scanning to a Folder on a Computer with a USB Connection

Note: You must install Express Scan Manager on your computer and create a scan destination before you can use this feature. For more information on Express Scan Manager, see Setting Up Scanning with USB on page 53.

If your computer is connected to the printer with a USB cable:
1. Load the original document on the document glass or in the document feeder.
2. On the control panel, press the Scan button.
3. Press the Up Arrow or Down Arrow button to select Scan to Computer (USB), then press the OK button.
4. Press the Up Arrow or Down Arrow button to select the options you want to change. For details, see Adjusting Scan Settings on page 120.
5. Press the Start button to begin the scan.
   A Xerox® WorkCentre 6505 (USB) scanner dialog box opens on your computer, where you select which application to launch to manage the scanned file.
6. Select WorkCentre 6505 Express Scan Manager, then click OK.
   Note: You can select the Always use this program for this action check box to make this program the default setting.

The printer scans your documents to the output destination specified in Express Scan Manager.
Scanning to a USB Flash Drive

To scan an image to a USB Flash Drive:
1. Insert your USB Flash Drive in the USB port on the front of the printer.
2. Load the original on the document glass or in the document feeder.
3. If desired, navigate to a folder on your USB Flash Drive:
   a. Press the Forward Arrow button.
   b. Press the Up Arrow or Down Arrow button to navigate to the folder.
   c. Press the OK button.
4. Press the Up Arrow or Down Arrow button to select any scanning options you want to change. For details, see Adjusting Scanning Options on page 120.
5. Press the Start button to begin the scan.
6. If the Another Page? prompt appears, select one of the following:
   - No completes the scanning process.
   - Yes prompts you to place the next page on the document glass. Select Continue or Cancel the Action.
7. Press OK.
   The printer scans your images to the folder you specified.
This section includes:

- Setting Up Scanning to a Computer on page 115
- Scanning to a Computer on page 115

**Setting Up Scanning to a Computer**

Before using the printer as a scanner on a network, you must:

- Create a shared folder on the computer. For details, see Setting Up Scanning to a Shared Folder on Your Computer on page 49.
- Create a new address using CentreWare Internet Services or the Address Book Editor pointing the scanner to the computer.

  **Note:** For more information, see Connecting the Printer on page 30.

**Scanning to a Computer**

To scan to a computer connected to the network:

1. On the control panel, press the **Scan** button.
2. Press the **Up Arrow** or **Down Arrow** button to select **Scan to Network**, then press the **OK** button.
3. At **Scan to**, press **OK**.
4. At **Computer (Network)**, press **OK**.
5. Press the **Up Arrow** or **Down Arrow** button to select the shared folder on your computer, then press **OK**.
6. If you want to change any other scan settings, press the **Up Arrow** or **Down Arrow** button to select the setting, and make your changes. For details, see Adjusting Scanning Options on page 120.
7. Press the **Start** button to begin the scan.
8. If the **Another Page?** prompt appears, select one of the following:
   - **No** completes the scanning process.
   - **Yes** prompts you to place the next page on the document glass. Select **Continue** or **Cancel the Action**.
9. Press **OK**.
   The printer scans the documents to the shared folder on your computer.
Scanning to an Email Address

To scan an image and send it to an email address:

1. On the control panel, press the Scan button.
2. Press the Up Arrow or Down Arrow button to select Scan to E-mail, then press the OK button.
3. At Email to, press OK.
4. Select the method for selecting the recipient:
   - Keypad allows you to enter the email address manually. Use the keypad to enter the address.
   - Address Book allows you to select an email address from the Address Book.
   - Email Group allows you to select a group email address from the Address Book.

   Note: When using the Address Book, press the Up Arrow or Down Arrow button to select the address for the desired recipient. Press the Forward Arrow button to select TO or BCC. When finished selecting addresses, press OK.

5. Press the Start button to begin the scan.
6. If the Another Page? prompt appears, select one of the following:
   - No completes the scanning process.
   - Yes prompts you to place the next page on the document glass. Select Continue or Cancel the Action.

7. Press OK.
   The printer scans your documents, and sends them as email attachments of the default file type.

See also:

Adjusting Scanning Options on page 120
Scanning to an FTP Server

Notes:
- You must set up an FTP server before you can use this feature.
- You must create an address for the printer to use before you can use this feature. You can use CentreWare Internet Services or the Address Book Editor.

To scan to an FTP server:
1. Load the original on the document glass or in the document feeder.
2. On the control panel, press the Scan button.
3. Press the Up Arrow or Down Arrow button to select Scan to Network, then press the OK button.
4. At Scan to, press OK.
5. Press the Up Arrow or Down Arrow button to select Server (FTP), then press OK.
6. Press the Up Arrow or Down Arrow button to select the FTP address, then press OK.
7. Press the Start button to begin the scan.
   The printer scans the document and places the image on the FTP server.

See also:
Adjusting Scanning Options on page 120


Scanning Images into an Application

You can import images directly from the scanner into applications on your Windows or Macintosh computer.

This section includes:
- Scanning an Image into a Windows Application (TWAIN) on page 118
- Using the WIA Image Manager in a Windows Application on page 118
- Scanning an Image into a Macintosh OS X Application on page 119

Scanning an Image into a Windows Application (TWAIN)

*Note:* The printer must be connected to the computer with a USB cable.

To import images into an application using Windows XP SP1 and later, or Windows Server 2003 and later:
1. Open the file in which you want to place the image.
2. In the application, select the menu item to acquire the image. For example, if you are using Microsoft Word 2003, to place an image in a document:
   a. Click Insert.
   b. Click Picture.
   c. Select From Scanner or Camera.
   d. Select the scanner, then click Custom Insert.
3. Select the paper source from the Paper Source menu:
   - Document Glass
   - Document Feeder
4. Specify the other scan driver settings as desired.
   *Note:* For more information, click the Help button to view the online help.
5. Press the Scan button to begin the scan.
   The printer scans the document and places the image in your application.

Using the WIA Image Manager in a Windows Application

You can scan and import images into an application using the WIA Image Manager on Windows XP SP1 and later, or Windows Server 2003 and later.

*Note:* The printer must be connected to the computer with a USB cable.

To import scanned images into an application:
1. Open the file in which you want to place the image.
2. In the application, select the menu item to acquire the image. For example, if you are using Microsoft Word 2003, to place an image in a document:
   a. Select Insert.
b. Select Picture.

c. Select From Scanner or Camera.

d. Select the scanner, then click Custom Insert.

3. Select the paper source from the Paper Source menu:
   - Flatbed
   - Document Feeder

4. Specify any other scan driver settings.

5. Press the Scan button to begin the scan.

The printer scans the document and places the image in your application.

**Scanning an Image into a Macintosh OS X Application**

*Note:* The printer must be connected to the computer with a USB cable.

To import images into an application:

1. Open the file in which you want to place the image.

2. In the application, select the menu item to acquire the image. For example, if you are using Microsoft Word 2003 to place an image in a document:
   a. Select Insert.
   b. Select Picture.
   c. Select From Scanner or Camera.
   d. Select the scanner, then click Acquire.

3. Specify the paper source in the Scan From menu:
   - Document Glass
   - Document Feeder

4. Specify any other scan driver settings.
   *Note:* For more information, click the Help button to view the online help.

5. Press the Scan button to begin the scan.

The printer scans the document and places the image in your application.
Adjusting Scanning Options

This section includes:
- Adjusting Scan Settings on page 120
- Changing the Default Scan Settings on page 123
- Limiting Access to Scan Operations on page 125

Adjusting Scan Settings

You can modify these settings for individual jobs, once you select the scan mode.

You can also change the default values for some settings. For details, see Changing the Default Scan Settings on page 123.

This section includes:
- Setting the File Format on page 120
- Setting the Color Mode on page 120
- Setting the Scan Resolution on page 121
- Specifying the Original Document Size on page 121
- Specifying the Scanned Image File Format on page 121
- Automatically Suppressing Background Variations on page 122
- Adjusting Image Brightness on page 122
- Adjusting Image Sharpness on page 122
- Adjusting Image Contrast on page 122
- Adjusting the Top and Bottom Margins on page 123
- Adjusting the Left and Right Margins on page 123
- Adjusting the Middle Margin on page 123

Setting the File Format

1. Press the Up Arrow or Down Arrow button to select File Format, then press the OK button.
2. Select a setting:
   - PDF
   - MultiPage TIFF
   - TIFF
   - JPEG
3. Press OK.

Setting the Color Mode

If the original image contains color, you can scan the image in color or in black and white. Selecting black and white significantly reduces the file size of the scanned images.
To set the color mode:
1. Press the Up Arrow or Down Arrow button to select Color Mode, then press the OK button.
2. Select a color mode:
   - Grayscale
   - Color
   - Color (Photo)
   - Black & White
3. Press OK.

**Setting the Scan Resolution**

The scan resolution depends on how you plan to use the scanned image. Scan resolution affects both the size and image quality of the scanned image file. The higher the scan resolution, the larger the file size.

To set the scan resolution:
1. Press the Up Arrow or Down Arrow button to select Resolution, then press the OK button.
2. Select an option:
   - 200x200 produces the lowest resolution and smallest file size.
   - 300x300 produces medium resolution and a medium file size.
   - 400x400 produces high resolution and a large file size.
   - 600x600 produces the highest resolution and largest file size.
3. Press OK.

**Specifying the Original Document Size**

To specify the size of the original:
1. Press the Up Arrow or Down Arrow button to select Document Size, then press the OK button.
2. Select a specific paper size to determine the area to scan:
   - Letter - 8.5x11”
   - US Folio - 8.5x13”
   - Legal - 8.5x14”
   - A4 - 210x297mm
   - A5 - 148x210mm
   - B5 - 182x257mm
   - Executive - 7.25x10.5”
3. Press OK.

**Specifying the Scanned Image File Format**

To specify the file format of the scanned image:
1. Press the Up Arrow or Down Arrow button to select File Format, then press the OK button.
2. Select a file type:
Scanning

- PDF
- MultiPageTIFF
- TIFF
- JPEG

The default setting is PDF.

3. Press OK.

Automatically Suppressing Background Variations

When scanning originals printed on thin paper, text or images printed on one side of the paper can sometimes be seen on the other side. Use the Auto Exposure setting on the control panel to improve the quality of 2-sided scanned pages. This setting minimizes the sensitivity of the scanner to variations in light background colors.

To turn Auto Exposure on or off:
1. Press the Up Arrow or Down Arrow button to select Auto Exposure, then press the OK button.
2. Select On or Off, then press OK.

Note: The default setting is On.

Adjusting Image Brightness

1. Press the Up Arrow or Down Arrow button to select Lighten/Darken, then press the OK button.
2. Press the Forward Arrow or Back Arrow button to move the slider to the desired setting.
3. Press OK.

Adjusting Image Sharpness

1. Press the Up Arrow or Down Arrow button to select Sharpness, then press the OK button.
2. Select an option:
   - Sharp
   - Normal
   - Soft
3. Press OK.

Adjusting Image Contrast

1. Press the Up Arrow or Down Arrow button to select Contrast, then press the OK button.
2. Select an option:
   - Higher
   - Normal
   - Lower
3. Press OK.
Adjusting the Top and Bottom Margins
1. Press the Up Arrow or Down Arrow button to select Margin Top/Bottom, then press the OK button.
2. Press the Up Arrow or Down Arrow button to set the margins from 0.0 through 2.0 in.
3. Press OK.

Adjusting the Left and Right Margins
1. Press the Up Arrow or Down Arrow button to select Margin Left/Right, then press the OK button.
2. Press the Up Arrow or Down Arrow button to set the margins from 0.0 through 2.0 in.
3. Press OK.

Adjusting the Middle Margin
1. Press the Up Arrow or Down Arrow button to select Margin Middle, then press the OK button.
2. Press the Up Arrow or Down Arrow button to set the margins from 0.0 through 2.0 in.
3. Press OK.

Changing the Default Scan Settings
The printer uses these settings unless you change them for an individual scan job.

This section includes:
- Setting the Scan to Network Option on page 123
- Setting the Default Color on page 124
- Setting the Color Button Sets on page 124
- Setting the Auto Exposure Level on page 124
- Setting the TIFF File Format on page 124
- Setting the Image Compression on page 125
- Setting the Maximum Email Size on page 125
- Changing General Scan Default Settings on page 125

To adjust any of the default scan settings:
1. On the control panel, press the System button.
2. Press the Up Arrow or Down Arrow button to select Defaults Settings, then press the OK button.
3. Select Scan Defaults, then press OK.
4. Press the Up Arrow or Down Arrow button to select the option you want to modify, then press OK.
5. Select the desired setting, then press OK.
   
   Note: Press the Return button at any time to return to the previous selection.

Setting the Scan to Network Option
1. Select Scan to Network, then press the OK button.
2. Press the Up Arrow or Down Arrow button to select a setting:
Scanning

- Computer (Network)
- Server (FTP)

3. Press OK.

Setting the Default Color

1. Press the Up Arrow or Down Arrow button to select Color, then press the OK button.
2. Select a setting:
   - Black & White
   - Color
3. Press OK.

Setting the Color Button Sets

1. Press the Up Arrow or Down Arrow button to select Color Button Set, then press the OK button.
2. Select B & W Button, then press OK.
3. Select a setting:
   - Black & White
   - Grayscale
4. Press OK.
5. Select Color Button, then press OK.
6. Select a setting:
   - Color
   - Color(Photo)
7. Press OK.

Setting the Auto Exposure Level

1. Press the Up Arrow or Down Arrow button to select Auto Expo. Level, then press the OK button.
2. Select a setting:
   - Normal
   - Higher(1)
   - Higher(2)
3. Press OK.

Setting the TIFF File Format

1. Press the Up Arrow or Down Arrow button to select TIFF File Format, then press the OK button.
2. Select a setting:
   - TIFF V6
   - TTN2
3. Press OK.
**Setting the Image Compression**

1. Press the **Up Arrow** or **Down Arrow** button to select **Image Compression**, then press the **OK** button.
2. Select a setting:
   - **Higher**
   - **Normal**
   - **Lower**
3. Press **OK**.

**Setting the Maximum Email Size**

1. Press the **Up Arrow** or **Down Arrow** button to select **Max Email Size**, then press the **OK** button.
2. Press the **Up Arrow** or **Down Arrow** button, or use the alphanumeric keypad, to set a value from 50 through 16384.
3. Press **OK**.

**Changing General Scan Default Settings**

You can also change the default setting for the following general scan settings:

- Resolution
- Document Size
- Lighten/Darken
- Sharpness
- Contrast
- Auto Exposure
- Margin Top/Bottom
- Margin Left/Right
- Margin Middle

*Note: For individual settings, see Adjusting Scan Settings on page 120.*

**Limiting Access to Scan Operations**

The Scan Lock options limit access to scan operations.

To set scan locks:
1. On the control panel, press the **System** button.
2. Press the **Up Arrow** or **Down Arrow** button to select **Admin Menu**, then press the **OK** button.
3. If prompted, enter the four-digit password, then press **OK**.
4. Select **Secure Settings**, then press **OK**.
5. Select **Service Lock**, then press **OK**.
6. Select an option:
   - **Scan to Computer**
Scanning

- PC Scan
- Scan to E-Mail
- Scan to Network
- Scan to USB Memory

7. Press OK.
8. Select an option:
   - Unlocked turns off the service lock.
   - Locked turns on the service lock, disabling the scan function.
   - Password Locked requires a password to use the scan function. Enter a new password, then press OK.

9. Press OK.
Faxing

This chapter includes:

- **Loading Documents for Faxing** on page 128
- **Basic Faxing** on page 129
- **Using the Fax Address Book** on page 132
- **Selecting Fax Options for Single Jobs** on page 137
- **Changing the Default Fax Job Settings** on page 139
- **Managing Fax Functions** on page 140

See also:

- **Installation and Setup Overview** on page 28
Loading Documents for Faxing

Position the original document to be scanned as shown.

**Document Glass**
Lift the document feeder or the document glass cover, then place the original face down in the upper left corner of the document glass.

**Document Feeder**
Insert originals face up with the top of the page entering the feeder first. Adjust the paper guides so they fit against the originals.

*Note: For details, see Automatic Document Feeder Guidelines on page 100.*
Basic Faxing

This section includes:

- Sending a Fax from the Printer on page 129
- Sending a Fax from Your Computer on page 130

Note: Before faxing, you must set the country code and fax number for the printer. For details, see Fax Configuration on page 139.

Sending a Fax from the Printer

To send a fax from the printer to a single recipient using the default settings:
1. Place your original document on the document glass or in the document feeder.
2. On the control panel, press the Fax button.
3. At Fax to, press the OK button.
4. To address the fax, press the Up Arrow or Down Arrow button to select an option:
   - Keypad allows you to enter the fax number manually using the alphanumeric keypad.
   - Speed Dial allows you to select a previously programmed speed dial. Use the alphanumeric keypad to enter a three-digit speed dial number.
   - Fax Address Book allows you to select a number from the Fax Address Book. For details, see Faxing to an Individual in the Address Book on page 133.
   - Group Dial allows you to send the fax to numerous recipients. For details, see Faxing to an Address Book Group on page 136.
   - Search Local Phone Book allows you to search the printer address book using a partial name. For details, see Searching the Local Phone Book on page 136.
   - Search Server Phone Book allows you to search the server address book using a partial name. For details, see Searching the Server Phone Book on page 136.
5. Press OK.
6. Press the Up Arrow or Down Arrow button to select the fax options you want to change. For details, see Selecting Fax Options for Single Jobs on page 137.
7. Press the Start button.
8. If the Another Page? prompt appears, select one of the following:
   - No completes the scanning process.
   - Yes prompts you to place the next page on the document glass. Select Continue or Cancel the Action.
9. Press OK.

The printer scans the pages and transmits the fax.

Note: If monitor reports are set to print, the report shows the fax transmission status. For details, see Printing Monitor Reports on page 140.
Faxing

See also:

- Using the Fax Address Book on page 132
- Managing Fax Functions on page 140
- Printing Monitor Reports on page 140
- Inserting Pauses in Fax Numbers on page 143

**Sending a Fax from Your Computer**

You can send a fax to the printer from an application on your computer.

### Sending a Fax Using Windows Applications

To send a fax from a Windows XP SP1 and later, or Windows Server 2003 and later computer:

1. In the application, access the **Print** dialog box.
2. Select your **WorkCentre 6505 PCL** printer, then click **Properties** or **Preferences** to open the print driver.
3. On the **Paper/Output** tab, select **Fax** from the **Job Type** drop-down list.
4. Click **Transmission image quality**, and select a quality setting from the drop-down menu:
   - Standard
   - High Quality
   - Super-high image quality
5. Click **Transmission Report**, and select a setting from the drop-down menu:
   - **Output Regularly** generates a transmission report for every fax sent.
   - **Output for error in transmission** only generates a transmission report when an error occurs.
   - **Do not output** does not generate a transmission report.
6. Click **OK**.
7. For cover page options, click **Fax Cover Page Settings**, and select a setting from the drop-down menu:
   - **Use Printer Settings**
   - **Attach**
   - **None**
8. Click **OK**.
9. In the **Print** window, click **OK**.
   
   The Recipient Setting dialog box opens.
10. Add recipients to the Recipient List. For more information, click the **Help** button to view the online help.
11. To delay sending the fax, select the **Delayed Send** check box, then adjust the delay time.
12. Click **Start Sending** to send the fax.

   **Note:** To stop a fax from sending, click the **Stop** button.
Sending a Fax Using Macintosh Applications

To send a fax from a Macintosh OS X version 10.5 and later computer, download the latest driver from www.xerox.com/office/WC6505drivers.
Using the Fax Address Book

You can create and save fax information for individuals or groups. You can then select saved names and numbers without re-entering them each time you want to send a fax.

This section includes:
- Faxing to an Individual on page 132
- Faxing to a Group on page 133

Faxing to an Individual

Set up and save individual names and fax numbers to use when you want to send a fax.

This section includes:
- Adding an Individual Fax Address Book Entry on page 132
- Faxing to an Individual in the Address Book on page 133

Adding an Individual Fax Address Book Entry

Create individual address book entries using CentreWare Internet Services or the Address Book Editor.

**Note:** To use the Address Book Editor, your computer must be connected to the printer with a USB cable.

To add an individual entry using CentreWare Internet Services:
1. At your computer, open a Web browser, type the IP address of the printer in the address field, then press Enter or Return.
   **Note:** If you do not know the IP address for your printer, see Finding the IP Address of Your Printer on page 35.
2. In CentreWare Internet Services, click Address Book.
3. Under Address Book in the left navigation pane, click FAX Address Book.
4. In the Directory Listing, click the Add button for an entry that is not in use.
   **Note:** The first eight entries in the Address Book correspond to the eight one-touch buttons on the left side of the control panel.
5. Type the name and phone number for the individual.
6. Click the Save Changes button to create the address.
   The new entry is saved to the fax address book.
   **Note:** Three-digit speed dial entries are assigned automatically in CentreWare Internet Services.

To add an individual entry using the Address Book Editor:
1. Access the Address Book Editor:
   - **Windows:** On the Start menu, select Programs > Xerox > WorkCentre 6505 > Address Book Editor.
Faxing

- **Macintosh**: Open the Applications folder, select Xerox/WorkCentre 6505/Address Book Editor, then click **OK**.

2. In the left pane, right-click the Fax icon, then select **New > New Entry**.

   The Speed Dial dialog box appears. The Address Book Editor automatically assigns the speed dial number to the first empty entry.

3. To assign the speed dial number manually, click the **Specify an Address Number** check box, then enter a value from 1 through 200.

   **Note**: The first eight entries in the Address Book correspond to the eight one-touch buttons on the left side of the control panel.

4. Type a name in the **Name** field.

5. Type a phone number in the **Phone Number** field, using numerals and pauses.

   **Note**: To insert a pause, type a hyphen.

6. To add this entry to an existing group:
   a. Click **Group Membership**.
   b. Select the groups to add this entry to, then click **Add**.
   c. Confirm the group members, then click **OK**.

7. Click **OK**.

8. Click on the **File** menu, then select **Save All**.

   The address book is saved with the new fax entry.

**Faxing to an Individual in the Address Book**

To fax to an individual in the address book:

1. On the control panel, press the Fax button.

2. At Fax to, press the Address Book button.

3. At All Entries, press the **OK** button.

4. Press the Up Arrow or Down Arrow button to scroll through the address book list, then press **OK** to select the recipient.

   **Note**: You can select more than one recipient.

5. After selecting the recipients, press **OK**.

6. Press the **Start** button.

   The printer starts the fax job.

   **Note**: To stop a fax from sending, press the **Stop** button.

**Faxing to a Group**

To send a fax to multiple individuals, create a group speed dial entry. Groups can include previously stored individual and group entries.

   **Note**: Individual entries must be set up before groups can be defined. For details, see **Adding an Individual Fax Address Book Entry** on page 132.

This section includes:
Faxing

- Creating a Fax Group on page 134
- Editing Address Book Fax Groups on page 135
- Faxing to an Address Book Group on page 136
- Searching the Local Phone Book on page 136
- Searching the Server Phone Book on page 136

Creating a Fax Group

Create group address book entries using CentreWare Internet Services or the Address Book Editor.

**Note:** To use the Address Book Editor, your computer must be connected to the printer with a USB cable.

To create a fax group using CentreWare Internet Services:

1. At your computer, open a Web browser, type the IP address of the printer in the address field, then press Enter or Return.

   **Note:** If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on page 35.

2. In CentreWare Internet Services, click Address Book.
3. Under Address Book in the left navigation pane, click FAX Groups.
4. In Directory Listing, click the Add link of any group that is not in use.
5. Type a group name, then click the Save Changes button.
6. When you see a Request Acknowledged message, click the Return button.
7. Click the Edit link for the group you created.
8. Select the check boxes of individuals you want to include in the group.

   **Note:** Click the Additional Entries links at the bottom of the Group Members column to see additional Fax Address Book entries. You can also add existing groups to this group.

9. When you have finished selecting group members, click Save Changes.

   The address book is saved on the printer with the new group.

To create a fax group using the Address Book Editor:

1. Access the Address Book Editor:
   - Windows: On the Start menu, select Programs > Xerox > WorkCentre 6505 > Address Book Editor.
   - Macintosh: Open the Applications folder, and then select Xerox/WorkCentre 6505/Address Book Editor, and then click OK.
2. In the left pane, right-click the Fax icon, then select New > New Group.
   The Group Dial dialog box opens. The Address Book Editor automatically assigns the Group ID to the first empty entry.
3. To specify the Group ID manually, click the Specify an Address Number check box, then enter a value from 1 through 6.
4. Type a group name in the Group Name field.
5. Click the Group Membership button.
6. Select group members from the list on the left side of the screen, then click the Add button to add them to the group.
   
   **Note:** To select multiple group members, press and hold the Ctrl key while making selections.

7. When you have finished adding group members, click OK.

8. Click OK a second time to create the group.

9. Confirm the group members, then click OK to save the group.

10. Click on the File menu, then select Save All.
    The address book is saved with the new fax group.

### Editing Address Book Fax Groups

Edit address book entries using CentreWare Internet Services or the Address Book Editor.

**Note:** To use the Address Book Editor, your computer must be connected to the printer with a USB cable.

To edit an existing fax group using CentreWare Internet Services:

1. At your computer, open a Web browser, type the IP address of the printer in the address field, then press Enter or Return.
   
   **Note:** If you do not know the IP address for your printer, see Finding the IP Address of Your Printer on page 35.

2. In CentreWare Internet Services, click Address Book.

3. Under Address Book in the left navigation pane, click FAX Groups.

4. In the Directory Listing, click the Edit button for the group you want to edit.

5. Select the check boxes of individuals you want in the group. Clear the check boxes of individuals you want to remove from the group.
   
   **Note:** Click the Additional Entries links at the bottom of the Group Members column to see additional Fax Address Book entries.

6. When you have finished editing the group, click Save Changes.
    The address book is saved with the edited group.

7. Click Return.

To edit an existing fax group using the Address Book Editor:

1. Access the Address Book Editor:
   - Windows: On the Start menu, select Programs > Xerox > WorkCentre 6505 > Address Book Editor.
   - Macintosh: Open the Applications folder, and then select Xerox/WorkCentre 6505/Address Book Editor, then click OK.

2. In the left pane, click the Fax icon.

3. In the upper right pane, right-click the group you want to edit, then select Edit.

4. Click the Group Membership button.

5. Select entries from the list on the left side of the screen, then click the Add and Delete buttons to edit the group.
Faxing to an Address Book Group

To fax to a group:
1. On the control panel, press the Fax button.
2. At Fax to, press the Address Book button.
3. Press the Up Arrow or Down Arrow button to select Group Dial, then press the OK button.
4. Press the Up Arrow or Down Arrow button to scroll through the address book list, then press OK to select the group.
   
   **Note:** You can select more than one group.
5. After selecting the groups, press OK.
6. Press the Start button.
   The printer starts the fax job.

Searching the Local Phone Book

To search for an individual or group in the local phone book using a partial name:
1. On the control panel, press the Fax button.
2. At Fax to, press the OK button.
3. Press the Up Arrow or Down Arrow button to select Search Local Phone Book, then press OK.
4. Use the alphanumeric keypad to enter the search text, then press OK.
5. Press the Up Arrow or Down Arrow button to scroll through the local address book results.
6. Press OK to select the entry.
7. Press OK.

Searching the Server Phone Book

To search for an individual or group in the server phone book using a partial name:
1. On the control panel, press the Fax button.
2. At Fax to, press the OK button.
3. Press the Up Arrow or Down Arrow button to select Search Server Phone Book, then press OK.
4. Use the alphanumeric keypad to enter the search text, then press OK.
5. Press the Up Arrow or Down Arrow button to scroll through the server address book results.
6. Press OK to select the entry.
7. Press OK.
Selecting Fax Options for Single Jobs

This section includes:

- Setting the Fax Resolution on page 137
- Making the Image Lighter or Darker on page 137
- Turning On Hook On or Off on page 137
- Sending a Delayed Fax on page 138
- Including a Fax Cover Page on page 138
- Setting Up Polling on page 138

Setting the Fax Resolution

To set the fax resolution:
1. On the control panel, press the Fax button.
2. Press the Up Arrow or Down Arrow button to select Resolution, then press the OK button.
3. Select an option from the drop-down list:
   - Standard
   - Fine
   - Super Fine
   - Photo
   
   Note: The default setting is Standard.
4. Press OK.

Making the Image Lighter or Darker

To lighten or darken an image when it is faxed:
1. On the control panel, press the Fax button.
2. Press the Up Arrow or Down Arrow button to select Lighten/Darken, then press the OK button.
3. Press the Forward Arrow or Back Arrow button to move the slider and lighten or darken the fax.
   
   Note: The default setting is Normal.
4. Press OK.

Turning On Hook On or Off

When you turn on the On Hook option, the telephone line is ready to dial out when you enter a phone number. You cannot receive incoming faxes while On Hook is turned on.

To turn On Hook on or off:
1. On the control panel, press the Fax button.
2. Press the Up Arrow or Down Arrow button to select On Hook, then press the OK button.
Faxing

3. Select Off or On, then press OK.

Sending a Delayed Fax

To send a fax at a specified time within 24 hours:
1. On the control panel, press the Fax button.
2. Press the Up Arrow or Down Arrow button to select Delayed Start, then press the OK button.
3. Select On, then press OK.
4. Select the time to send the fax:
   a. Press the Up Arrow or Down Arrow button to select a number from 0 through 23 for the hour.
   b. Press the Forward Arrow or Back Arrow button to select Minutes.
   c. Press the Up Arrow or Down Arrow button to select a number from 0 through 59 for minutes, then press OK.
5. Press the Start button.
   The fax is scanned and saved, and sent at the time you specified.

Including a Fax Cover Page

To include a fax cover page when sending a fax:
1. On the control panel, press the Fax button.
2. Press the Up Arrow or Down Arrow button to select Fax Cover Page, then press the OK button.
3. Select On, then press OK.

Setting Up Polling

To turn on Polling:
1. On the control panel, press the Fax button.
2. Press the Up Arrow or Down Arrow button to select Polling, then press the OK button.
3. Select On, then press OK.
Changing the Default Fax Job Settings

To change the default fax settings:
1. On the control panel, press the System button.
2. Press the Up Arrow or Down Arrow button to select Default Settings, then press the OK button.
3. Select Fax Defaults, then press OK.
4. Press the Up Arrow or Down Arrow button to select the setting you want to change, then press OK.
5. Press the Up Arrow or Down Arrow button to select the new setting, then press OK.

Fax Configuration

To configure the printer for faxing:
1. On the control panel, press the System button.
2. Press the Up Arrow or Down Arrow button to select Admin Menu, then press the OK button.
3. If prompted, enter the password, then press OK.
4. Select Fax Settings, then press OK.
5. Edit the fax settings as desired.
6. Press OK.

For information on the Fax Settings menu items, see Fax Settings on page 153.
Managing Fax Functions

This section includes:

- Printing Monitor Reports on page 140
- Enabling or Disabling Secure Faxes on page 141
- Limiting Access to Fax Operations on page 141
- Limiting Who Can Send Faxes to the Printer on page 142
- Limiting Access to Fax Operations on page 142
- Printing Fax Reports on page 143
- Inserting Pauses in Fax Numbers on page 143

Printing Monitor Reports

To select a default option for printing fax monitor reports:
1. On the control panel, press the System button.
2. Press the Up Arrow or Down Arrow button to select Admin Menu, then press the OK button.
3. If prompted, enter the password, then press OK.
4. Select Fax Settings, then press OK.
5. Select Fax Transmit, then press OK.
6. Select an option:
   - Print Always prints a monitor report for every fax.
   - Print at Error prints a monitor report when an error occurs with the fax transmission.
   - Print Disabled does not print a monitor report.
     The default setting is Print Always.
7. Press OK.

Printing a Monitor Report for a Group Fax

To select a default option for printing group fax monitor reports:
1. On the control panel, press the System button.
2. Select Admin Menu, then press the OK button.
3. If prompted, enter the password, then press OK.
4. Select Fax Settings, then press OK.
5. Select Fax Broadcast, then press OK.
6. Select an option:
   - Print Always prints a monitor report for every fax.
   - Print at Error prints a monitor report when an error occurs with the fax transmission.
   - Print Disabled does not print a monitor report.
     The default setting is Print Always.
7. Press OK.
Enabling or Disabling Secure Faxes

When the Secure Receive Lock option is enabled, you must enter a password before faxes can be printed.

To enable or disable Secure Receive Lock:
1. On the control panel, press the System button.
2. Press the Up Arrow or Down Arrow button to select Admin Menu, then press the OK button.
3. If prompted, enter the password, then press OK.
4. Select Secure Settings, then press OK.
5. Select Secure Receive, then press OK.
6. At Secure Receive Set, press OK.
7. Select Enable or Disable, then press OK.
8. To change your password:
   a. Select Change Password, then press OK.
   b. Enter the current password, then press OK.
   c. Enter a new four-digit password, then press OK.
   Note: The default password is 0000.

Printing Secure Faxes

If the Secure Receive Lock option is enabled, you must enter your password to print a received fax.

To print all secure faxes:
1. On the control panel, press the Print button.
2. At Secure Receive, press the OK button.
3. When prompted, enter your four-digit password, then press OK.
   The received faxes print.

Limiting Access to Fax Operations

The Fax Lock limits access to fax operations by requiring a password.

To set the fax lock:
1. On the control panel, press the System button.
2. Press the Up Arrow or Down Arrow button to select Admin Menu, then press the OK button.
3. If prompted, enter the four-digit password, then press OK.
4. Select Secure Settings, then press OK.
5. Select Service Lock, then press OK.
6. Select Fax, then press OK.
7. Select an option:
   • Unlocked turns off the service lock.
   • Locked turns on the service lock, disabling the fax function.
Faxing

- **Password Locked** requires a password to use the fax function. Enter a password, then press **OK**.

8. Press **OK**.

**Changing the Panel Lock Password**

The Panel Lock password limits access to the Admin menu.

To change the Panel Lock password:
1. On the control panel, press the **System** button.
2. Press the **Up Arrow** or **Down Arrow** button to select **Admin Menu**, then press the **OK** button.
3. Enter the current four-digit password, then press **OK**.
4. Select **Secure Settings**, then press **OK**.
5. At **Panel Lock**, press **OK**.
6. Select **Change Password**, then press **OK**.
7. Enter the current four-digit password, then press **OK**.
8. Enter a new four-digit password, then press **OK**.
9. Re-enter the new password, then press **OK**.

   **Note:** The default password is 0000.

**Limiting Who Can Send Faxes to the Printer**

When the Junk Fax Filter setting is On, the printer only prints faxes received from phone numbers in the address book.

To turn the Junk Fax Filter on or off:
1. On the control panel, press the **System** button.
2. Press the **Up Arrow** or **Down Arrow** button to select **Admin Menu**, then press the **OK** button.
3. If prompted, enter the four-digit password, then press **OK**.
4. Select **Fax Settings**, then press **OK**.
5. Select **Junk Fax Filter**, then press **OK**.
6. Select an option:
   - **Off** allows anyone to send you a fax.
   - **On** only receives faxes from phone numbers in the printer address book.
7. Press **OK**.

**Limiting Access to Fax Operations**

The Fax Lock options limit access to fax operations.

To set the password:
1. On the control panel, press the **System** button.
2. Press the **Up Arrow** or **Down Arrow** button to select **Admin Menu**, then press the **OK** button.
3. If prompted, enter the four-digit password, then press **OK**.
4. Select **Secure Settings**, then press **OK**.
5. Select **Service Lock**, then press **OK**.
6. Select **Fax**, then press **OK**.
7. Select an option:
   - **Unlocked** turns off the service lock.
   - **Locked** turns on the service lock, disabling the fax function.
   - **Password Locked** requires a password to use the fax function. Enter a new password, then press **OK**.
8. Press **OK**.

### Printing Fax Reports

Various fax reports provide information about faxing activities, directories, and pending jobs.

To print a fax report:
1. On the control panel, press the **System** button.
2. At **Information Pages**, press the **OK** button.
3. If prompted, enter the four-digit password, then press **OK**.
4. Select a report:
   - **Speed Dial** prints information about fax numbers, individual recipients, and group recipients.
   - **Address Book** prints information about fax numbers, individual recipients, and group recipients.
   - **Server Address** prints a list of server addresses.
   - **Fax Activity** prints information about completed fax jobs.
   - **Fax Pending** prints a list of faxes waiting to be sent.
5. Press **OK** to print the report.

### Inserting Pauses in Fax Numbers

Some fax numbers require one or more pauses during the dialing sequence.

To insert pauses in a fax number:
1. On the control panel, press the **Fax** button.
2. Select **Fax To**, then press the **OK** button.
3. Press the **Up Arrow** or **Down Arrow** button to select **Keypad**, then press **OK**.
4. Use the alphanumeric keypad to enter the fax number.
   - If necessary, press the **Redial/Pause** button to insert a pause, represented by a hyphen.
   - **Note:** Press the **Redial/Pause** button multiple times to add additional pauses.
5. Press the **Start** button to send the fax.
Faxing
Control Panel Menus

This chapter includes:

- Navigating the Control Panel Menus on page 146
- System Menus on page 147
Navigating the Control Panel Menus

The following table describes the navigation and function buttons on the control panel.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Copy Icon]</td>
<td>Copy</td>
<td>Allows you to change job settings for copy jobs.</td>
</tr>
<tr>
<td>![Scan Icon]</td>
<td>Scan</td>
<td>Allows you to change job settings for scan jobs.</td>
</tr>
<tr>
<td>![Print Icon]</td>
<td>Print</td>
<td>Prints from USB memory.</td>
</tr>
<tr>
<td>![Fax Icon]</td>
<td>Fax</td>
<td>Allows you to change job settings for fax jobs.</td>
</tr>
<tr>
<td>![Job Status Icon]</td>
<td>Job Status</td>
<td>Displays active jobs.</td>
</tr>
<tr>
<td>![System Icon]</td>
<td>System</td>
<td>Displays or closes the System Menu screen.</td>
</tr>
<tr>
<td>![Address Book Icon]</td>
<td>Address Book</td>
<td>Allows you to access the printer address book.</td>
</tr>
<tr>
<td>![Forward Arrow Icon]</td>
<td>Forward Arrow</td>
<td>Moves one level downward in menu selections or moves the cursor to the right when setting a value.</td>
</tr>
<tr>
<td>![Back Arrow Icon]</td>
<td>Back Arrow</td>
<td>Moves one level upward in menu selections or moves the cursor to the left when setting a value.</td>
</tr>
<tr>
<td>![Up Arrow Icon]</td>
<td>Up Arrow</td>
<td>Displays the previous menu or item. Press the Up and Down Arrow button at the same time to change a setting to its default value.</td>
</tr>
<tr>
<td>![Down Arrow Icon]</td>
<td>Down Arrow</td>
<td>Displays the next menu or item. Press the Up and Down Arrow button at the same time to change a setting to its default value.</td>
</tr>
<tr>
<td>![OK Icon]</td>
<td>OK</td>
<td>Selects or executes the option or function displayed on the screen.</td>
</tr>
<tr>
<td>![Return Icon]</td>
<td>Return</td>
<td>Navigates up one menu level.</td>
</tr>
<tr>
<td>![Power Saver Icon]</td>
<td>Power Saver</td>
<td>Controls entry and exit from Energy Saver Mode. Light on indicates the printer is in Energy Saver mode. Light off indicates the printer is ready to print.</td>
</tr>
<tr>
<td>![Stop Icon]</td>
<td>Stop</td>
<td>Stops the current operation.</td>
</tr>
<tr>
<td>![Clear All Icon]</td>
<td>Clear All</td>
<td>Cancels the current print, copy, scan, or fax job.</td>
</tr>
<tr>
<td>![Redial/Pause Icon]</td>
<td>Redial/Pause</td>
<td>Recalls the last fax number used or inserts pauses in fax numbers.</td>
</tr>
<tr>
<td>![Speed Dial Icon]</td>
<td>Speed Dial</td>
<td>Used to access directories of group or individual fax telephone numbers.</td>
</tr>
</tbody>
</table>
# System Menus

This section includes:
- **System Menus** on page 147
- **Information Pages** on page 148
- **Billing Meters** on page 148
- **Admin Menu** on page 149
- **Default Settings** on page 161
- **Tray Settings** on page 163

## System Menus

Press the **System** button on the control panel to access the following menus:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information Pages</td>
<td>Allows you to print various reports and lists. For details, see <strong>Information Pages</strong> on page 148.</td>
</tr>
<tr>
<td>Billing Meters</td>
<td>Displays the printed paper counts on the control panel. For details, see <strong>Billing Meters</strong> on page 148.</td>
</tr>
<tr>
<td>Admin Menu</td>
<td>Allows you to set up administrative options:</td>
</tr>
<tr>
<td></td>
<td>* Phone Book: Use to create or delete address book entries.</td>
</tr>
<tr>
<td></td>
<td>* PCL Settings: Use to specify settings such as paper tray, paper size and orientation, font information, and default color.</td>
</tr>
<tr>
<td></td>
<td>* PDF Settings: Use to adjust PDF settings such as quantity, print mode, and layout.</td>
</tr>
<tr>
<td></td>
<td>* PostScript Settings: Use to adjust PostScript settings such as error reports, job timeout, paper select mode, and default color.</td>
</tr>
<tr>
<td></td>
<td>* Network Setup: Use to configure the network settings for the printer.</td>
</tr>
<tr>
<td></td>
<td>* Fax Settings: Use to configure default fax settings.</td>
</tr>
<tr>
<td></td>
<td>* USB Setup: Use to determine port status and Adobe protocol.</td>
</tr>
<tr>
<td></td>
<td>* System Setup: Use to make system settings, such as Alarm and Power Saver mode.</td>
</tr>
<tr>
<td></td>
<td>* Maintenance: Use to reset default settings or adjust color registration.</td>
</tr>
<tr>
<td></td>
<td>* Secure Settings: Use to set printer security settings.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For details, see <strong>Admin Menu</strong> on page 149.</td>
</tr>
<tr>
<td>Defaults Settings</td>
<td>Allows you to define default settings. For details, see the following:</td>
</tr>
<tr>
<td></td>
<td>* <strong>Copy Defaults</strong> on page 161</td>
</tr>
<tr>
<td></td>
<td>* <strong>Fax Defaults</strong> on page 163</td>
</tr>
<tr>
<td></td>
<td>* <strong>Scan Defaults</strong> on page 162</td>
</tr>
<tr>
<td></td>
<td>* <strong>Print from USB Defaults</strong> on page 163</td>
</tr>
<tr>
<td>Tray Settings</td>
<td>Allows you to define the size and type of paper loaded in each tray.</td>
</tr>
<tr>
<td>Panel Language</td>
<td>Allows you to select the language that appears on the control panel.</td>
</tr>
</tbody>
</table>
Information Pages

The Information Pages menu allows you to print various reports and lists. You can print the Menu Map to see where these information pages are located in the control panel menu structure.

<table>
<thead>
<tr>
<th>Information Page</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Map</td>
<td>Prints a map of the control panel menus.</td>
</tr>
<tr>
<td>Configuration</td>
<td>Prints status of the printer, such as hardware configuration and network information. Print this report to verify if optional accessories have been correctly installed.</td>
</tr>
<tr>
<td>PCL Fonts List</td>
<td>Prints information on PCL internal fonts and samples of the fonts.</td>
</tr>
<tr>
<td>PCL Macro List</td>
<td>Prints a list of PCL macros.</td>
</tr>
<tr>
<td>PS Fonts List</td>
<td>Prints a list of PostScript printer fonts.</td>
</tr>
<tr>
<td>PDF Fonts List</td>
<td>Prints a list of fonts applicable to PDF documents.</td>
</tr>
<tr>
<td>Job History</td>
<td>Prints information on previous printing jobs, such as the date, time, job type, document name, output color, and paper size. The status of a maximum of 20 jobs can be printed on the Job History Report. You can print the Job History Report automatically for every 20 jobs completed. For details, see Auto Log Print on page 158.</td>
</tr>
<tr>
<td>Error History</td>
<td>Prints information about the latest System Fail and Paper Jam errors.</td>
</tr>
<tr>
<td>Printer Meter</td>
<td>Prints a Print Volume Report containing information about pages and sheets printed, divided by color and black and white.</td>
</tr>
<tr>
<td>Demo Page</td>
<td>Prints a sample document for checking the printer performance.</td>
</tr>
<tr>
<td>Protocol Monitor</td>
<td>Prints information about the previous fax job as an aid in determining fax protocol problems.</td>
</tr>
<tr>
<td>Speed Dial</td>
<td>Prints a list of individual and group speed dial entries.</td>
</tr>
<tr>
<td>Address Book</td>
<td>Prints a list of individual and group email entries.</td>
</tr>
<tr>
<td>Server Address</td>
<td>Prints a list of server addresses associated with the printer.</td>
</tr>
<tr>
<td>Fax Pending</td>
<td>Prints a list of faxes waiting to be sent.</td>
</tr>
</tbody>
</table>

Billing Meters

The Billing Meters menu shows the number of processed print jobs. The meter is divided according to the color modes. You cannot print the billing meters and you cannot reset them; they track the total number of pages printed for the life of the printer.
The print meter, in contrast, can be reset, and you can print the information as the Print Volume report. For details, see **Checking Page Counts** on page 176.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Impression</td>
<td>Displays the total number of pages printed.</td>
</tr>
<tr>
<td>Color Impression</td>
<td>Displays the total number of pages printed in color.</td>
</tr>
<tr>
<td>Black Impression</td>
<td>Displays the total number of pages printed in black and white.</td>
</tr>
</tbody>
</table>

See also:  
* **Checking Page Counts** on page 176.

**Admin Menu**

Use the Admin Menu to access the configuration settings of the printer.

The Admin menu contains the following submenus:
- *Fax Address Book* on page 149
- *PCL Settings* on page 150
- *PDF Settings* on page 151
- *PostScript Settings* on page 151
- *Network Setup* on page 152
- *Fax Settings* on page 153
- *USB Setup* on page 156
- *System Setup* on page 157
- *Maintenance* on page 159
- *Secure Settings* on page 160

**Fax Address Book**

Use this menu to create, edit, and delete speed dial and group dial numbers.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speed Dial</td>
<td>Create, edit, and delete speed dial address book entries.</td>
</tr>
<tr>
<td>Group Dial</td>
<td>Create, edit, and delete speed dial group entries.</td>
</tr>
</tbody>
</table>
## PCL Settings

Use this menu to configure settings for PCL.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Tray</td>
<td>Specifies the paper tray used.</td>
</tr>
<tr>
<td>Paper Size</td>
<td>Specifies the default paper size.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Specifies the paper printing direction: Portrait or Landscape. The default setting is Portrait.</td>
</tr>
<tr>
<td>2-Sided</td>
<td>Specifies 2-sided printing options:</td>
</tr>
<tr>
<td></td>
<td>• 2-Sided Print: On or Off. The default setting is On when the duplex unit is installed.</td>
</tr>
<tr>
<td></td>
<td>• Binding Edge: Flip Long Edge or Flip Short Edge</td>
</tr>
<tr>
<td>Font</td>
<td>Specifies the default font. The default setting is Courier.</td>
</tr>
<tr>
<td>Symbol Set</td>
<td>Specifies the font used for symbols. The default setting is ROMAN-8.</td>
</tr>
<tr>
<td>Font Size</td>
<td>Specifies the default font size, from 4 through 50, in increments of 0.25. Available only for typographic fonts.</td>
</tr>
<tr>
<td>Font Pitch</td>
<td>Specifies the character spacing. You can specify a value from 6.00 through 24.00 in increments of 0.01. The default setting is 10.00.</td>
</tr>
<tr>
<td>Form Line</td>
<td>Specifies the form line (the number of lines per form). You can specify a value from 5 through 128 in increments of 1. The default setting is 64.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Specifies the copies to print. You can specify a value from 1 through 999. The default setting is 1.</td>
</tr>
<tr>
<td>Image Enhance</td>
<td>Specifies whether to perform image enhancement. Image enhancement is a feature that makes the boundary line between black and white smoother, to decrease jags and enhance the appearance. The default setting is On.</td>
</tr>
<tr>
<td>Hex Dump</td>
<td>Specifies whether to print the data sent from a computer in the ASCII code corresponding to the hexadecimal notation format to check the data contents. The default setting is Disable.</td>
</tr>
<tr>
<td>Draft Mode</td>
<td>Specifies whether to print in draft mode. The default setting is Disable.</td>
</tr>
<tr>
<td>Line Termination</td>
<td>Specifies line termination.</td>
</tr>
<tr>
<td></td>
<td>• Off: Line termination commands are not added.</td>
</tr>
<tr>
<td></td>
<td>• Add-LF: The Line Feed command is added.</td>
</tr>
<tr>
<td></td>
<td>• Add-CR: The Carriage Return command is added.</td>
</tr>
<tr>
<td></td>
<td>• CR-XX: The Line Feed and Carriage Return commands are both added.</td>
</tr>
<tr>
<td>Default Color</td>
<td>Specifies the default color mode: Black or Color. The default setting is Black.</td>
</tr>
</tbody>
</table>
PDF Settings

Use this menu to specify PDF settings.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantity</td>
<td>Specifies the number of copies to print. You can specify a value from 1 through 99 in increments of 1. The default setting is 1.</td>
</tr>
</tbody>
</table>
| 2-Sided Print    | Specifies the method to use for printing 2-sided documents:  
  • 1-Sided  
  • Flip Long Edge  
  • Flip Short Edge |
| Print Mode       | Specifies the print mode:  
  • Normal  
  • High Quality  
  • High Speed |
| PDF Password     | Specifies a password to enter to print a PDF file. Use the alphanumeric keypad to enter a password up to 32 characters.                   |
| Collated         | Specifies whether to collate copies.                                                                                                       |
| Paper Size       | Specifies the paper size for PDF documents:  
  • Letter  
  • Auto |
| Layout           | Specifies the default page layout for PDF documents:  
  • Auto %  
  • 100 %  
  • Booklet  
  • 2 Pages Up  
  • 4 Pages Up |
| Default Color    | Specifies the default color mode for PDF documents:  
  • Color  
  • Black  
  The default setting is Color. |

PostScript Settings

Use this menu to specify PostScript settings.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PS Error Report</td>
<td>Turns the PostScript error report off or on.</td>
</tr>
<tr>
<td>PS Job Time-Out</td>
<td>Turns the PostScript job time-out off or on.</td>
</tr>
</tbody>
</table>
Control Panel Menus

Network Setup

Use this menu to configure printer settings for jobs sent to the printer through a network port.

Notes:
- The settings in the Network Setup menu cannot be selected if you access this menu during printing.
- Restart the printer to activate menu setting changes. After changing settings, turn off the printer, then turn it on again.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Select Mode</td>
<td>Sets the paper select mode to Auto or Select From Tray.</td>
</tr>
<tr>
<td>Default Color</td>
<td>Sets the default color mode to Color or Black. The default setting is Color.</td>
</tr>
</tbody>
</table>

Ethernet

Specifies the Ethernet communication speed and the modes.
- Auto: Automatically detects 10Base Half, 10Base Full, 100Base Half, and 100Base Full. The default setting is Auto.
- 10Base Half: Uses 10Base-T half-duplex.
- 10Base Full: Uses 10Base-T full-duplex.
- 100Base Half: Uses 100Base-TX half-duplex.
- 100Base Full: Uses 100Base-TX full-duplex.
- 1000Base Full: Uses 1000Base-TX full-duplex.

TCP/IP

Specifies the TCP/IP settings for the network.
- IP Mode: Dual Stack, IPv4 Mode, or IPv6 Mode.
- IPv4: Get IP Address, IP Address, Network Mask, or Gateway Address.

Protocol

Set Enable when using the protocol. When Disable is selected, the protocol cannot be activated.
- LPR: The default setting is Enable.
- Port9100: The default setting is Enable.
- FTP: The default setting is Enable.
- IPP
- SMB TCP/IP
- SMB NetBEUI
- WSD
- Network TWAIN
- SNMP: The default setting is Enable.
- Email Alerts: The default setting is Enable.
- CentreWare IS: The default setting is Enable.
- Bonjour (mDNS): The default setting is Enable.
- Telnet
- Update Addr Book
- LLTD
Fax Settings

Use this menu to specify fax settings.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host Access List</td>
<td>Limits the IP addresses that can access this printer.</td>
</tr>
<tr>
<td>Initialize NVM</td>
<td>Initializes network data stored in NVM. After executing this function and restarting the printer, all network settings are reset to their default values.</td>
</tr>
<tr>
<td>Adobe Protocol</td>
<td>Specifies the Adobe protocol:</td>
</tr>
<tr>
<td></td>
<td>• Auto</td>
</tr>
<tr>
<td></td>
<td>• Standard</td>
</tr>
<tr>
<td></td>
<td>• BCP</td>
</tr>
<tr>
<td></td>
<td>• TBCP</td>
</tr>
<tr>
<td></td>
<td>• Binary</td>
</tr>
</tbody>
</table>

**Fax Settings**

Use this menu to specify fax settings.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ans Select</td>
<td>Specifies the receiving mode:</td>
</tr>
<tr>
<td></td>
<td>• FAX Mode: A fax is automatically received.</td>
</tr>
<tr>
<td></td>
<td>• TEL/FAX Mode: When the printer receives an incoming fax, the external telephone rings for the time specified by Auto Ans. TEL/FAX, then the printer automatically receives the fax. If incoming data is not a fax, the printer beeps the internal speaker.</td>
</tr>
<tr>
<td></td>
<td>• Ans/FAX Mode: The printer can share one telephone line with an answering machine. In this mode, the printer monitors the fax signal and picks up the line if there are fax tones. If the phone communication in your country is serial, this mode is not available.</td>
</tr>
<tr>
<td></td>
<td>• DRPD Mode: Before using the Distinctive Ring Pattern Detection (DRPD) option, distinctive ring service must be installed on your telephone line by the telephone company. After the telephone company provides a separate number with a distinctive ring pattern, configure the fax setup to monitor for that specific ring pattern.</td>
</tr>
<tr>
<td></td>
<td>• TEL Mode: Automatic fax reception is turned off. You can receive a fax by picking up the handset of the external phone, then pressing the remote receive code. You can also set OnHook to On, allowing you to hear voice or fax tones from the remote machine, then press <strong>Start</strong>.</td>
</tr>
<tr>
<td>Auto Answer Fax</td>
<td>When FAX Mode is enabled, specifies how long the printer waits before answering an incoming call. Specify values from 0 through 255 seconds.</td>
</tr>
<tr>
<td>Auto Ans. TEL/FAX</td>
<td>When TEL/FAX Mode is enabled, specifies how long the printer waits before answering an incoming call. Specify values from 0 through 255 seconds.</td>
</tr>
<tr>
<td>Auto Ans. Ans/FAX</td>
<td>When ANS/FAX Mode is enabled, specifies how long the printer waits before answering an incoming call. Specify values from 0 through 255 seconds.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Line Monitor</td>
<td>Specifies the volume of the external phone:</td>
</tr>
<tr>
<td></td>
<td>• Min</td>
</tr>
<tr>
<td></td>
<td>• Middle</td>
</tr>
<tr>
<td></td>
<td>• Max</td>
</tr>
<tr>
<td></td>
<td>• Off</td>
</tr>
<tr>
<td>Ring Tone Volume</td>
<td>Specifies the volume for incoming faxes:</td>
</tr>
<tr>
<td></td>
<td>• Min</td>
</tr>
<tr>
<td></td>
<td>• Middle</td>
</tr>
<tr>
<td></td>
<td>• Max</td>
</tr>
<tr>
<td></td>
<td>• Off</td>
</tr>
<tr>
<td>Line Type</td>
<td>Specifies the default line type: PSTN or PBX.</td>
</tr>
<tr>
<td>Dialing Type</td>
<td>Specifies the dialing type:</td>
</tr>
<tr>
<td></td>
<td>• PB</td>
</tr>
<tr>
<td></td>
<td>• DP(10PPS)</td>
</tr>
<tr>
<td></td>
<td>• (20PPS).</td>
</tr>
<tr>
<td>Interval Timer</td>
<td>Specifies the interval timer. Values range from 3 through 255 seconds.</td>
</tr>
<tr>
<td>Number of Redial</td>
<td>Specifies the number of attempts made to redial a fax number, from 0 through 9.</td>
</tr>
<tr>
<td>Redial Interval</td>
<td>Specifies the interval between redial attempts, from 1 through 15 minutes.</td>
</tr>
<tr>
<td>Junk Fax Filter</td>
<td>When set to On, incoming faxes are only accepted from numbers registered in the Address Book.</td>
</tr>
<tr>
<td>Remote Receive</td>
<td>Specifies whether to receive a fax by pressing the remote receive code on the external telephone after picking up the handset of the telephone. When set to On, a fax can be received by pressing the remote receive code on the external telephone.</td>
</tr>
<tr>
<td>Remote Rcv Tone</td>
<td>Specifies the tone in two digits (00–99) when Remote Receive is set to On.</td>
</tr>
<tr>
<td>Company Name</td>
<td>Specifies the sender name that is recorded in the sender report.</td>
</tr>
<tr>
<td>Fax Number</td>
<td>Specifies your telephone number, which is printed at the top of each page sent from your printer.</td>
</tr>
<tr>
<td>Fax Cover Page</td>
<td>When set to On, automatically prints a fax cover page. When set to Off, does not print a fax cover page.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DRPD Pattern</td>
<td>Specifies a distinctive ring pattern for use with DRPD service. Your telephone company specifies the DRPD Patterns. The patterns provided with your multifunction printer are shown here, with Pattern 1 at the top and Pattern 5 at the bottom:</td>
</tr>
<tr>
<td></td>
<td><img src="wc6505_021" alt="Ring Patterns" /></td>
</tr>
<tr>
<td>2-Sided Print</td>
<td>Turns 2-sided printing on or off.</td>
</tr>
<tr>
<td>Sent Fax Fwd</td>
<td>Specifies the setting for forwarded faxes:</td>
</tr>
<tr>
<td></td>
<td>- Off</td>
</tr>
<tr>
<td></td>
<td>- Forward</td>
</tr>
<tr>
<td></td>
<td>- Print</td>
</tr>
<tr>
<td></td>
<td>- Print and Forward</td>
</tr>
<tr>
<td>Fwd. Settings Num</td>
<td>Specifies the number to which outgoing faxes are forwarded.</td>
</tr>
<tr>
<td>Prefix Dial</td>
<td>Specifies whether to add the prefix number when you send a fax.</td>
</tr>
<tr>
<td>Prefix Dial Num</td>
<td>Specifies the prefix dial number, up to five digits. This number dials before any auto dial number is started.</td>
</tr>
<tr>
<td>Discard Size</td>
<td>Specifies whether the printer discards any excess data at the bottom of the page:</td>
</tr>
<tr>
<td></td>
<td>- Off</td>
</tr>
<tr>
<td></td>
<td>- On</td>
</tr>
<tr>
<td></td>
<td>- Auto Reduction</td>
</tr>
<tr>
<td>ECM (Error Correction Mode)</td>
<td>If ECM is set to On, it attempts to correct errors in the fax transmission caused by problems, such as a noisy telephone line. The default setting is On.</td>
</tr>
</tbody>
</table>
## Control Panel Menus

### USB Setup

Use this menu to configure the USB port.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Status</td>
<td>Enables or disables the USB port.</td>
</tr>
<tr>
<td>Adobe Protocol</td>
<td>Specifies the Adobe protocol:</td>
</tr>
<tr>
<td></td>
<td>- BCP</td>
</tr>
<tr>
<td></td>
<td>- TBCP</td>
</tr>
<tr>
<td></td>
<td>- Binary</td>
</tr>
<tr>
<td></td>
<td>- Auto</td>
</tr>
<tr>
<td></td>
<td>- Standard</td>
</tr>
</tbody>
</table>

### Extel Hook Thresh

Specifies the threshold value for the external telephone:
- Lower
- Normal
- Higher

### Modem Speed

Specifies the fax modem speed:
- 9.6 Kbps
- 14.4 Kbps
- 33.6 Kbps
- 2.4 Kbps
- 4.8 Kbps

### Country

Specifies the country where the printer is used.

### Fax Activity

Turns Auto Print on or off.

### Fax Transmit

Specifies the fax transmit mode:
- Print Always
- Print on Error
- Print Disable

### Fax Broadcast

Specifies the fax broadcast mode:
- Print Always
- Print on Error
- Print Disable

### Fax Protocol

Specifies the fax protocol:
- Print Always
- Print on Error
- Print Disable
## System Setup

Use this menu to configure general operation settings of the printer. For example, time to Energy Saver mode, alarm settings, and so on.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Saver Timer</td>
<td>Specifies the transitional time of Power Saver Modes 1 and 2 in increments of 1 minute.</td>
</tr>
<tr>
<td></td>
<td>• Mode 1 (Printer): 5–60 min. The default setting is 3 minutes.</td>
</tr>
<tr>
<td></td>
<td>• Mode 2 (System): 5–120 min. The default setting is 1 minutes.</td>
</tr>
<tr>
<td></td>
<td>For details, see Energy Saver Mode on page 23.</td>
</tr>
<tr>
<td>Power Saver Wake Up</td>
<td>Turns on or off the Off Hook Wake Up.</td>
</tr>
<tr>
<td>Auto Reset</td>
<td>Specifies the time the printer waits for further control panel input before resetting the Copy, Scan, or Fax settings and returning to standby mode.</td>
</tr>
<tr>
<td></td>
<td>• 45sec</td>
</tr>
<tr>
<td></td>
<td>• 1min</td>
</tr>
<tr>
<td></td>
<td>• 2min</td>
</tr>
<tr>
<td></td>
<td>• 3min</td>
</tr>
<tr>
<td></td>
<td>• 4min</td>
</tr>
<tr>
<td>Fault Time-out</td>
<td>You can cancel a printing process when it goes beyond a set time period. Set the time until the print job is canceled:</td>
</tr>
<tr>
<td></td>
<td>• 3 sec. to 300 sec.: Specifies the amount of time in increments of 1 second the printer waits for additional data before it cancels the job. The default setting is 60 sec.</td>
</tr>
<tr>
<td></td>
<td>• Off: Cannot cancel.</td>
</tr>
<tr>
<td>Time-Out</td>
<td>You can cancel a printing process when it goes beyond a set time period. Set the time until the print job is canceled:</td>
</tr>
<tr>
<td></td>
<td>• 5 sec. to 300 sec.: Specifies the amount of time in increments of 1 second the printer waits for additional data before it cancels the job. The default setting is 30 sec.</td>
</tr>
<tr>
<td></td>
<td>• Off: Cannot cancel.</td>
</tr>
<tr>
<td>Clock Settings</td>
<td>Specifies the date and time, and the format of the settings:</td>
</tr>
<tr>
<td></td>
<td>• Set Date &amp; Time.</td>
</tr>
<tr>
<td></td>
<td>• Date Format: Select yy/mm/dd, mm/dd/yy, or dd/mm/yy.</td>
</tr>
<tr>
<td></td>
<td>• Time Format: Select 12H or 24H format.</td>
</tr>
</tbody>
</table>
### Alert Tone
Specifies whether to turn on the alarm when an error occurs in the printer, and sets the sound volume to Soft, Normal, or Loud:
- **Panel Select Tone**: The default setting is Off.
- **Panel Alert Tone**: The default setting is Off.
- **Machine Ready Tone**: The default setting is Off.
- **Copy Job Tone**: The default setting is Off.
- **Non-Copy Job Tone**: The default setting is Off.
- **Fault Tone**: The default setting is Off.
- **Alert Tone**: The default setting is Off.
- **Out of Paper**: The default setting is Off.
- **Low Toner**: The default setting is Off.
- **Auto Clear Alert**: The default setting is Off.
- **Base Tone**: The default setting is Off.
- **All Tones**: The default setting is Off.

### mm / inch
Set the units for the custom paper size to millimeters or inches.
- millimeter (mm): The paper size is displayed in millimeters. The default setting is mm.
- inch (\*): The paper size is displayed in inches.

### Def. PrintPaper Size
Sets the default paper size to Letter or A4.

### Auto Log Print
Specifies whether to print the Job History Report with information about the printed data that has been processed:
- **Off**: Does not print the Job History Report even if the number of print jobs exceeds 22. The default setting is Off.
- **On**: Automatically prints a Job History Report when the number of print jobs reaches 22.

**Note**: You cannot set Auto Log Print during printing.

You can print the Job History Report from the Information Pages menu. For details, see Information Pages on page 24.

### Print ID
Prints the user ID in a specified position.
- **Off**: User ID is not printed. The default setting is Off.
- **Top Left**: Prints the user ID in the top left of the sheet of paper.
- **Top Right**: Prints the user ID in the top right of the sheet of paper.
- **Bottom Left**: Prints the user ID in the bottom left of the sheet of paper.
- **Bottom Right**: Prints the user ID in the bottom right of the sheet of paper.

### Print Text
Specifies whether the printer outputs PDL data, which is not supported by the printer, as text when the printer receives it. Text data is printed on A4 or Letter size paper.
- **Off**: Does not print the received data. The default setting is Off.
- **On**: Prints the received data as text data.
## Control Panel Menus

### Maintenance

Use this menu to configure color registration and to reset defaults.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size Mismatch</td>
<td>Specifies the size mismatch setting:</td>
</tr>
<tr>
<td></td>
<td>• Off</td>
</tr>
<tr>
<td></td>
<td>• Larger Size</td>
</tr>
<tr>
<td></td>
<td>• Nearest Size</td>
</tr>
<tr>
<td>Startup Page</td>
<td>Turns the startup page on or off.</td>
</tr>
<tr>
<td>Letterhead 2-Sid</td>
<td>Enables or disables the Letterhead 2-Sided mode.</td>
</tr>
<tr>
<td>LowToner AlertMsg</td>
<td>Turns the Low Toner alert message on or off.</td>
</tr>
<tr>
<td>Email From Field</td>
<td>Enables or disables the Email From Field option.</td>
</tr>
<tr>
<td>Server Address Book</td>
<td>Turns the Server Address Book on or off.</td>
</tr>
<tr>
<td>Server Phone Book</td>
<td>Turns the Server Phone Book on or off.</td>
</tr>
<tr>
<td>Power On Wizard</td>
<td>Turns the Power On Wizard on or off.</td>
</tr>
</tbody>
</table>

### Maintenance

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F/W Version</td>
<td>Displays the latest firmware version.</td>
</tr>
<tr>
<td>Auto Regi Adjust</td>
<td>Adjusts the color registration automatically. The default setting is On.</td>
</tr>
<tr>
<td>Adjust ColorRegi</td>
<td>Used to correct the color registration manually. For details, see Color Registration on page 199.</td>
</tr>
<tr>
<td></td>
<td>• Auto Adjust: Correct the color registration.</td>
</tr>
<tr>
<td></td>
<td>• Color Regi Chart: Print the correction chart.</td>
</tr>
<tr>
<td></td>
<td>• Enter Number: Enter the number to correct the registration.</td>
</tr>
<tr>
<td>Initialize NVM</td>
<td>Initializes the settings stored in the NVM except for the network settings. The NVM is a nonvolatile memory that stores the printer settings even after the power is turned off. After executing this function and restarting the printer, all the menu settings are reset to their default values. Note: You cannot execute this setting during printing.</td>
</tr>
<tr>
<td>Init Print Meter</td>
<td>Initializes the print counts.</td>
</tr>
<tr>
<td>Reset Fuser</td>
<td>Resets the count for fuser life to 0.</td>
</tr>
<tr>
<td>Imaging Unit Refresh</td>
<td>Helps improve imaging unit performance by performing a density and color curve calibration.</td>
</tr>
</tbody>
</table>
Secure Settings

Use this menu for controlling access to printer features.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel Lock</td>
<td>When enabled, access to the Admin Menu requires a password. For details, see Changing the Panel Lock Password on page 142.</td>
</tr>
</tbody>
</table>
| Service Lock    | Specifies whether a function is unlocked and available to everyone, locked from everyone, or password locked, requiring a password for access:  
  - Copy  
  - Fax  
  - Scan to Computer  
  - PC Scan  
  - Scan to Email  
  - Scan to Network  
  - Scan to USB Memory  
  - Print from USB  
  Note: Panel Lock must be enabled before setting the service locks. |
| Secure Receive  | Turns Secure Receive Set on or off.                                         |
| Login Error     | When enabled, specifies the number of login attempts to make, from 1 through 10 times. |
Default Settings

The Default Settings menu allows you to set default behaviors for Copy, Scan, Fax, and Print from USB functions.

The Default Settings menu contains the following submenus:
- Copy Defaults on page 161
- Scan Defaults on page 162
- Fax Defaults on page 163
- Print from USB Defaults on page 163

Copy Defaults

Use this menu to set default copying behaviors. For details, see Changing the Default Settings on page 107.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Specifies Black &amp; White or Color copies.</td>
</tr>
<tr>
<td>Paper Supply</td>
<td>Specifies the paper tray that copies are printed from.</td>
</tr>
<tr>
<td>M.F. Paper Size</td>
<td>Specifies the size of the paper in the manual feed slot.</td>
</tr>
<tr>
<td>M.F. Paper Type</td>
<td>Specifies the type of the paper in the manual feed slot.</td>
</tr>
<tr>
<td>Collated</td>
<td>Turns collation on or off.</td>
</tr>
<tr>
<td>Reduce/Enlarge</td>
<td>Reduces or enlarges the copies.</td>
</tr>
<tr>
<td>Document Size</td>
<td>Specifies the size of the original</td>
</tr>
<tr>
<td>Document Type</td>
<td>Specifies the type of the original.</td>
</tr>
<tr>
<td>Lighten/Darken</td>
<td>Lightens or darkens copies.</td>
</tr>
<tr>
<td>Sharpness</td>
<td>Specifies the sharpness of the copies.</td>
</tr>
<tr>
<td>Color Saturation</td>
<td>Deepens or lightens the overall color levels of your copies.</td>
</tr>
<tr>
<td>Auto Exposure</td>
<td>Turns Auto Exposure on and off when copying. Auto Exposure suppresses the document background of off-white colored paper. It also helps suppress show-through when copying 2-sided thin paper.</td>
</tr>
<tr>
<td>Auto Expo. Level</td>
<td>Adjusts the Auto Exposure level.</td>
</tr>
<tr>
<td>Color Balance</td>
<td>Adjusts the color levels of your copies.</td>
</tr>
<tr>
<td>2-Sided</td>
<td>Specifies 2-sided copying options:</td>
</tr>
<tr>
<td></td>
<td>• 1-&gt;1-Sided</td>
</tr>
<tr>
<td></td>
<td>• Long Edge Binding</td>
</tr>
<tr>
<td></td>
<td>• Short Edge Binding</td>
</tr>
</tbody>
</table>
Control Panel Menus

Scan Defaults

Use this menu to set default scanning behaviors. For details, see Adjusting Scanning Options on page 120.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan to Network</td>
<td>Selects the scan destination: Computer (Network) or Server (FTP).</td>
</tr>
<tr>
<td>File Format</td>
<td>Selects the file type of the scanned image.</td>
</tr>
<tr>
<td>Color</td>
<td>Selects the color mode: Color or Black and White.</td>
</tr>
<tr>
<td>Color Button Set</td>
<td>Adjusts the Color Mode settings:</td>
</tr>
<tr>
<td></td>
<td>• B&amp;W button: Black &amp; White or Grayscale.</td>
</tr>
<tr>
<td></td>
<td>• Color Button: Color or Color (Photo)</td>
</tr>
<tr>
<td>Resolution</td>
<td>Selects the scan resolution.</td>
</tr>
<tr>
<td>Document Size</td>
<td>Specifies the size of the original document.</td>
</tr>
<tr>
<td>Lighten/Darken</td>
<td>Lightens or darkens the scanned image.</td>
</tr>
<tr>
<td>Sharpness</td>
<td>Specifies the sharpness of the scanned image.</td>
</tr>
<tr>
<td>Contrast</td>
<td>Specifies the contrast of the scanned image.</td>
</tr>
<tr>
<td>Auto Exposure</td>
<td>Turns Auto Exposure on and off when scanning. Auto Exposure suppresses the document background of off-white colored paper. It also helps suppress show-through when copying 2-sided thin paper.</td>
</tr>
<tr>
<td>Auto Expo. Level</td>
<td>Adjusts the level of the auto exposure functionality.</td>
</tr>
<tr>
<td>Margin Top/Bottom</td>
<td>Turns on and off the copy margins for the top and bottom of the page.</td>
</tr>
<tr>
<td>Margin Left/Right</td>
<td>Turns on and off the copy margins for the left and right of the page.</td>
</tr>
<tr>
<td>Margin Middle</td>
<td>Turns on and off the copy margins for the middle of the page. Use to create a gutter in the middle of the page when you print using the N-up feature.</td>
</tr>
<tr>
<td>TIFF File Format</td>
<td>Sets the TIFF file format: TIFF V6 or TTN2.</td>
</tr>
</tbody>
</table>
Fax Defaults

Use this menu to set default faxing behaviors. For details, see Changing the Default Fax Job Settings on page 139.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>Specifies the resolution of the fax.</td>
</tr>
<tr>
<td>Lighten/Darken</td>
<td>Lightens or darkens the scanned image.</td>
</tr>
<tr>
<td>Delayed Start</td>
<td>Specifies the time delay before sending a fax job, up to 23 hours and 59 minutes.</td>
</tr>
</tbody>
</table>

Print from USB Defaults

Use this menu to set default printing from USB behaviors.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Specifies the color mode: Black &amp; White or Color.</td>
</tr>
<tr>
<td>Paper Supply</td>
<td>Specifies the paper supply to use: Tray 1 or Manual Feed Slot.</td>
</tr>
<tr>
<td>M.F. Paper Size</td>
<td>Specifies the paper size for the manual feed slot.</td>
</tr>
<tr>
<td>M.F. Paper Type</td>
<td>Specifies the paper type for the manual feed slot.</td>
</tr>
<tr>
<td>2-Sided</td>
<td>Specifies 2-sided printing options:</td>
</tr>
<tr>
<td></td>
<td>• 1-&gt;1-Sided</td>
</tr>
<tr>
<td></td>
<td>• Long Edge Binding</td>
</tr>
<tr>
<td></td>
<td>• Short Edge Binding</td>
</tr>
<tr>
<td>Layout</td>
<td>Specifies the layout options:</td>
</tr>
<tr>
<td></td>
<td>• 1Up</td>
</tr>
<tr>
<td></td>
<td>• 2Up</td>
</tr>
<tr>
<td></td>
<td>• 4Up</td>
</tr>
<tr>
<td>PDF Password</td>
<td>Specifies a password to enter to print a PDF file. Use the alphanumeric keypad to enter a password up to 32 characters.</td>
</tr>
</tbody>
</table>

Tray Settings

Use this menu to configure settings for paper trays installed in the printer.
When the size or type of paper that is loaded is different from the setting, print quality can be reduced or paper jams can occur. Specify the correct paper type and size.

When the paper size and type settings for the trays are the same, printing is uninterrupted when the paper runs out in the specified tray. Printing continues by changing to the other tray when it is installed.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Size</td>
<td>Specifies the paper size and orientation for each tray.</td>
</tr>
<tr>
<td></td>
<td>• Manual Feed Slot</td>
</tr>
<tr>
<td></td>
<td>• Paper Tray. The default setting is Auto.</td>
</tr>
<tr>
<td></td>
<td>For details, see <a href="#">Supported Paper on page 58</a> and <a href="#">Setting Paper Types and Sizes on page 68</a>.</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Specifies the type of paper loaded in each tray.</td>
</tr>
<tr>
<td></td>
<td>• Manual Feed Slot. The default setting is Thin Card Stock.</td>
</tr>
<tr>
<td></td>
<td>• Paper Tray. The default setting is Plain.</td>
</tr>
<tr>
<td></td>
<td>For details, see <a href="#">Supported Paper on page 58</a> and <a href="#">Setting Paper Types and Sizes on page 68</a>.</td>
</tr>
<tr>
<td>Display Popup</td>
<td>Specifies whether to display the message that prompts you to set the paper size and type every time you load paper in the tray. The default setting is Off.</td>
</tr>
</tbody>
</table>
Maintenance

This chapter includes:

• Cleaning the Printer on page 166
• Ordering Supplies on page 169
• Managing the Printer on page 171
• Checking Page Counts on page 176
• Moving the Printer on page 178
Cleaning the Printer

This section includes:

- **General Precautions** on page 166
- **Cleaning the Document Glass** on page 167
- **Cleaning the Exterior** on page 167
- **Cleaning the Interior** on page 168

**General Precautions**

⚠️ **WARNING:** When cleaning your printer do not use organic or strong chemical solvents or aerosol cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only as directed in this documentation. Keep all cleaning materials out of the reach of children.

⚠️ **WARNING:** Internal parts of the printer can be hot, especially the fuser. Use caution when doors and covers are open.

⚠️ **WARNING:** Do not use pressurized air-spray cleaning aids on or in the printer. Some pressurized air-spray containers contain explosive mixtures and are not suitable for use in electrical applications. Use of such cleaners can result in a risk of explosion and fire.

⚠️ **WARNING:** Do not remove the covers or guards that are fastened with screws. You cannot maintain or service any parts that are behind these covers and guards. Do not attempt any maintenance procedure that is not described in the documentation supplied with your printer.

To avoid damaging the printer, follow these guidelines:

- Do not place anything on top of the printer.
- Do not leave the covers and doors open for any length of time, especially in well-lit places. Light exposure can damage the imaging units.
- Do not open covers and doors during printing.
- Do not tilt the printer while in use.
- Do not touch the electrical contacts, gears, or laser devices. Doing so could damage the printer and cause the print quality to deteriorate.
- Make sure any parts removed during cleaning are reinstalled before you plug in the printer.
Cleaning the Document Glass

Clean the document glass with a moistened lint-free cloth only. Do not use any cleaning agent to clean the glass. Wipe the glass in one direction to move any debris to the edge of the glass.

1. Automatic document feeder (ADF) paper path
2. ADF cover
3. Flatbed document glass
4. ADF glass

Cleaning the Exterior

Clean the exterior of the printer about once a month. Wipe the parts with a damp, soft cloth. Then wipe with another dry, soft cloth. For stubborn stains, apply a small amount of neutral detergent to the cloth and gently wipe the stain off.

⚠️ **CAUTION:** Do not spray the detergent directly on the printer. The liquid detergent could enter the printer through a gap and cause problems. Never use cleaning agents other than water or neutral detergent.
Cleaning the Interior

After clearing paper jams or replacing one of the toner cartridges, inspect the inside of the printer before closing the printer covers.

Remove any remaining pieces of paper. For more information, see Clearing Paper Jams on page 205.

Remove any dust or stains with a dry, clean cloth.

⚠️ **WARNING:** Never touch a labeled area found on or near the heat roller in the fuser. You can get burned. If a sheet of paper is wrapped around the heat roller, do not try to remove it immediately to avoid injuries or burns. Switch off the printer immediately and wait 40 minutes for the fuser to cool.

1. Fuser
2. Transfer belt unit
Ordering Supplies

This section includes:

- **Consumables** on page 169
- **Routine Maintenance Items** on page 169
- **When to Order Supplies** on page 169
- **Recycling Supplies** on page 170

**Consumables**

Consumables are printer supplies that get depleted during the operation of the printer. Consumable supplies for this printer are the genuine Xerox® Toner Cartridges (Cyan, Magenta, Yellow, and Black).

**Notes:**

- Each toner cartridge includes installation instructions.
- Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner remaining amount displayed could be inaccurate.
- To enhance print quality, the toner cartridges have been designed to cease functioning at a predetermined point.

⚠️ **CAUTION:** Use of toner other than genuine Xerox® Toner can affect print quality and printer reliability. Xerox® Toner is the only toner designed and manufactured under strict quality controls by Xerox® for specific use with this printer.

**Routine Maintenance Items**

Routine maintenance items are printer parts that have a limited life and require periodic replacement. Replacements can be parts or kits. Routine maintenance items are typically customer replaceable. Routine maintenance items for this printer include the following:

- Fuser
- Feed Roller Kit
- Imaging Unit

**Note:** Although the transfer belt unit is not considered a routine maintenance item, if it becomes damaged, you can order another one. You can also order a duplex unit.

To order routine maintenance items, contact your local Xerox® authorized service provider, contact your local Xerox® customer service representative, or go to the Xerox® Supplies website at www.xerox.com/office/WC6505supplies. You can also call the Xerox® Direct Store at 1-866-495-6286.

**When to Order Supplies**

The printer control panel displays a warning when a supply nears its replacement time. Verify that you have replacements on hand. It is important to order these supplies when the messages first appear to
Maintenance

avoid interruptions to your printing. The control panel displays an error message when the supply must be replaced.

To order supplies, contact your local reseller or go to the Xerox® Supplies website at www.xerox.com/office/WC6505supplies.

⚠️ CAUTION: Use of non-Xerox® supplies is not recommended. The Xerox® Warranty, Service Agreements, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused by use of non-Xerox® supplies. They also do not cover damage or degradation of performance caused by the use of Xerox® supplies not specified for this printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage can vary outside these areas. Please contact your local representative for details.

Recycling Supplies

For information on recycling supplies, go to www.xerox.com/gwa.

See also:

Recycling and Disposal on page 229
Managing the Printer

This section includes:

- Managing the Printer with CentreWare Internet Services on page 171
- Checking Printer Status with PrintingScout on page 172
- Checking Printer Status using Email on page 173

Managing the Printer with CentreWare Internet Services

This section includes:

- Accessing CentreWare Internet Services on page 171
- Checking the Status of the Printer on page 171
- Checking Print Job Status on page 171
- Using Online Help on page 172

CentreWare Internet Services is the administration and configuration software installed on the embedded Web server in the printer. For details, see CentreWare Internet Services on page 25.

Accessing CentreWare Internet Services

At your computer, open a Web browser, type the IP address of the printer into the address field, then press Enter or Return.

Checking the Status of the Printer

1. In CentreWare Internet Services, click the Status button or Status tab.
   The general status of the printer includes:
   - The type, size, and amount, empty or full, of paper in each tray.
   - The ready-for-printing status of the printer.
   - The frequency with which the printer status information is refreshed.
   - The total page count of printed pages.

2. To check the supplies status of the printer, on the Status tab, click the Supplies button.
   The supplies status of the printer includes:
   - The amount remaining in each toner cartridge.
   - The percentage remaining of the life of the imaging unit.

Checking Print Job Status

CentreWare Internet Services keeps a log of current print jobs, including job names, the users who submitted them, the job status, and more. You can also get a list of all print jobs.

1. To view the status of print jobs from the main menu in CentreWare Internet Services, click the Jobs button or tab.
Maintenance

2. To view a job history list in the Jobs tab, expand the History List folder in the navigation pane on the left of the page. Click to open the Job History.

Using Online Help

For details about settings in CentreWare Internet Services, click the Help button. For other support information, click the Support button or tab.

Checking Printer Status with PrintingScout

Note: PrintingScout is a Windows-only application.

The PrintingScout utility automatically checks the printer status when you send a print job. PrintingScout can check the paper sizes of the trays, the status of the output tray, and the remaining consumables percentages, such as toner.

To open PrintingScout, do one of the following:

- In the Windows taskbar, double-click the PrintingScout icon.
- From the Start menu, select Programs > Xerox® Office Printing > PrintingScout > Activate PrintingScout.

The status of the printer is displayed in the General Status window that opens.

For information on using PrintingScout, see the PrintingScout help. To see Help in the Windows taskbar, right-click the PrintingScout icon and select Help.

See also:

Installing PrintingScout on page 44
Checking Printer Status using Email

This section includes:

- Configuring Email Alerts on page 173
- Using Commands in Email Text on page 174

If you are connected to the printer through the network, you can configure the printer to email you reports about the printer. Reports include:

- The network settings of the printer.
- The printer status.
- The errors that occur on the printer.

Configuring Email Alerts

In CentreWare Internet Services, configure the following settings according to your email environment. After configuring the settings on each page, always click Save Changes. For details, see the Help in CentreWare Internet Services.

1. Launch your Web browser and type the IP address of your printer in the browser address field.
2. In the CentreWare Internet Services page that appears, click Properties.
3. In the navigation pane on the left side of the page, click the Mail Alerts link.
4. In the Mail Alerts page, select the Enable Mail Alerts check box if it is not already selected.
5. In the SysAdmin Mail Address field, type your email address or the address to which you want email alerts sent.
6. In the Notification Items section, select the events for which you would like to be notified.
7. In the Connection Setup box, click the Email Settings link.
   The Email Settings page opens.
8. In the Email Server Setup (Required to send Email) section, do the following:
   a. In the Return Email Address field, type the return address used by the email server.
   b. In the SMTP Server (IP Address or DNS Name) field, type the outgoing IP address used by your SMTP server for sending email.
   Note: If you are unsure of the address or DNS name, contact your Internet Service Provider (ISP) for the correct address information.
   c. In the SMTP Port field, type the number of the port used. The default is 25.
9. In the Email Send Authentication section, do one of the following:
   - If no authentication is necessary, select No Authentication in the Authentication Type field.
   - If authentication is required, complete the fields as needed.
10. In the Email Server Setup (Required to receive Email) section, enter the appropriate information in the fields as needed.
    Note: The Email Alert function is used only for remote status monitoring. The printer does not print email saved to the printer.
11. In the Email Filter (Filters Email received by the device) section, enter the email addresses of the users who are permitted to send email to the printer. If no address is specified here, the printer can receive email from all users.
12. In the **Email Password** (**Password for remote status**) section, enter a password in the **Password** field, then enter it in the **Re-enter Password** field. This password controls access to the printer read only and read/write email functions.

13. Click the **Save Changes** button.

14. In the navigation pane on the left side of the page, click **Port Enabling** and then select the check boxes for the ports to enable. Be sure to enable at least the **Enable Mail Alerts** port.

15. Click the **Save Changes** button.

**Using Commands in Email Text**

**Notes:**
- You can specify any title for the email when checking the printer status or changing the printer settings.
- Use the commands described in the next section to create the text of the email.

Use each command according to the following rules.
- Prefix all commands with the pound sign (#), and specify the **#Password** command at the top of the email.
- Command lines without the pound sign (#) are ignored.
- Type one command on each line and separate each command and parameter with a space or a tab.

When the same command is written two or more times in one email, the second and subsequent commands are ignored.

<table>
<thead>
<tr>
<th>Command</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#Password</td>
<td>Password</td>
<td>Use this command at the top of the email when a password for read only or full access is set. You can omit this command when the password is not set.</td>
</tr>
<tr>
<td>#NetworkInfo</td>
<td></td>
<td>Use this command to check information on the network settings list.</td>
</tr>
<tr>
<td>#Status</td>
<td></td>
<td>Use this command to check the printer status.</td>
</tr>
<tr>
<td>#SetMsgAddr</td>
<td>Recipient email address</td>
<td>Use this command to specify the email address to which email reports are sent to. This command can only be used when the password in the #Password command specifies full access.</td>
</tr>
</tbody>
</table>

**Examples of Commands**
- To check the printer status when the read-only password is *ronly*, for read only, use:
  
  ```
  #Password ronly
  #Status
  ```
• To set the recipient email address to service@xerox.com when the full access password is admin, use:

```
#Password admin
#SetMsgAddr service@xerox.com
```

• To set the recipient email address to service@xerox.com, and confirm the setting result on the network settings list when the full access password is admin, use:

```
#Password admin
#SetMsgAddr service@xerox.com
#NetworkInfo
```

**Note:** Type the #SetMsgAddr command before the #NetworkInfo command. If they are written in reverse, the information retrieved by the #NetworkInfo command and the result of executing the #SetMsgAddr command can differ.
Checking Page Counts

This section includes:

- Viewing the Billing Meter on page 176
- Printing the Print Volume Report on page 176

You can check the total number of printed pages at the printer control panel, on the Configuration Page, and in CentreWare Internet Services. Three meters are available: Total Impressions, Color Impressions, and Black Impressions. The billing meter counts the number of pages printed properly. 1-side prints, including N-up, are counted as one impression, and 2-sided prints, including N-up, are counted as two. During 2-sided printing, if an error occurs after one side prints properly, it is counted as one.

Color documents converted using an ICC profile on applications with the Color (Auto) setting can print in color, even if displayed in black and white. The data prints in color even if it seems to be black and white data on the monitor. In that case, the number of Color Impressions is increased.

**Note:** Grayscale images printed with the composite black setting count as color pages because color consumables are used. Composite black is the default setting on most printers.

When doing automatic 2-sided printing, you can insert a blank page automatically depending on the settings in the application. In this case, the blank page is counted as one page.

**Viewing the Billing Meter**

The billing meter tracks the total number of pages printed for the life of the printer. It cannot be reset.

To check the total number of pages printed:
1. On the control panel, press the **System** button.
2. Press the **Up Arrow** or **Down Arrow** button to select **Billing Meters**, then press the **OK** button.
3. Press the **Up Arrow** or **Down Arrow** button to select the desired meter.
   - The number of printed pages is displayed below the name.
4. After checking, press the **System** button to exit the Billing Meters menu.

**Printing the Print Volume Report**

The print meter tracks print job accounting information. The information is available in the Print Volume report. The report shows the information organized by user name and the quantity of pages of each size printed in color and in black and white.

To print the print meter information page:
1. On the control panel, press the **System** button.
2. At **Information Pages**, press the **OK** button.
3. Press the **Up Arrow** or **Down Arrow** button to select **Print Meter**, then press **OK**.
4. Press **OK**.
   - The Print Volume Report prints.
See also:

- Information Pages on page 24
- Managing the Printer with CentreWare Internet Services on page 171
Moving the Printer

Follow these procedures when moving the printer.

The printer, with Tray 1 and supplies but without the optional duplex unit or 250-sheet feeder, weighs 28.8 Kg (63.5 lb.). Configured with the optional duplex unit and 250-sheet feeder, the printer weighs 34.5 Kg (76.1 lb.).

Before moving the printer, do the following:

1. Turn off the printer and disconnect the power cord and other cables from the back of the printer.

   ! **WARNING:** To prevent electric shock, never touch the power plug with wet hands. When removing the power cord, make sure that you pull the plug and not the cord. Pulling the cord can damage it, which can lead to fire or electrical shock.

2. Wait for the printer to cool down, about 40 minutes.

3. Remove any paper or other media from the output tray and return the paper stopper to its original, non-extended position.

4. Remove Tray 1 and set it aside.

   **Note:** If you are moving the printer a long distance, remove the toner cartridges to prevent toner from spilling. To prevent damage to the printer, pack the printer and toner inside separate boxes.

5. If your printer configuration includes the 250-sheet feeder, remove it and its lower feeder unit by lifting the printer off it.

   ! **WARNING:** If the optional 250-sheet feeder is installed, uninstall it before moving the printer. If the feeder is not fixed securely to the printer, it could fall and cause injuries. For details on how to uninstall the options, refer to the instruction sheet that is bundled with each option.

   ! **WARNING:** To avoid injury, use two people to lift the printer off the lower feeder unit.
When moving the printer:

- Always use two people to lift and move the printer.
- When lifting the printer, grasp the areas as shown in the illustration.

**Note:** Configured with the optional duplex unit and 250-sheet feeder, the printer weighs 34.5 Kg (76 lb.). Do not move them together. Move the Tray 2 assembly and the printer separately.

- Do not tilt the printer more than 10 degrees to the front or back, or left or right. Tilting the printer more than 10 degrees can cause toner spillage.

**CAUTION:** Failure to repack the printer properly can result in damage to the printer not covered by the Warranty, Service Agreement, or Total Satisfaction Guarantee.

After moving the printer:

1. Reinstall any parts you removed. If you removed the 250-sheet feeder, put the printer back on top of it.
2. Reconnect the printer to the cables and power cord.
3. Plug in and turn on the printer.
4. Adjust the color registration before using the printer. For details, see Color Registration on page 199.
Troubleshooting

This chapter includes:

- Troubleshooting Overview on page 182
- Control Panel Messages on page 184
- Problems with the Printer on page 188
- Print-Quality Problems on page 191
- Cleaning the Imaging Unit and Laser Lens on page 196
- Color Registration on page 199
- Color Balance on page 203
- Paper Jams on page 204
Troubleshooting Overview

This section includes:
- Error and Status Messages on page 182
- PrintingScout Alerts on page 182
- Online Support Assistant on page 182
- Information Pages on page 182
- More Information on page 183

Your printer comes with a number of utilities and resources to help you troubleshoot printing problems.

Error and Status Messages

The printer control panel provides you with information and troubleshooting help. When an error or warning condition occurs, the control panel displays a message informing you of the problem.

For details, see Control Panel Messages on page 184.

PrintingScout Alerts

The PrintingScout utility automatically checks the printer status when you send a print job. If the printer is unable to print, PrintingScout displays an alert on your computer screen to let you know that the printer needs attention. Install PrintingScout from the Software and Documentation disc that came in the documentation packet with your printer. For details, see Installing PrintingScout on page 44.

Note: PrintingScout is a Windows-only application.

Online Support Assistant

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to solve your printer problems. You can find solutions for print-quality problems, paper jams, software installation, and more.

To access the Online Support Assistant, go to www.xerox.com/office/WC6505support.

Information Pages

Two information pages in the printer, the Demo Page and the Error History report, can help with troubleshooting certain problems. The Demo Page prints an image using all printer colors to show the current ability of the printer to print. The Error History report prints information on up to the last 42 printer errors that occurred.

To print information pages:
1. On the control panel, press the System button.
2. At Information Pages, press the Forward Arrow button.
3. Press the **Up Arrow** or **Down Arrow** button to select the desired page, then press **OK**.

**More Information**

You can obtain more information about your printer from these sources:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technical support information for your printer. Includes online Technical Support, Recommended Media List, Online Support Assistant, driver downloads, documentation, video tutorials, and more.</td>
<td><a href="http://www.xerox.com/office/WC6505support">www.xerox.com/office/WC6505support</a></td>
</tr>
<tr>
<td>Supplies for your printer</td>
<td><a href="http://www.xerox.com/office/WC6505supplies">www.xerox.com/office/WC6505supplies</a></td>
</tr>
<tr>
<td>A resource for tools and information such as interactive tutorials, printing templates, helpful tips, and customized features to meet your individual needs.</td>
<td><a href="http://www.xerox.com/office/businessresourcecenter">www.xerox.com/office/businessresourcecenter</a></td>
</tr>
<tr>
<td>Contacts</td>
<td><a href="http://www.xerox.com/office/worldcontacts">www.xerox.com/office/worldcontacts</a></td>
</tr>
<tr>
<td>Printer registration</td>
<td><a href="http://www.xerox.com/office/register">www.xerox.com/office/register</a></td>
</tr>
</tbody>
</table>
| Material Safety Data Sheets identify materials and provide information on safely handling and storing hazardous materials. | [www.xerox.com/environment_europe](http://www.xerox.com/environment_europe) (European Union)  
[www.xerox.com/msds](http://www.xerox.com/msds) (U.S. and Canada) |
| Information about recycling supplies.                                   | [www.xerox.com/gwa](http://www.xerox.com/gwa) |
Control Panel Messages

This section includes:

- Supply Status Messages on page 184
- Error Messages on page 185

The printer uses control panel messages to indicate printer status, errors, and to provide instructions.

Supply Status Messages

Status messages tell you about the status of the printer and its supplies.

Note: Xxx indicates one of the following: the Yellow Toner (Y), Cyan Toner (C), Magenta Toner (M), Black Toner (K), a tray, or fuser. NNN indicates a numeric value.

<table>
<thead>
<tr>
<th>Code/Message</th>
<th>Condition/Reason/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace Fuser 010-351</td>
<td>Time to replace the fuser. Replace the old fuser with a new one and then restart the printer.</td>
</tr>
<tr>
<td>Insert Fuser 010-317</td>
<td>The fuser is not installed or it is incorrectly installed. Install the fuser and then restart the printer.</td>
</tr>
<tr>
<td>Replace Imaging Unit</td>
<td>It is time to replace the imaging unit. Replace the imaging unit. For details, see the Imaging Unit instruction sheet that came in the documentation packet with your printer.</td>
</tr>
<tr>
<td>Insert Imaging Unit</td>
<td>The imaging unit is not installed. Install the imaging unit. For details, see the Imaging Unit instruction sheet that came in the documentation packet with your printer.</td>
</tr>
<tr>
<td>Insert Xxx Cartridge</td>
<td>The Xxx toner cartridge is not installed correctly or is not installed. Install the toner cartridge.</td>
</tr>
<tr>
<td>Replace Xxx Cartridge</td>
<td>The toner cartridge is empty. Replace the old toner cartridge with a new one.</td>
</tr>
<tr>
<td>Invalid Xxx</td>
<td>The wrong toner cartridge is installed or the toner cartridge is not seated correctly. Reseat the toner cartridge or replace the cartridge with one that meets specifications for your printer. The region of your printer is listed on the Configuration Page in the General section. For details on printing the Configuration Page, see Configuration Page on page 24.</td>
</tr>
<tr>
<td>Non-Xerox® Toner</td>
<td>The printer is in the custom toner mode. This message means a non-Xerox® toner is installed. You could experience a decrease in print quality as a result.</td>
</tr>
<tr>
<td>Low Density Xxx Cartridge</td>
<td>Toner is not distributed evenly in the specified cartridge. Remove and shake the cartridge, then reinstall it.</td>
</tr>
</tbody>
</table>
## Error Messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Condition/Reason/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fuser Error Error 010-397</td>
<td>Check that the fuser is seated correctly, then restart the printer.</td>
</tr>
<tr>
<td>Check Unit Imaging Unit</td>
<td>Sealing tape is still attached to the imaging unit. Remove the tape.</td>
</tr>
<tr>
<td>Over Heat Please Wait Error 042-700 Please Wait</td>
<td>The internal temperature of the printer is too high. The printer has stopped. Wait one hour before restarting the printer. Ensure that the printer has adequate cooling space around it, and that the cooling vents are not blocked.</td>
</tr>
<tr>
<td>Jam at Tray 1 Check Tray 1 Open Front Cover</td>
<td>Paper is jammed inside the paper tray. Remove the jammed paper, then open and close the front cover. For details, see Clearing Jams at Tray 1 on page 205.</td>
</tr>
<tr>
<td>Jam at Tray 2 Check Tray 2 Open Front Cover</td>
<td>Paper is jammed inside the paper tray. Open Tray 2 and remove the jammed paper. Open and close the front cover. For details, see Clearing Jams at the 250-Sheet Feeder on page 207.</td>
</tr>
<tr>
<td>Chk Manual Feed Remove Paper Open and close Front Cover</td>
<td>There is a jam at the manual feed slot. Remove the paper, then open and close the front cover. For details, see Clearing Jams at the Manual Feed Slot on page 206.</td>
</tr>
<tr>
<td>Remove paper from Manual Feed</td>
<td>Remove the paper at the manual feed slot.</td>
</tr>
<tr>
<td>Jam at Front Cover Open Front Cover and Remove Paper</td>
<td>Paper is jammed inside the printer. Press the button to open the front cover, then remove the jammed paper.</td>
</tr>
<tr>
<td>Jam at Duplexer Open Front Cover Lift Transfer Unit</td>
<td>There is a paper misfeed at the duplex unit. Press the button to open the front cover, then remove the jammed paper. For details, see Clearing Jams at the Duplex Unit on page 208.</td>
</tr>
<tr>
<td>Message</td>
<td>Condition/Reason/Solution</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Jam at Exit</td>
<td>Paper is jammed inside the printer.</td>
</tr>
<tr>
<td>Open Front Cover and Remove Paper</td>
<td>Open the front cover and remove the paper.</td>
</tr>
<tr>
<td>Jam at Reg. Roll</td>
<td>There is a paper misfeed at the registration roller that helps align the paper in the printer path. Open the front cover and remove the paper.</td>
</tr>
<tr>
<td>Open Front Cover</td>
<td></td>
</tr>
<tr>
<td>Reseat Paper of Manual Feed</td>
<td>Remove, then reseat the paper in the manual feed slot.</td>
</tr>
<tr>
<td>Load Manual Feed</td>
<td>Load the correct-size paper in the manual feed slot.</td>
</tr>
<tr>
<td>Load Tray Xxx</td>
<td>The printer has detected a paper size mismatch or no suitable paper is loaded in any of the trays. Open the specified tray, remove the paper, insert paper of the correct size, then close the tray.</td>
</tr>
<tr>
<td>Insert Output to Tray Xxx</td>
<td>Waiting for side 2 to be set for manual 2-sided printing. Insert paper from output tray into the specified tray for printing on the second side.</td>
</tr>
<tr>
<td>Side Door Open</td>
<td>The side door to the toner is open. Close the side door.</td>
</tr>
<tr>
<td>Close Side Door</td>
<td></td>
</tr>
<tr>
<td>Front Cover Open</td>
<td>The front cover is open.</td>
</tr>
<tr>
<td>Close Front Cover</td>
<td>Close the front cover.</td>
</tr>
<tr>
<td>Invalid Job</td>
<td>The printer configuration on the print driver does not conform to the printer you are using.</td>
</tr>
<tr>
<td>Press OK Button</td>
<td>Press the Cancel button to cancel the print job.</td>
</tr>
<tr>
<td>Error 016-799</td>
<td>Make sure that the configuration of the printer on the print driver conforms to the printer you are using.</td>
</tr>
<tr>
<td>Out of Memory</td>
<td>The printer memory is full and cannot continue processing the current print job.</td>
</tr>
<tr>
<td>Press OK Button</td>
<td>Press the OK button to clear the message, cancel the current print job, and conduct the next print job, if any.</td>
</tr>
<tr>
<td>Error 016-718</td>
<td>Press the Cancel button to cancel the print job.</td>
</tr>
<tr>
<td></td>
<td>Press the Back Arrow button to open the Walk-Up Features menu and delete the job being held.</td>
</tr>
<tr>
<td></td>
<td>If the problem is not corrected, turn off the printer, then turn it on again.</td>
</tr>
<tr>
<td></td>
<td>To avoid this error in the future, do the following:</td>
</tr>
<tr>
<td></td>
<td>• Delete unnecessary fonts, macros, and other data in printer memory.</td>
</tr>
<tr>
<td></td>
<td>• Install additional printer memory.</td>
</tr>
<tr>
<td>Collate Full</td>
<td>The memory for the collate function is full.</td>
</tr>
<tr>
<td>Press OK Button</td>
<td>Press OK, then turn off the printer, then turn it on to clear any pending jobs.</td>
</tr>
<tr>
<td>Error 116-721</td>
<td>Also check the print queue to make sure that the jobs are deleted. Try sending the job again. If you still get the error message, repeat the process of clearing the print queue, then send the print job in smaller batches. If clearing the queue and sending smaller print jobs does not work, contact technical support.</td>
</tr>
<tr>
<td>Message</td>
<td>Condition/Reason/Solution</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PDL Error</td>
<td>An error relating to PCL emulation has occurred.</td>
</tr>
<tr>
<td>Press OK Button</td>
<td>Press the <strong>OK</strong> button to clear the message, cancel the current print job, and conduct the next print job, if any.</td>
</tr>
<tr>
<td>Error 016-720</td>
<td>Press the <strong>Cancel</strong> button to cancel the print job.</td>
</tr>
</tbody>
</table>
Problems with the Printer

If you encounter a problem with your printer, use the following table to troubleshoot and fix the problem. For additional troubleshooting information, see Troubleshooting Overview on page 182.

⚠️ **WARNING:** Never open or remove printer covers that are secured with screws unless instructed in the manual. A high-voltage component can cause electric shock. Do not try to alter the printer configuration or modify any parts. An unauthorized modification can cause smoke or fire.

⚠️ **CAUTION:** Probable causes of trouble are that the printer, computer, server, or other hardware is not correctly set for the network environment you are using.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Reason/Solution</th>
</tr>
</thead>
</table>
| No power.             | Is the power to the printer turned off?  
Press the power button to the **On** position to turn on the power.  
Is the power cord disconnected or not securely connected?  
Turn off the power to the printer, then connect the power cord to the power outlet again. Turn on the power to the printer.  
Is the power cord connected to a power outlet with the correct voltage?  
Connect the printer exclusively to a power outlet with a suitable voltage and current rating. For details, see Electrical Specifications on page 214.  
Is the printer connected to an uninterruptible power supply?  
Turn off the power to the printer, then connect the power cord to a suitable power outlet.  
Is the printer connected to a power strip shared with other high-power devices?  
Connect the printer to a power strip that is not shared with other high-power devices. |
| Cannot print.         | Is the Ready indicator turned off?  
The printer is in Energy Saver mode or in the menu setting mode. For details, see Control Panel on page 20.  
Is there a message displayed on the control panel?  
Read the message and follow the instructions to correct the problem. For details, see Control Panel Messages on page 184. |
<table>
<thead>
<tr>
<th>Symptom</th>
<th>Reason/Solution</th>
</tr>
</thead>
</table>
| Print job sent but the light of the Ready indicator is not blinking or on. | Is the Ethernet or USB interface cable disconnected?  
Turn off the power and check the connection of the interface cable. |
|                                                                        | Is the protocol configured?  
Check the port status of the interface. Make sure that the protocol settings are correctly configured in CentreWare Internet Services. For details, access Help in CentreWare Internet Services. |
|                                                                        | Is the computer environment set up correctly?  
Check the computer environment, such as the print driver. For details, see Installation and Setup on page 27. |
| Error indicator is on.                                                  | Is there an error message displayed on the control panel?  
Check the displayed message and correct the error. For details, see Control Panel Messages on page 184. |
| Error indicator is blinking.                                           | An error has occurred that you cannot correct by yourself.  
Record the displayed error message or error code, turn off the power, and disconnect the power plug from the outlet. Refer to the Xerox® Support website at www.xerox.com/office/WC6505support. |
| Light of the Ready indicator is on and blinking but there is no print output. | There are jobs remaining in the printer.  
Cancel printing or force the remaining data to be printed.  
To force the print job, press the OK button. To cancel the job, press the Cancel button. |
| Top section of printed document is missing. The top and side margins are incorrect. | Are the paper tray guides in the correct positions?  
Set the length guide and the width guides to the correct positions. For details, see Loading Paper on page 61.  
Check that the paper size on the print driver or the control panel is correctly set. For details, see Setting Paper Types and Sizes on page 68.  
For details, see the online help for the print driver.  
Check that the margin setting is correct on the print driver. (PCL only).  
For details, see the online help for the print driver. |
| Condensation has occurred inside the printer.                         | Turn on the printer and leave it on for at least one hour to get rid of the condensation. If the problem continues, refer to the Xerox® Support website at www.xerox.com/office/WC6505support. |
## Troubleshooting

### Symptom

<table>
<thead>
<tr>
<th>Paper cannot be fed. Paper jams. Multiple sheets are fed. Paper is fed at an angle. Paper is wrinkled.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Reason/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is the paper correctly loaded? Load the paper correctly. For labels or envelopes, fan them well to allow air to enter between each sheet before loading. For details, see Loading Paper on page 61.</td>
</tr>
<tr>
<td>The paper used is not suitable. Load the correct type of paper. For details, see Supported Paper and Media on page 56.</td>
</tr>
<tr>
<td>Is the paper tray set correctly? Push the paper tray completely into the printer.</td>
</tr>
<tr>
<td>Is the printer placed on a flat location? Place the printer on a stable, flat surface.</td>
</tr>
<tr>
<td>Are the paper tray guides set in the correct positions? Set the guides to the correct positions. For details, see Loading Paper on page 61.</td>
</tr>
<tr>
<td>Paper is fed more than 1 sheet at a time. Multiple feeding of paper can occur before the sheets of paper loaded in the tray are used up. Remove the paper, fan it, and load again. Replenish paper only when all the sheets of the loaded paper are used up.</td>
</tr>
</tbody>
</table>

### Unusual noises.

<table>
<thead>
<tr>
<th>Reason/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer is not level. Reposition the printer on a flat, stable surface.</td>
</tr>
<tr>
<td>The paper tray is not inserted properly. Push the paper tray completely into the printer.</td>
</tr>
<tr>
<td>There is a foreign object inside the printer. Turn off the printer and remove the foreign object. Refer to the Xerox® Support website at <a href="http://www.xerox.com/office/WC6505support">www.xerox.com/office/WC6505support</a>.</td>
</tr>
</tbody>
</table>
Print-Quality Problems

When the print quality is poor, select the closest symptom from the following table and see the corresponding solution to correct the problem. You can also print a demo page to more precisely determine the print-quality problem. For details, see Information Pages on page 182.

If the print quality does not improve after carrying out the appropriate action, contact Xerox® Customer Support or your reseller.

Notes:
- To enhance print quality, toner cartridges for many models of equipment have been designed to cease functioning at a predetermined point.
- Grayscale images printed with the composite black setting count as color pages, because color consumables are used. Composite black is the default setting on most printers.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Faded printouts with multiple colors</td>
<td>The toner cartridges are not Xerox® toner</td>
<td>Verify that the toner cartridges (CMYK) meet specifications, and replace them if necessary.</td>
</tr>
<tr>
<td>faded.</td>
<td>cartridges.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The paper being used is outside the recommended</td>
<td>Replace the paper with a recommended size and type, and confirm that your control panel and print driver settings are correct. For details, see Supported Paper and Media on page 56.</td>
</tr>
<tr>
<td></td>
<td>specification range.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The paper is damp.</td>
<td>Replace the paper.</td>
</tr>
<tr>
<td></td>
<td>The transfer belt unit is old or damaged.</td>
<td>Replace the transfer belt unit.</td>
</tr>
<tr>
<td></td>
<td>The high-voltage supply is defective.</td>
<td>For assistance, see the Xerox® Support website at: <a href="http://www.xerox.com/office/WC6505support">www.xerox.com/office/WC6505support</a></td>
</tr>
<tr>
<td>Only one color is faded.</td>
<td>Toner cartridge is empty or damaged.</td>
<td>Check the condition of the toner cartridge and replace it if necessary.</td>
</tr>
</tbody>
</table>
### Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stray black dots or white areas (dropouts).</td>
<td>The paper is outside the recommended specification range.</td>
<td>Replace the paper with a recommended size and type, and confirm that your control panel and print driver settings are correct. For details, see Supported Paper and Media on page 56.</td>
</tr>
<tr>
<td></td>
<td>The transfer belt unit is old or damaged.</td>
<td>Replace the transfer belt unit.</td>
</tr>
<tr>
<td></td>
<td>The toner cartridges are not Xerox® toner cartridges.</td>
<td>Verify that the toner cartridges meet specifications and replace them if necessary. For details, see Consumables on page 169.</td>
</tr>
<tr>
<td>• Vertical black or color streaks or multiple colored streaks or lines.</td>
<td>The transfer belt unit is old or damaged.</td>
<td>Replace the transfer belt unit.</td>
</tr>
<tr>
<td>• Streaks in only one color.</td>
<td>The toner cartridges are not Xerox® toner cartridges.</td>
<td>Verify that the toner cartridges meet specifications and replace them if necessary. For details, see Consumables on page 169.</td>
</tr>
<tr>
<td></td>
<td>There is a problem with the toner cartridge for that color.</td>
<td>Check the toner cartridge for damage and replace if necessary.</td>
</tr>
<tr>
<td>Recurring smudges.</td>
<td>Dirt in the paper path.</td>
<td>Print several blank sheets until the smudges disappear.</td>
</tr>
<tr>
<td></td>
<td>The paper is outside the recommended specification range.</td>
<td>Replace the paper with a recommended size and type, and confirm that your control panel settings are correct. For details, see Supported Paper and Media on page 56.</td>
</tr>
<tr>
<td></td>
<td>The transfer belt unit or fuser is old or damaged.</td>
<td>Check the condition of the transfer belt unit and the fuser and replace if necessary.</td>
</tr>
<tr>
<td>Symptom</td>
<td>Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Toner smears when rubbed.</td>
<td>The paper is damp.</td>
<td>Replace the paper.</td>
</tr>
<tr>
<td></td>
<td>The paper is outside the recommended specification range, or the paper type setting is not correct.</td>
<td>Replace the paper with a recommended size and type, then confirm that your print driver settings are correct. For details, see Supported Paper and Media on page 56.</td>
</tr>
<tr>
<td></td>
<td>The toner cartridges are not Xerox® toner cartridges.</td>
<td>Verify that the toner cartridges meet specifications and replace if necessary. For details, see Consumables on page 169.</td>
</tr>
<tr>
<td></td>
<td>The fuser is old or damaged.</td>
<td>Replace the fuser.</td>
</tr>
<tr>
<td>Printed pages are blank.</td>
<td>Two or more sheets are feeding at once.</td>
<td>Remove the paper stack from the tray, fan it, then reinsert it.</td>
</tr>
<tr>
<td></td>
<td>The toner cartridges are not Xerox® toner cartridges.</td>
<td>Verify that the toner cartridges meet specifications and replace if necessary. For details, see Consumables on page 169.</td>
</tr>
<tr>
<td></td>
<td>The transfer belt unit is old or damaged.</td>
<td>Replace the transfer belt unit.</td>
</tr>
<tr>
<td></td>
<td>The cable to the laser unit or controller is defective.</td>
<td>For assistance, see the Xerox® Support website at: <a href="http://www.xerox.com/office/WC6505support">www.xerox.com/office/WC6505support</a></td>
</tr>
<tr>
<td>Hair-like marks appear in or around black half-tone printing. Shadows appear around areas of dense black printing.</td>
<td>The paper was left unwrapped for a long time, especially in a dry environment.</td>
<td>Replace the paper. Also, see Paper Storage Guidelines on page 57.</td>
</tr>
<tr>
<td></td>
<td>The paper is outside the recommended specification range.</td>
<td>Replace the paper with a recommended size and type, then confirm that your print driver settings are correct. For details, see Supported Paper on page 58.</td>
</tr>
<tr>
<td></td>
<td>The transfer belt unit is old or damaged.</td>
<td>Replace the transfer belt unit.</td>
</tr>
<tr>
<td>Color around the edge of printing is incorrect.</td>
<td>The color registration is incorrect.</td>
<td>Adjust the color registration. For details, see Color Registration on page 199.</td>
</tr>
<tr>
<td>Colored dots are printed at regular intervals (about 28 mm).</td>
<td>The imaging unit is dirty.</td>
<td>Gently clean the imaging unit. For details, see Cleaning the Imaging Unit and Laser Lens on page 196.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partial blanks, creased paper, or blotted printing.</td>
<td>The paper is damp.</td>
<td>Replace the paper.</td>
</tr>
<tr>
<td></td>
<td>The paper is outside the recommended specification range.</td>
<td>Replace the paper with a recommended size and type. For details, see Supported Paper on page 58.</td>
</tr>
<tr>
<td></td>
<td>The transfer belt unit or the fuser is not installed correctly.</td>
<td>Reinstall the transfer belt unit or the fuser. For details, see the instruction sheets in the documentation packet that came with your printer.</td>
</tr>
<tr>
<td></td>
<td>The toner cartridges are not Xerox® toner cartridges.</td>
<td>Verify that the toner cartridges meet specifications and replace if necessary. For details, see Consumables on page 169.</td>
</tr>
<tr>
<td></td>
<td>Condensation inside the printer causes partial blanks or creased paper.</td>
<td>Turn on the printer and leave it on for at least one hour to get rid of the condensation. If the problems still occur, for assistance see the Xerox® Support website: <a href="http://www.xerox.com/office/WC6505support">www.xerox.com/office/WC6505support</a></td>
</tr>
<tr>
<td>Vertical blanks.</td>
<td>The laser is being blocked.</td>
<td>Remove the imaging unit and clean all debris from the laser lens with a lint-free cloth. For details, see Cleaning the Imaging Unit and Laser Lens on page 196.</td>
</tr>
<tr>
<td></td>
<td>The transfer belt unit or fuser is old or damaged.</td>
<td>Check the condition of the transfer belt unit and fuser, and replace if necessary.</td>
</tr>
<tr>
<td></td>
<td>The toner cartridges are not Xerox® toner cartridges.</td>
<td>Verify that the toner cartridges meet specifications and replace if necessary.</td>
</tr>
<tr>
<td>Slanted printing.</td>
<td>The paper guides in the trays are not set correctly.</td>
<td>Reset the paper tray guides. For details, see Loading Paper on page 61.</td>
</tr>
<tr>
<td>Horizontal bands, approximately 22 mm wide, appear vertically every 73 mm.</td>
<td>The imaging unit has been exposed to too much light; possibly from leaving the front door open too long.</td>
<td>Replace the imaging unit.</td>
</tr>
<tr>
<td>Symptom</td>
<td>Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>--------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Colors are blurry or there is white area around objects.</td>
<td>Color-to-color alignment is not correct.</td>
<td>Perform an automatic color registration adjustment. For details, see Color Registration on page 199.</td>
</tr>
</tbody>
</table>
Cleaning the Imaging Unit and Laser Lens

If prints have voids or light streaks through one or more color, use the following instructions to clean the imaging unit and laser lens:

*Note:* Do not use warm water or cleaning solvents to remove toner from your skin or clothing. Warm water sets the toner and makes it difficult to remove. If toner gets on your skin or clothing, brush it off, blow it off, or wash it off with cold water and mild soap.

⚠️ **CAUTION:** Do not expose the imaging unit to strong light, and minimize its exposure to light in general to five minutes or less if possible.

1. Switch off the printer at the power switch located on the right side of the printer toward the back.
2. Wait until the printer has cooled (about 40 minutes).
3. Remove Tray 1 and set it aside.
4. Open the printer by pressing the front cover button on the right side of the printer near the top.
5. Fold down the transfer belt unit, being careful not to touch its shiny surface.
6. Using a flashlight, inspect the gaps in the imaging unit and remove any paper debris from the area.
7. Remove the imaging unit:

⚠️ **CAUTION:** Do not drop or shake the imaging unit after removal because toner can spill from it.

⚠️ **CAUTION:** Do not expose the imaging unit to any light source for more than five minutes. Prolonged exposure to light can damage the unit. Cover the imaging unit while it is exposed. Do not touch the shiny blue transfer belt unit. For details, see Internal View on page 19.

a. Turn the four peach-colored twist-locks to the left to unlock the imaging unit.

![Image of imaging unit with twist-locks turned}

b. Grasp the imaging unit by its peach-colored pull tabs on the top edge, then pull the unit forward and up out of the printer.

c. Place the imaging unit on a flat surface and cover it with a sheet of paper to minimize its exposure to light.

8. Using a clean, dry, lint-free cloth or swab, clean all debris from the laser lens.

![Image of cleaning laser lens]

9. Check for and remove any debris around the imaging unit gears located on the left side of the unit.
10. Reinstall the imaging unit:
   a. Grasp the unit by its peach-colored pull-tabs on the top edge and install the unit in the printer. Make sure to insert the unit into the guides in the printer, then push the unit all the way back into the printer.
   
   ![Image of the imaging unit installation process]

   b. Turn the four twist-locks to the right to lock the unit.

11. Fold the transfer belt unit back into place and close the printer front cover.
Color Registration

This section includes:

- Setting Automatic Color Registration on page 199
- Performing a One-time Automatic Color Registration Adjustment on page 199
- Performing a Manual Color Registration Adjustment on page 199

The printer automatically adjusts the color registration when automatic adjustment is enabled. You can manually adjust color registration at any time the printer is idle. Adjust the color registration any time the printer is moved. If you are having printing problems, adjust the color registration. For details, see Print-Quality Problems on page 191.

Setting Automatic Color Registration

To set the automatic color registration adjustment feature:
1. On the control panel, press the System button.
2. Press the Up Arrow or Down Arrow button to select Admin Menu, then press the OK button.
3. Press the Up Arrow or Down Arrow button to select Maintenance, then press OK.
4. Press the Up Arrow or Down Arrow button to select Auto Regi Adjust, then press OK.
5. Press the Up Arrow or Down Arrow button to select On, then press OK.
6. Press the Return button to return to the Ready screen.

Performing a One-time Automatic Color Registration Adjustment

Use the following procedure to perform an automatic color registration adjustment.

Note: An automatic color registration adjustment is performed every time a new toner cartridge is installed.

1. On the control panel, press the System button.
2. Press the Up Arrow or Down Arrow button to select Admin Menu, then press the OK button.
3. Press the Up Arrow or Down Arrow button to select Maintenance, then press OK.
4. Press the Up Arrow or Down Arrow button to select Adjust ColorRegi, then press OK.
5. At Auto Adjust, press OK.
6. At the Are you sure? prompt, press the Up Arrow or Down Arrow button to select Yes.
7. Press OK to begin the calibration.

Performing a Manual Color Registration Adjustment

You can fine-tune color registration by performing a manual adjustment. Manual color registration adjustment is a three-part process:

- Printing the Color Registration Correction Chart on page 200.
- Determining the Color Registration Values on page 200.
- Entering Color Registration Values on page 201.
Printing the Color Registration Correction Chart

1. On the control panel, press the System button.
2. Press the Up Arrow or Down Arrow button to select Admin Menu, then press the OK button.
3. Press the Up Arrow or Down Arrow button to select Maintenance, then press OK.
4. Press the Up Arrow or Down Arrow button to select Adjust Color Regi, then press OK.
5. Press the Up Arrow or Down Arrow button to select Color Regi Chart, then press OK.
6. Press the Up Arrow or Down Arrow button to select Yes, then press the OK button.
   The Color Registration Chart prints.
7. Continue to Determining the Color Registration Values on page 200 to determine if any adjustments are necessary.

Determining the Color Registration Values

The Color Registration Chart shows horizontal and vertical values for each color. The horizontal values are:
- LY = left yellow
- LM = left magenta
- LC = left cyan
- RY = right yellow
- RM = right magenta
- RC = right cyan

The vertical values are:
- PY = paper feed direction yellow
- PM = paper feed direction magenta
- PC = paper feed direction cyan

To determine the horizontal values:
1. In the top section of the Color Registration Chart, lines are displayed next to the color letters LY, LM, LC, RY, RM, and RC. Some lines are straight and other lines are jagged. A value is listed next to each line. For each color, examine the lines and determine which one is the straightest. Refer to the enlarged illustration on the chart that shows how to determine the closest number.
2. For each color, do one of the following:
   - If zero (0) is the value nearest the straightest line, you do not need to adjust the color registration.
   - If zero (0) is not the value nearest the straightest line, record the number that is closest.
3. Proceed to determining the vertical values described in the following procedure.

To determine the vertical values:
1. In the lower section of the Color Registration Chart, columns of color are displayed with a wavy white column where there is no color. Identify the column of white that is the straightest. Refer to the enlarged illustration on the chart that shows how to determine the closest number.
2. For each color, do one of the following:
Troubleshooting

- If zero (0) is the value closest to the middle of the white band, you do not need to adjust that color.
- If zero (0) is not the value closest to the middle of the white band, record the number that is closest to the center of the white band.

3. If it is necessary to make any horizontal or vertical adjustments, proceed to Entering Color Registration Values on page 201.

**Entering Color Registration Values**

Using the control panel, enter the values that you found on the Color Registration Correction Chart to make adjustments:

1. On the control panel, press the **System** button.
2. Press the **Up Arrow** or **Down Arrow** button to select **Admin Menu**, then press the **OK** button.
3. Press the **Up Arrow** or **Down Arrow** button to select **Maintenance**, then press **OK**.
4. Press the **Up Arrow** or **Down Arrow** button to select **Adjust Color Regi**, then press **OK**.
5. Press the **Up Arrow** or **Down Arrow** button to select **Enter Number**, then press **OK**.
6. Adjust the Left Horizontal registration values:
   a. Press the **Up Arrow** or **Down Arrow** button to select the LY value from the Color Registration Correction Chart. Press the **Forward Arrow** button to adjust the next value.
   b. Press the **Up Arrow** or **Down Arrow** button to select the LM value from the Color Registration Correction Chart. Press the **Forward Arrow** button to adjust the next value.
   c. Press the **Up Arrow** or **Down Arrow** button to select the LC value from the Color Registration Correction Chart. Press **OK** to move to the next screen.
7. Adjust the Right Horizontal registration values:
   a. Press the **Up Arrow** or **Down Arrow** button to select the RY value from the Color Registration Correction Chart. Press the **Forward Arrow** button to adjust the next value.
   b. Press the **Up Arrow** or **Down Arrow** button to select the RM value from the Color Registration Correction Chart. Press the **Forward Arrow** button to adjust the next value.
   c. Press the **Up Arrow** or **Down Arrow** button to select the RC value from the Color Registration Correction Chart. Press **OK** to move to the next screen.
8. Adjust the Process Vertical registration values:
   a. Press the **Up Arrow** or **Down Arrow** button to select the PY value from the Color Registration Correction Chart. Press the **Forward Arrow** button to adjust the next value.
   b. Press the **Up Arrow** or **Down Arrow** button to select the PM value from the Color Registration Correction Chart. Press the **Forward Arrow** button to adjust the next value.
   c. Press the **Up Arrow** or **Down Arrow** button to select the PC value from the Color Registration Correction Chart.
9. When the registration value adjustments are complete, press **OK**.
10. Print the chart again to check the values:
    a. Press the **Up Arrow** or **Down Arrow** button to select **Color Regi Char**, then press **OK**.
    b. Press the **Up Arrow** or **Down Arrow** button to select **Yes**, then press **OK**.

*Note: For details, see Printing the Color Registration Correction Chart on page 200.*
Troubleshooting

11. If 0 is not displayed next to the straight lines, examine the chart and determine additional correction values.

12. When satisfied that the horizontal adjustment is complete, press the Return button to return to the Ready screen.
Color Balance

The printer automatically rebalances the color when printer consumables are replaced, or when changes in environmental conditions occur. To perform this manually one time, use the following procedure.

To adjust the color balance for the printer:

1. On the control panel, press the System button.
2. Press the Up Arrow or Down Arrow button to select Admin Menu, then press the OK button.
3. Press the Up Arrow or Down Arrow button to select Maintenance, then press OK.
4. Press the Up Arrow or Down Arrow button to select Drum Refresh, then press OK.
5. At the Are you sure? prompt, press OK.

The process runs automatically. Wait about three minutes for the process to complete and the printer to return to Ready.
Paper Jams

This section includes:

- Preventing Paper Jams on page 204
- Clearing Paper Jams on page 205

Preventing Paper Jams

To reduce the occurrence of paper jams, follow the guidelines and instructions in Supported Paper and Media on page 56. It includes paper-usage guidelines and instructions for properly loading paper in the trays.

To prevent paper and other media misfeeds and printer jams, follow these guidelines:

- Make sure that the paper used matches the specifications for each tray in the printer.
- Stack media so that it is flat and level, especially on the leading edge.
- Make sure that the printer is on a hard, flat, level surface.
- Store paper and other media in a dry location away from moisture and humidity.
- Always adjust the paper guides in Tray 1 after inserting the media. A guide that is not properly adjusted can cause poor print quality, paper misfeeds, and printer damage.
- Avoid using paper that is folded, wrinkled, or excessively curled.
- Avoid double feeding. Remove the paper and fan the sheets to prevent them from sticking together.
- Do not load more than one type, size, or weight of paper in a tray at the same time.
- Do not overfill the trays.
- Do not allow the output tray to overfill; misfeeding can occur if you allow too many sheets of paper to accumulate at one time.

**WARNING:** When removing jammed paper, make sure that no pieces of torn paper are left in the printer. If a sheet of paper is wrapped around the heat roller, do not try to remove it. Turn off the printer using the power switch, then contact Technical Support for additional assistance. Turn off the printer to remove jammed paper that is difficult or impossible to see.

**WARNING:** The fuser and the surrounding area are hot and can cause burns.
Clearing Paper Jams

This section includes:

- Clearing Long Paper Jams on page 205
- Clearing Jams at Tray 1 on page 205
- Clearing Jams at the Manual Feed Slot on page 206
- Clearing Jams at the Fuser on page 207
- Clearing Jams at the 250-Sheet Feeder on page 207
- Clearing Jams at the Duplex Unit on page 208

Clearing Long Paper Jams

When paper longer than 356 mm jams inside the printer, cut the paper as needed. After cutting, remove it in the proper way depending on the place that the paper jam occurs.

⚠️ CAUTION: If it is difficult to open the front cover, do not force it. Turn off the printer using the power switch on the right side of the printer. For additional assistance, refer to the Xerox® Support website at www.xerox.com/office/WC6505support.

Clearing Jams at Tray 1

1. Pull the paper tray open.
2. Pull the jammed paper gently out of the paper tray, then remove any remaining paper from the tray.

3. Close the paper tray, then press the front cover button to open the front cover.

⚠️ WARNING: Some components inside the printer, such as the fuser and surrounding area, are hot and can cause burns.
4. Carefully remove any jammed paper in the printer. Confirm that there are no scraps of paper left inside.

⚠️ **CAUTION:** Prolonged exposure to light can damage the imaging unit. Do not leave the cover open for more than five minutes at a time.

5. Close the front cover.
6. Remove the tray from the printer, then carefully pull out any jammed paper remaining inside the printer.

7. Reinsert the tray into the printer.

⚠️ **CAUTION:** Do not use excessive force on the tray; doing so could damage the tray or the inside of the printer.

**Clearing Jams at the Manual Feed Slot**
1. Pull Tray 1 out of the printer.
2. Remove any jammed or damaged paper in the tray, then close the tray.
3. Press the front cover button to open the cover.
4. Carefully remove any jammed paper in the printer. Make sure that there are no torn pieces of paper inside the printer.
5. Close the front cover.

**Clearing Jams at the Fuser**

⚠️ **WARNING:** Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. To avoid injuries or burns, turn off the printer immediately and wait 40 minutes for the fuser to cool.

⚠️ **WARNING:** When removing jammed paper, make sure that no torn pieces of paper are left in the printer. A piece of paper remaining in the printer can cause a fire. If a sheet of paper is wrapped around the heat roller, turn off the printer to remove it. Turn off the printer to remove a jammed sheet of paper that is difficult to see.

⚠️ **CAUTION:** Do not expose the imaging unit to any light source for more than 5 minutes. Prolonged exposure to light can damage the unit. Do not touch the shiny black transfer belt unit.

For additional assistance, refer to the Xerox® Support website at www.xerox.com/office/WC6505support

1. Press the front cover button on the side of the printer and open the printer cover.
2. Being careful not to touch the fuser, lift the levers at both sides of the fuser to release the roller pressure. At the top of the fuser, lift the green labeled tab to open the top cover and remove the jammed paper. If the paper is torn, remove any scraps of paper remaining inside the printer.

3. Put the fuser tabs back into place, then close the front cover.

**Clearing Jams at the 250-Sheet Feeder**

*Note:* Paper jammed in the lower tray can block the trays above it, preventing you from opening them. Look for the jammed paper sequentially, starting with the lowest tray.

1. Pull out the paper trays until you find the jammed paper.
2. Remove all jammed and creased paper from the tray.

   Note: Pull the jammed paper out carefully to avoid tearing it. If the paper is torn, remove the scraps.

3. Press the front cover button and open the printer cover. Confirm that there are no scraps of paper remaining inside the printer.

   ! CAUTION: Prolonged exposure to light can damage the imaging unit.

   ! WARNING: Some components inside the printer, such as the fuser and surrounding area, are hot and can cause burns.

4. Close the printer cover, then reinsert the trays.

   ! CAUTION: Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

Clearing Jams at the Duplex Unit

1. Press the front cover button and open the printer cover.

   ! WARNING: Some components inside the printer, such as the fuser and surrounding area, are hot and can cause burns.

   ! CAUTION: Prolonged exposure to light can damage the imaging unit.
2. Gently pull out any jammed paper that you find.

3. Lift the duplex unit by the recessed slot and open the unit fully.

4. Remove the jammed paper, then confirm that there are no scraps of paper left inside the duplex unit or transfer belt unit.

5. Close the duplex unit, then close the printer cover.
   
   **Note:** To remove the entire duplex unit, after opening the front cover of the printer, press the front cover-release button again to release the duplex unit.
Troubleshooting
Printer Specifications

This chapter includes:

- Physical Specifications on page 212
- Environmental Specifications on page 213
- Electrical Specifications on page 214
- Performance Specifications on page 215
## Physical Specifications

### Weights and Dimensions

<table>
<thead>
<tr>
<th>Part</th>
<th>Specifications</th>
</tr>
</thead>
</table>
| Printer                           | Width: 430 mm (16.9 in.)
|                                   | Depth: 544 mm (21.4 in.)
|                                   | Height: 584 mm (23 in.)
|                                   | Weight: 30 Kg (66.13 lb.) |
| 250-Sheet Feeder (optional)       | Width: 419 mm (16.5 in.)
|                                   | Depth: 518 mm (20.4 in.)
|                                   | Height: 106 mm (4.2 in.)
|                                   | Weight: 4.5 Kg (9.92 lb.) |
| Duplex Unit (optional)            | Width: 326.5 mm (12.9 in.)
|                                   | Depth: 313 mm (12.3 in.)
|                                   | Height: 153.5 mm (6.1 in.)
|                                   | Weight: 1.2 Kg (2.65 lb.) |
Environmental Specifications

Temperature

10°–32°C (50°–90°F)

Relative Humidity

Note: Under extreme environment conditions, such as 10°C and 85% RH, defects can occur due to condensation approximately 30 minutes after the printer is turned on.

15–85% RH at 28°C (82°F)

Elevation

For optimum performance, use the printer at elevations below 3,100 m (10,170 ft.).
Electrical Specifications

Power Source

- 110–127 V, 50/60 Hz, 10 A or less
- 220–240 V, 50/60 Hz, 5 A or less

Power Consumption

AC 110–127 V/220–240 V

- Energy Saver mode (Sleep Mode): 12 W or less
- Standby Mode: 60 W or less (fuser on)
- Continuous color printing: 550 W or less
- Continuous monochrome printing: 550 W or less

This printer does not consume electric power when the power switch is turned off even if the printer is connected to an AC outlet.

- ENERGY STAR qualified multifunction printer
- Default time settings: 3 minutes and 1 minutes
# Performance Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warm-up time</td>
<td>Power on: 30 seconds or less. Recovery from Energy Saver mode: 25 seconds or less. (assume temperature of 22°C/71.6°F)</td>
</tr>
</tbody>
</table>
| Continuous print speed        | Color: 24 ppm  
Black and White: 24 ppm  
**Note:** Print speed can decrease due to paper type, paper size, printing conditions, or image-quality adjustment. |
| 2-sided print speed (WorkCentre 6505DN configuration only) | Color: 16 ppm (A4)/17 ppm (Letter)  
Black and White: 16 ppm (A4)/17 ppm (Letter) |
| Resolution                    | Standard: 600 x 600 dpi x 1-bit  
Enhanced: 600 x 600 dpi x 4-bit (PostScript driver)/5-bit (PCL driver) |
This chapter includes:

- Electromagnetic Interference on page 218
- Other Regulations on page 220
- Copy Regulations on page 221
- Fax Regulations on page 224
- Material Safety Data Sheets on page 227
Xerox® has tested this product to electromagnetic emission and immunity standards. These standards are designed to mitigate interference caused or received by this product in a typical office environment.

This section includes:
- United States FCC Regulations on page 218
- Canada Regulations on page 218
- European Union on page 219

United States FCC Regulations

This equipment was tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential environment. This equipment generates, uses, and can radiate radio frequency energy. If it is not installed and used in accordance with these instructions, it can cause harmful interference to radio communications. However, there is no guarantee that interference does not occur in a particular installation.

To determine if this printer is causing harmful interference to radio or television reception, turn the printer off and on. If this equipment does cause harmful interference to radio or television reception, correct the interference by one or more of the following measures:
- Reorient or relocate the receiver.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/television technician for help.

Any changes or modifications not expressly approved by Xerox® could void the authority of the user to operate the equipment. To ensure compliance with Part 15 of the FCC rules, use shielded interface cables.

Canada Regulations

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
European Union

The CE mark applied to this product symbolizes the Xerox® declaration of conformity with the following applicable Directives of the European Union as of the dates indicated:

- December 12, 2006: Low Voltage Directive 2006/95/EC

This product, if used properly in accordance with the instructions, is not dangerous for the consumer or to the environment.

To ensure compliance with European Union regulations, use shielded interface cables.

A signed copy of the Declaration of Conformity for this product can be obtained from Xerox®.
Other Regulations

Turkey (RoHS Regulation)

In compliance with Article 7 (d), we hereby certify: “It is in compliance with the EEE Regulation.”

"EEE yönetmeliğine uygundur."
Copy Regulations

This section includes:

- **United States** on page 221
- **Canada** on page 222
- **Other Countries** on page 223

**United States**

Congress, by statute, has forbidden the reproduction of the following subjects under certain circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such reproductions.

1. **Obligations or Securities of the United States Government, such as:**
   - Certificates of Indebtedness
   - National Bank Currency
   - Coupons from Bonds
   - Federal Reserve Bank Notes
   - Silver Certificates
   - Gold Certificates
   - United States Bonds
   - Treasury Notes
   - Federal Reserve Notes
   - Fractional Notes
   - Certificates of Deposit
   - Paper Money
   - Bonds and Obligations of certain agencies of the government, such as FHA, etc.
   - Bonds (U.S. Savings Bonds may be photographed only for publicity purposes in connection with the campaign for the sale of such bonds.)
   - Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a canceled revenue stamp, this may be done provided the reproduction of the document is performed for lawful purposes.
   - Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be photographed, provided the reproduction is in black and white and is less than 75% or more than 150% of the linear dimensions of the original.
   - Postal Money Orders
   - Bills, Checks, or Draft of money drawn by or upon authorized officers of the United States.
   - Stamps and other representatives of value, of whatever denomination, which have been or may be issued under any Act of Congress.
   - Adjusted Compensation Certificates for Veterans of the World Wars.

2. **Obligations or Securities of any Foreign Government, Bank, or Corporation.**
3. Copyrighted materials, unless permission of the copyright owner has been obtained or the reproduction falls within the “fair use” or library reproduction rights provisions of the copyright law. Further information of these provisions may be obtained from the Copyright Office, Library of Congress, Washington, D.C. 20559. Ask for Circular R21.

4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be photographed.

5. Passports. Foreign Passports may be photographed.

6. Immigration papers.

7. Draft Registration Cards.

8. Selective Service Induction papers that bear any of the following Registrant’s information:
   - Earnings or Income
   - Court Record
   - Physical or mental condition
   - Dependency Status
   - Previous military service

   Exception: United States military discharge certificates may be photographed.

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the various Federal Departments, such as FBI, Treasure, etc. (Unless photograph is ordered by the head of such department or bureau.)

Reproducing the following is also prohibited in certain states:
   - Automobile Licenses
   - Drivers’ Licenses
   - Automobile Certificates of Title

The above list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case of doubt, consult your attorney.

Canada

Parliament, by stature, has forbidden the reproduction of the following subjects under certain circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such reproductions.
   - Current bank notes or current paper money.
   - Obligations or securities of a government or bank.
   - Exchequer bill paper or revenue paper.
   - The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of a court of law.
   - Proclamations, orders, regulations or appointments, or notices thereof (with intent to falsely cause same to purport to have been printed by the Queens Printer for Canada, or the equivalent printer for a province).
   - Marks, brands, seals, wrappers or designs used by or on behalf of the Government of Canada or of a province, the government of a state other than Canada or a department, board, Commission or agency established by the Government of Canada or of a province or of a government of a state other than Canada.
• Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of a province or by the government of a state other than Canada.

• Documents, registers or records kept by public officials charged with the duty of making or issuing certified copies thereof, where the copy falsely purports to be a certified copy thereof.

• Copyrighted material or trademarks of any manner or kind without the consent of the copyright or trademark owner.

The above list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is assumed for its completeness or accuracy. In case of doubt, consult your solicitor.

Other Countries

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be imposed on those found guilty of making such reproductions.

• Currency notes
• Bank notes and cheques
• Bank and government bonds and securities
• Passports and identification cards
• Copyright material or trademarks without the consent of the owner
• Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of doubt, contact your legal counsel.
Fax Regulations

This section includes:
- United States on page 224
- Canada on page 225
- European Union on page 226

United States

Fax Send Header Requirements

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other electronic device, including a fax machine, to send any message unless such message clearly contains in a margin at the top or bottom of each transmitted page or on the first page of the transmission, the date and time it is sent and an identification of the business or other entity, or other individual sending the message and the telephone number of the sending machine or such business, other entity, or individual. The telephone number provided may not be a 900 number or any other number for which charges exceed local or long-distance transmission charges.

Data Coupler Information

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the Administrative Council for Terminal Attachments (ACTA). On the rear of this equipment is a label that contains, among other information, a product identifier in the format US:AAAAEQ##TXXXX. If requested, this number must be provided to the Telephone Company.

A plug and jack used to connect this equipment to the premises wiring and telephone network must comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant telephone cord and modular plug is provided with this product. It is designed to be connected to a compatible modular jack that is also compliant. See installation instructions for details.

You may safely connect the machine to the following standard modular jack: USOC RJ-11C using the compliant telephone line cord (with modular plugs) provided with the installation kit. See installation instructions for details.

The Ringer Equivalence Number (REN) is used to determine the number of devices that can be connected to a telephone line. Excessive RENs on a telephone line could result in the devices not ringing in response to an incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the number of devices that can be connected to a line, as determined by the RENs, contact the local Telephone Company. For products approved after July 23, 2001, the REN is part of the product identifier that has the format US:AAAAEQ##TXXXX. The digits represented by ## are the REN without a decimal point (for example, 03 is a REN of 0.3). For earlier products, the REN is separately shown on the label.

To order the correct service from the local telephone company, you could also have to quote the codes in the following list:
- Facility Interface Code (FIC) = 02LS2
• Service Order Code (SOC) = 9.0Y

⚠️ CAUTION: Ask your local telephone company for the modular jack type installed on your line. Connecting this machine to an unauthorized jack can damage telephone company equipment. You, not Xerox®, assume all responsibility and/or liability for any damage caused by the connection of this machine to an unauthorized jack.

If this Xerox® equipment causes harm to the telephone network, the Telephone Company could temporarily discontinue service to the telephone line to which it is connected. If advance notice is not practical, the Telephone Company notifies you of the disconnection as soon as possible. If the Telephone Company interrupts your service, they can advise you of your right to file a complaint with the FCC if you believe that it is necessary.

The Telephone Company could change its facilities, equipment, operations, or procedures which could affect the operation of the equipment. If the Telephone Company changes something that affects the operation of the equipment, they should notify you in order for you to make necessary modifications to maintain uninterrupted service.

If you experience trouble with this Xerox® equipment, please contact the appropriate service center for repair or warranty information. Contact information is contained in the Machine Status menu on the printer and in the back of the Troubleshooting section of the User Guide. If the equipment is causing harm to the telephone network, the Telephone Company may request you to disconnect the equipment until the problem is resolved.

Only a Xerox® Service Representative or an authorized Xerox® Service provider are authorized to make repairs to the printer. This applies at any time during or after the service warranty period. If unauthorized repair is performed, the remainder of the warranty period is null and void.

This equipment must not be used on party lines. Connection to party line service is subject to state tariffs. Contact the state public utility commission, public service commission, or corporation commission for information.

Your office could have specially wired alarm equipment connected to the telephone line. Make sure that the installation of this Xerox® equipment does not disable your alarm equipment.

If you have questions about what could disable alarm equipment, consult your Telephone Company or a qualified installer.

**Canada**

This product meets the applicable Industry Canada technical specifications.

A representative designated by the supplier should coordinate repairs to certified equipment. Repairs or alterations made by the user to this device, or device malfunctions, could cause the telecommunications company to request you to disconnect the equipment.
For user protection, make sure that the printer is properly grounded. The electrical ground connections of the power utility, telephone lines, and internal metallic water pipe systems, if present, must be connected together. This precaution could be vital in rural areas.

⚠️ **WARNING:** Do not attempt to make such connections yourself. Contact the appropriate electric inspection authority, or electrician, to make the ground connection.

The REN assigned to each terminal device provides an indication of the maximum number of terminals allowed to be connected to a telephone interface. The termination on an interface could consist of any combination of devices. The only limitation to the number of devices is the requirement that the sum of the RENs of the devices does not exceed 5. For the Canadian REN value, please see the label on the equipment.

**European Union**

**Radio Equipment & Telecommunications Terminal Equipment Directive**

The Facsimile has been approved in accordance with the Council Decision 1999/5/EC for pan-European single terminal connection to the public switched telephone network (PSTN). However, due to differences between the individual PSTNs provided in different countries, the approval does not give an unconditional assurance of successful operation on every PSTN network terminal point.

In the event of a problem you should contact your authorized local dealer.

This product has been tested to and is compliant with ES 203 021-1, -2, -3, a specification for terminal equipment for use on analog-switched telephone networks in the European Economic Area. This product provides a user-adjustable setting of the country code. The country code should be set prior to connecting this product to the network. Refer to the customer documentation for the procedure for setting the country code.

**Note:** Although this product can use either loop disconnect (pulse) or DTMF (tone) signaling, it is recommended that it is set to use DTMF signaling. DTMF signaling provides reliable and faster call setup. Modification of this product, connection to external control software or to external control apparatus not authorized by Xerox®, will invalidate its certification.

**South African Statement**

This modem must be used in conjunction with an approved surge protection device.
Material Safety Data Sheets

For Material Safety Data information regarding your WorkCentre 6505 printer, go to:
• North America: www.xerox.com/msds
• European Union: www.xerox.com/environment_europe

For Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts.
Recycling and Disposal

This chapter includes:

- **All Countries** on page 229
- **North America** on page 229
- **Other Countries** on page 229
- **European Union** on page 229

**All Countries**

If you are managing the disposal of your Xerox® product, please note that the product may contain lead, mercury, perchlorate, and other materials. The disposal of these materials may be regulated due to environmental considerations. The presence of these materials is fully consistent with global regulations applicable at the time the product was placed on the market. For recycling and disposal information, contact your local authorities. This product may contain one or more Perchlorate-containing devices, such as batteries. Special handling may apply. For details, see www.dtsc.ca.gov/hazardouswaste/perchlorate.

**North America**

Xerox® operates an equipment take back and reuse/recycle program. Contact your Xerox® sales representative (1-800-ASK-XEROX) to determine whether this Xerox® product is part of the program. For more information about Xerox® environmental programs, visit www.xerox.com/environment. For recycling and disposal information, contact your local authorities.

**Other Countries**

Please contact your local waste authorities and request disposal guidance.

**European Union**

Some equipment can be used in both a domestic household environment and a professional or business application.
Domestic or Household Environment

Application of this symbol on your equipment confirms that you should not dispose of the equipment in the normal household waste stream.

In accordance with European legislation, end-of-life electrical and electronic equipment subject to disposal must be segregated from household waste.

Private households within EU member states may return used electrical and electronic equipment to designated collection facilities free of charge. Please contact your local disposal authority for information.

In some member states, when you purchase new equipment, your local retailer may be required to take back your old equipment free of charge. Please ask your retailer for information.

Professional or Business Environment

Application of this symbol on your equipment confirms that you must dispose of this equipment in compliance with agreed national procedures.

In accordance with European legislation, end-of-life electrical and electronic equipment subject to disposal must be managed within agreed procedures.

Prior to disposal, please contact your local reseller or Xerox® representative for end-of-life datebook information.
Information for Users on Collection and Disposal of Old Equipment and Used Batteries

These symbols on the products and/or accompanying documents mean that used electrical and electronic products and batteries should not be mixed with general household waste.

For proper treatment, recovery and recycling of old products and used batteries, please take them to applicable collection points, in accordance with your national legislation and the Directive 2002/96/EC and 2006/66/EC.

By disposing of these products and batteries correctly, you help save valuable resources and prevent any potential negative effects on human health and the environment.

For more information about collection and recycling, contact your local municipality, your waste disposal service or the point of sale where you purchased the items.

Penalties may be applicable for incorrect disposal of this waste, in accordance with national legislation.

For Business Users in the European Union

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for further information.

Information on disposal in other countries outside the European Union

These symbols are only valid in the European Union. If you need to discard these items, contact your local authorities or dealer and ask for the correct method of disposal.

Note for the Battery Symbol

This wheeled bin symbol may be used in combination with a chemical symbol. This establishes compliance with the requirements set out by the Directive.

Removal

Batteries should only be replaced by a MANUFACTURER-approved service facility.